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はじめに 
 
 

走査プローブ顕微鏡（SPM）は、無機結晶表面から半導体微細構造、有機分子、自己組

織化膜、タンパク質分子、DNA などの生体ナノ構造に至るまで、自然界あるいは人工的な

超微細構造と微細スケールにおける物性を計測し、それらの機能開発を導く強力な実験法

です。ところが、SPM の探針先端と試料間のナノ領域では、原子レベルの力学的・電子的・

化学的過程が複雑に絡み合っているため、実験結果の解析に理論的な支援がなければ難し

いのが現状です。 

本シミュレータは、このような必要性に応えるために開発いたしました。従来の研究レ

ベルの SPM シミュレーション技術をベースとした上で、問題に応じた計算規模の軽減が行

えるように複数のソフトウェアを用意し選択できるようにいたしました。また、容易な操

作を支援する GUI（グラフィカルユーザーインターフェース）を備えたものに仕上げてい

ます。 

今後 SPM 計測技術は、物理化学、生命科学、電子情報工学、材料科学などの先端的基礎

研究分野のみならず、半導体デバイス、表面処理技術、高分子材料、バイオ科学、農学、

先端医療、環境触媒、燃料電池、洗剤・化粧品業界などの産業分野においても重要性を増

すものと考えられます。このような分野での研究ツールとして本シミュレータがお役に立

てば幸いです。 

 

 本書は弊社 SPM シミュレータの操作手順書となっており、ソフトウェアのインストール

から操作手順、注意事項などをご紹介いたします。本書では初心者の方にも簡単にお使い

いただけるよう、基本的な操作方法を中心に解説しております。詳細設定に関しましては

別紙リファレンスマニュアルをご覧ください。 
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SPMシミュレータの構成 
 
 

弊社 SPM シミュレータには、以下のように大きく５つの機能があります。 

 

       １．高速相互予測 AFM シミュレータ 

       ２．連続弾性体 AFM シミュレータ 

       ３．液中ソフトマテリアル AFM シミュレータ 

       ４．原子分子ナノ材料 AFM 像シミュレータ 

       ５．量子論的 SPM 像シミュレータ 

 

そして、補助機能として薄膜構造作成ツールを備えています。 

上記５つの機能は、以下の６つのシミュレータから構成されています。 

 

① GEO  ② FEM  ③ LIQ  ④ CG  ⑤ MD  ⑥ DFTB 

 

それぞれのシミュレータの分類、機能概要、および対象領域は以下の表のようになってい

ます。 

 

表１：各シミュレータの機能概要 

 
 

表２：補助機能の機能概要 

古典力学に基づき、探針－試料間でのファンデルワールス力を考慮し、その上で、探針
及び試料が弾性方程式に従うと仮定して、測定AFM像を予測するシミュレータ

（探針形状データおよび試料表面形状データを入力として、測定AFM像データを予測・
出力する）

FEM連続弾性体AFMシミュレータ

探針形状データ、試料表面形状データ、測定AFM像データ、の三種類のデータのうち、
二種類のデータから、残り一種類のデータを高速に予測するシミュレータ

（シミュレーション計算においては、探針－試料間の相互作用を考慮せず、また、探
針・試料の立体形状は変形しないと仮定して、純粋に幾何学的な計算により、データを
相互予測する）

GEO高速相互予測AFMシミュレータ

DFTB

MD

CG

LIQ

ｼﾐｭﾚｰﾀ
名称

接触電位差を計算し、KPFM像を予測する機能

トンネル電流計算を行い、STM像を予測する機能

化学的相互作用力を計算し、AFM像を予測する機能

量子力学に基づいて系の電子状態を求め、探針－試料間の相互作用を計算。その結果か
らAFM像/STM像/KPFM像を予測するシミュレータ。

分子動力学法に基づいて試料の変形を考慮し、AFM像を予測するシミュレータ

エネルギー緩和法に基づいて試料の変形を考慮し、AFM像を予測するシミュレータ

古典力学に基づき、力場ポテンシャルを用いることにより探針－試料間の相互作用を計
算し、AFM像を予測するシミュレータ

液中でのカンチレバーの運動を，流体及び試料から受ける抗力とレバー自身の弾性変形
を考慮して計算するシミュレータ

概要

構造最適化AFM像シミュレータ

分子動力学AFM像シミュレータ

AFM像シミュレーション

STM像シミュレーション

KPFM像シミュレーション

量子論的SPM像シミュレータ

原子分子ナノ材料AFM像シミュレータ

液中ソフトマテリアルAFMシミュレータ

古典力学に基づき、探針－試料間でのファンデルワールス力を考慮し、その上で、探針
及び試料が弾性方程式に従うと仮定して、測定AFM像を予測するシミュレータ

（探針形状データおよび試料表面形状データを入力として、測定AFM像データを予測・
出力する）

FEM連続弾性体AFMシミュレータ

探針形状データ、試料表面形状データ、測定AFM像データ、の三種類のデータのうち、
二種類のデータから、残り一種類のデータを高速に予測するシミュレータ

（シミュレーション計算においては、探針－試料間の相互作用を考慮せず、また、探
針・試料の立体形状は変形しないと仮定して、純粋に幾何学的な計算により、データを
相互予測する）

GEO高速相互予測AFMシミュレータ

DFTB

MD

CG

LIQ

ｼﾐｭﾚｰﾀ
名称

接触電位差を計算し、KPFM像を予測する機能

トンネル電流計算を行い、STM像を予測する機能

化学的相互作用力を計算し、AFM像を予測する機能

量子力学に基づいて系の電子状態を求め、探針－試料間の相互作用を計算。その結果か
らAFM像/STM像/KPFM像を予測するシミュレータ。

分子動力学法に基づいて試料の変形を考慮し、AFM像を予測するシミュレータ

エネルギー緩和法に基づいて試料の変形を考慮し、AFM像を予測するシミュレータ

古典力学に基づき、力場ポテンシャルを用いることにより探針－試料間の相互作用を計
算し、AFM像を予測するシミュレータ

液中でのカンチレバーの運動を，流体及び試料から受ける抗力とレバー自身の弾性変形
を考慮して計算するシミュレータ

概要

構造最適化AFM像シミュレータ

分子動力学AFM像シミュレータ

AFM像シミュレーション

STM像シミュレーション

KPFM像シミュレーション

量子論的SPM像シミュレータ

原子分子ナノ材料AFM像シミュレータ

液中ソフトマテリアルAFMシミュレータ
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表３：各シミュレータの対象領域 

 
○：無償版、製品版ともに対応 

●：製品版のみ対応      

－：未対応          

 

 高速相互予測シミュレータ                           

高速相互予測シミュレータでは、「探針形状

データ」、「試料表面形状データ」、「測定 AFM

像データ」の三種類のデータのうち、二種類

のデータから、残り一つのデータを高速数値

計算によって求めます。このシミュレータは、

探針が試料に常に接しているコンタクトモー

ド測定を仮定しており、純粋に幾何学的な計

算手法によって解を求める点に特徴が有りま

す。 

外部フリーソフトウェア
で対応

外部フリーソフトウェア
で対応

無償版に添付して配布

開発中

備考

プロテインデータバンクの利用

分子構造の作成と編集

結晶構造のデータからの半導体薄膜モデルの作成と編集

初期構造の作成

測定像とシミュレーション像を比較し、類似物から試料の
構造を予測する機能

概要

半導体薄膜構造作成ツール

分子構造作成

たんぱく質

モデリング機能

試料表面構造予測機能

外部フリーソフトウェア
で対応

外部フリーソフトウェア
で対応

無償版に添付して配布

開発中

備考

プロテインデータバンクの利用

分子構造の作成と編集

結晶構造のデータからの半導体薄膜モデルの作成と編集

初期構造の作成

測定像とシミュレーション像を比較し、類似物から試料の
構造を予測する機能

概要

半導体薄膜構造作成ツール

分子構造作成

たんぱく質

モデリング機能

試料表面構造予測機能

試料、探針の変形を考慮可能－○－○FEM連続弾性体AFMシミュレータ

1秒以内で計算可能ナノスケール半
導体デバイス、
（生体）高分子
化合物

－○－○GEO高速相互予測AFMシミュレータ

DFTB

MD

CG

LIQ

ｼﾐｭﾚｰﾀ
名称

－○

－○

－○

●○

●○

液中
真空
中

○

環境

○

有機低分子、無
機物質等

高分子化合物、
生体分子等

対象

試料

試料の変形を考慮可能

温度を考慮可能

試料の変形を考慮可能

その他特徴

○－
構造最適化AFM像シミュ
レータ

原子分子
ナノ材料
AFM像シ
ミュレータ ○－

分子動力学AFM像シミュ
レータ

○－AFM像シミュレーション
量子論的
SPM像シ
ミュレータ

○－STM像シミュレーション

○●KPFM像シミュレーション

対象スケール

－○液中ソフトマテリアルAFMシミュレータ

ミクロマクロ

試料、探針の変形を考慮可能－○－○FEM連続弾性体AFMシミュレータ

1秒以内で計算可能ナノスケール半
導体デバイス、
（生体）高分子
化合物

－○－○GEO高速相互予測AFMシミュレータ

DFTB

MD

CG

LIQ

ｼﾐｭﾚｰﾀ
名称

－○

－○

－○

●○

●○

液中
真空
中

○

環境

○

有機低分子、無
機物質等

高分子化合物、
生体分子等

対象

試料

試料の変形を考慮可能

温度を考慮可能

試料の変形を考慮可能

その他特徴

○－
構造最適化AFM像シミュ
レータ

原子分子
ナノ材料
AFM像シ
ミュレータ ○－

分子動力学AFM像シミュ
レータ

○－AFM像シミュレーション
量子論的
SPM像シ
ミュレータ

○－STM像シミュレーション

○●KPFM像シミュレーション

対象スケール

－○液中ソフトマテリアルAFMシミュレータ

ミクロマクロ
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 連続弾性体 AFM シミュレータ                            

連続弾性体 AFM シミュレー

タでは、探針－試料間のファン

デルワールス力を考慮し、その

上で、探針および試料が(古典的

な)弾性方程式に従うと仮定して

有限要素法計算を実行し、予測

される AFM 画像を求めます。こ

のシミュレータでは、カンチレ

バーの先端の探針は、常に試料

表面から数Å程度離れており、

ノンコンタクトモード測定に対

応します。 

 
 

 液中ソフトマテリアル AFM シミュレータ                    

液中ソフトマテリアル AFM シミュレータでは、液中の動的 AFM に対応し、カンチレバ

ーの振動解析、粘弾性ソフトマテリアルの SPM 計測をシミュレーションすることができま

す。液中でのカンチレバーの運動の様子を、周辺流

体から受ける抗力、試料との接触によって受ける力、

レバー自身の弾性変形の 3 つを練成して計算します。 

本シミュレータでは、振動モードでの粘弾性試料の

AFM 像を計算することができ（開発中）、試料の弾

性率などの物性値を推測することが可能です。また、

液中でのカンチレバーの共鳴振動周波数を特定する

ことができ振動特性が分かるので、カンチレバー形

状の設計、振動条件の検討に役立ちます。 

 
 

 原子分子ナノ材料 AFM 像シミュレータ                     

 原子分子ナノ材料 AFM 像シミュレータは、

対象とする AFM 測定試料の原子一つ一つに力

場パラメータを設定し、それらに基づいて、走

査される探針と試料との間の相互作用を計算

することにより、AFM 測定像を予測するシミ

ュレータです。また、探針との相互作用による

試料分子の構造変化を原子スケールで予測す

ることができることに特徴があります。このシ
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ミュレータには分子構造を計算する手法として二種類用意されています。一つは、分子が

エネルギー的に安定になる原子配置を探索し、分子構造を決定する「構造最適化 AFM 像シ

ミュレータ」です。もう一つは、すべての原子についてのニュートン方程式を解くことに

より分子構造の変化過程を予測する「分子動力学 AFM 像シミュレータ」です。これらのう

ちから目的に応じて選び、シミュレーションを行うことができます。 

 
 

 量子論的 SPM 像シミュレータ                         

量子論的 SPM 像シミュレータでは、量子力学的

な電子状態の計算を元に、真空中のミクロスケール

な表面構造に対する周波数シフト像、トンネル電流

像、および局所接触電位差像のシミュレーションを

行うことができます。また、トンネル電流の計算で

は、走査トンネル分光スペクトルとしても解析する

ことができます。本シミュレータでは、密度汎関数

理論に基づく強束縛計算法を採用しており、量子力学計算に通常付随する大きな計算コス

トを軽減させています。そのため、実験との比較を行う上で現実的な試料表面や、古典分

子動力学法によって評価した比較的大きな系に対して適応することが可能です。 

 
 

 モデリング機能                                

 薄膜構造作成ツールは、補助機能のひとつで、

SPM シミュレータに利用する初期構造を作成する

ことができます。このツールでは、ミクロスケール

（DFTB 法、CG 法、MD 法）で使用される原子モデ

ルを作成しますが、一部マクロスケールでも使用す

ることができます。ミクロスケールで使用される原

子モデルとして、理想表面を持つ薄膜モデルが作成

されます。また、任意の原子・クラスタの追加・削

除・移動の編集を行う事ができます。 
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第１章 

ソフトウェアのインストールと準備 

 
 

1 ソフトウェアのインストール 

 
 
 SPM シミュレータをご利用頂くためには、以下の URL からお申込み下さい。 

https://www.aasri.jp/pub/spm/appform/spmlicapp.php 
 

申し込みフォーム（画面は 2014 年 10 月 24 日現在のものです。） 

 

 

ご希望者基本情報を入力 

ご希望のソルバーを選択（複数可） 

１ ソフトウェアのインストール                    
 

https://www.aasri.jp/pub/spm/appform/spmlicapp.php
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申し込みの後、e-mail にてアカウント ID及びライセンスキーと入手先のURLが提供されます。 

 
 

インストールプログラムをダウンロードし、PC へ保存します。 

ファイル名は SPMInstaller.zip となります。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ご希望の原子間作用パラメータを 

選択（複数可） 

上記を入力の上、送信 
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SPMInstaller.zip を解凍します。 

 

 
 

解凍すると SPMInstaller というフォルダが作成されます。SPMInstaller フォルダを開きます。 
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Installer.exe をダブルクリックして実行します。 

以下の画面が表示されます。 

 
 

続いて以下の画面が表示されますので、Next ボタンをクリックします。 
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本ソフトウェアの使用条件が表示されますので、ご一読頂き、ご同意の上でインストール

を続けて頂きます。 

 
 

「同意する」のラジオボタンをチェックすると Next ボタンをクリックできる状態になりま

す。続けて Next ボタンをクリックします。 

 
アカウント ID とラインセンスキーの入力画面に変わります。 

e-mail にて送付されたアカウント ID とライセンスキーを入力し、OK ボタンをクリックし
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ます。 

 
 

以下の画面が表示されます。 

 
ネットワークについての設定です。お使いのネットワーク環境に従ってプロキシ等の設定

を選択してください。 

OK ボタンをクリックすると、以下の画面が表示されます。 

インストール先のフォルダを選択し、OK ボタンをクリックします。 
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SPM Simulator モジュールのインストールが開始されます。 
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SPM Simulator モジュールのインストールが終了すると Next ボタンをクリックできる状態

になります。Next ボタンをクリックします。 

 
 

サーバへの登録画面が表示されます。 
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サーバへの登録が完了すると以下が表示され、Next ボタンをクリックできる状態になりま

す。Next ボタンをクリックします。 

 
 

終了の画面が表示されます。デスクトップショートカットならびにスタートメニューへの

登録ができます。チェックボックスの必要箇所にチェックし Finish ボタンをクリックしま

す。インストールは以上で終了です。 
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第２章 

ソフトウェアの操作 

 
 
 

1 GUI 概要 

 
本ソフトウェアでは、探針、試料、画像などのコンポーネントデータやそれらの初期配置、

各シミュレータで用いられるパラメータ、計算結果出力ファイルパスなど、シミュレーシ

ョンに必要な全ての情報を『プロジェクト』と呼ばれる XML 形式のファイルで一括管理し

ています。各シミュレータは、このプロジェクトファイルを入力とし、計算途中あるいは

終了後、結果を指定されたパスに出力します。統合 GUI を用いることで、プロジェクトフ

ァイルの作成・編集を簡単に行うことができ、また結果ファイルを様々な形態で可視化・

表示することができます（図）。 

 

 

プロジェクトファイル 

作成、編集 

表示 

      

計算結果ファイル 

  

統合GUI 

参照 

コンポーネントデータ 

(探針、試料、画像) 

シミュレータ 

MD 

FEM 

DFTB 

CG 

LIQ 

GEO 

１ GUI 概要                     
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2 画面説明 

 

 
以下では画面ごとの主な機能について説明します。 

【Menu Bar & Tool Bar】 

Project Editor 

Main View 

Log View 

Result View 

Menu Bar & Tool Bar 

DB View 

Project View 

Data View 

２ 画面説明 
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プロジェクトの新規作成や読み込み、保存などのファイル操作、シミュレータの選択

や実行、再生、一時停止、停止などのシミュレーション制御操作、各画面の表示／非

表示の切り替えなどを行います。 

 

【Project Editor】 

プロジェクトファイルの内容をツリービューとして表示します。表示された値は直接

編集することができます。変更内容は即座に Main View 上の描画に反映されます。 

 

【Main View】 

プロジェクトファイルに書かれているコンポーネントやそれらの初期配置、スキャン

エリアなどのセットアップ情報を可視化します。マウスやキーボード、スライダーバ

ーの操作によってコンポーネントのレイアウトを変更でき、その内容は即座に Project 

Editor に反映されます。またシミュレーション実行中には、探針の移動や試料の変形の

様子を可視化します。 

 

【Result View】 

シミュレーション途中や終了後の計算結果を可視化し、２D、３D など様々な形態で表

示します。 

 

【Log View】 

シミュレータや GUI からのメッセージを表示します。 

 

【DB View】 

予めデータベースに登録されたコンポーネント（探針や試料の分子データ）の一覧表

を表示します。一覧表の中からコンポーネントを選択・ダブルクリックするだけでプ

ロジェクトに取り込むことができます。 

 

【Project View】 

プロジェクトファイルの内容をテキスト表示します。直接編集することはできません。 

 

【Data View】 

コンポーネントのデータを表示します。分子データの場合、原子ごとに電荷情報と移

動可／不可の情報を設定・編集することができます。ただし原子種と原子座標は編集

できません。 

 



 22 

3 GUI の起動 

 
 
 

 
 

1. a. デスクトップ  “SPM Simulators”アイコン ダブルクリック 

1. b. インストールディレクトリ¥SPMSimulator.exe ダブルクリック 

 

正常に起動しない場合は、第 6 章 

トラブルシューティングをご覧ください。 

 

３ GUI の起動 
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4 プロジェクトのファイル操作 

  
 

GUI を起動後、全ての操作はプロジェクトを読み込むことから始まります。プロジェク

ト読み込み後、GUI を用いてそのプロジェクトを編集・保存し、最後にシミュレーション

を実行するという手順になります。ここでは、プロジェクトの新規作成や読み込み、保存

などのファイル操作について説明します。 

 

新規プロジェクト作成 

 

 
1. “Menu Bar” → [File] → [New]1 → ”Create new project”ダイアログ 

2. “Project name”入力 → “Directory”入力 → [OK] 

  

”Create new project”ダイアログでは、プロジェクト名(Project name)およびプロジェクト作

成ディレクトリ(Directory)を指定します。[Ref]ボタンを押すとダイアログを用いてディレク

トリを指定できます。[OK]ボタンを押すと “Directory”で指定されたディレクトリの中に、

プロジェクトと同名のディレクトリが作成され、その中にプロジェクトファイルが作成さ

れます。例えば test というプロジェクト名を指定した場合、 

指定したディレクトリ¥test¥test.pro 

 

というプロジェクトが作成されます。プロジェクトが作成されると、”Project Editor”

                                                   
1 この操作は、“Tool Bar” → Newアイコンをクリックすることでも行えます。 

Simulator Tab 

４ プロジェクトのファイル操作 

す 
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の”Setup”タブ内には”Component”項目が追加され、”Simulator Tab”（図では”DFTB”）内に

はデフォルトのパラメータ値が自動設定されます。 

 

既存プロジェクト読み込み 

【ファイルダイアログを使用した読み込み】 

 
1. “Menu Bar” → [File] → [Open]2 → ”Open Project”ダイアログ 

2. プロジェクトファイル(～.pro)指定 → [開く] 

 

                                                   
2 この操作は、”Tool Bar” → Openアイコンをクリックすることでも行えます。 
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指定されたプロジェクトが読み込まれると、”Project Editor”の各タブ内にセットアップ情報

やシミュレータのパラメータ情報などが表示されます。同時に Main View 上に探針や試料

などのコンポーネントが描画されます。また既に計算結果がある場合は、”Result View”に結

果情報がセットされます。 

 

【最近使用したプロジェクトの読み込み】 

 
1. “Menu Bar” → [File] → [Recent Files] → プロジェクト一覧3→ファイル指定 

 

【再読み込み】 

 
 

1. “Menu Bar” → [File] → [Reload]4 

セットアップ情報やパラメータ値を変更した時、保存前であれば、再読み込みすることで

前回保存した時点のプロジェクトに戻すことができます。 

 
 

                                                   
3 最近使ったプロジェクトファイルは最大 10個まで表示されます。 
4 この操作は、”Tool Bar” → Reloadアイコンクリックでも行えます。 
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プロジェクトの表示 

 
1. “Menu Bar” → [Display] → [Current Project File:ファイル名] 

 
Current Project File:の後には、現在のプロジェクトファイル名が表示されます。このメニュ

ーをクリックすることで、”Project View”が立ち上がり、プロジェクトファイルの内容を閲

覧することができます。なお、”Project View”上でファイルを直接編集することはできませ

ん。編集は”Project Editor”から行います。 

 

プロジェクトの保存 

 

GUI 上でプロジェクトを編集した場合、その内容が直ちにプロジェクトファイルに反映さ

れるわけではありません。保存をしてはじめてプロジェクトファイルが更新されます。各

シミュレータはプロジェクトファイルを参照して計算を行うため、プロジェクトの変更内

容をシミュレーション結果に反映させるためには、実行前にファイルを保存しておく必要

があります。以下では保存方法について説明します。 

 

【保存】 

1. “Manu Bar” → [File] → [Save]5  

                                                   
5 この操作は”Tool Bar”の Saveアイコンをクリックすることでも行えます。 
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【名前を付けて保存】 

 

 
1.“Manu Bar”→ [File] → [Save As] → “Save Project ”ダイアログ 

2. “Project name”入力 → “Directory”入力 → [OK] 

 
” Save Project”ダイアログでは、プロジェクト名(Project name)およびプロジェクトファイ

ル作成ディレクトリ(Directory)を指定します。[Ref]ボタンを押すとダイアログを用いてディ

レクトリを指定できます。[OK]ボタンを押すと “Directory”で指定されたディレクトリの中

に、プロジェクトと同名のディレクトリ（プロジェクトディレクトリ）を作成し、その中

にプロジェクトファイルを作成・保存します。その際、データファイルなどプロジェクト

に必要な全てのファイルがプロジェクトディレクトリにコピーされます。 

 

GUI 上部のタイトルバーに現在のプロジェクトファイル名が表示されていますが、編集し

てファイルを書き換えた場合には、このファイル名の後に”*”という記号が表示されます。

保存が完了するとこの記号が消えます。 

 
 

プロジェクトの終了 
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1.“Manu Bar”→ [File] → [Close]6  

 

プロジェクトを終了すると、”Project Editor”から全項目が削除されます。また”Main View”

上の描画も全て消去されます。 

 
 
 

                                                   
6 この操作は”Tool Bar”の Closeアイコンをクリックすることでも行えます。 
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5 プロジェクトの編集 

 

コンポーネント 

 
（１） 追加・置換・削除 

コンポーネントは、探針・試料・画像の３種類ありますが、以下では探針の場合を例にと

って説明します。 

 

【追加】 

 
1. “Project Editor” → “Setup”タブ 

2. “Component”右クリック → コンテキストメニュー7 

                                                   
7このメニューは、 “Menu Bar” → [Edit] を選択すること、あるいは “Main View” 上で右クリックすることでも

５ プロジェクトの編集 

す 
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3. a. [Add Tip] → [Database] → “DB View” → コンポーネントダブルクリック 

b. [Add Tip] → [File] → “Import File”ダイアログ → ファイル指定 → [開く] 

c. [Add Tip] → [Sphere/Cone/Pyramid/Pillar] → パラメータ入力ダイアログ → 半

径・角度入力 → [OK] 

 
 

探針の場合、追加データは[Database]（データベース）、[File]（ファイル）および 4 種類の

形状モデル[Sphere][Cone][Pyramid][Pillar]から選択可能ですが、各々入力ダイアログが異な

ります8。データベースからの入力の場合、一覧からコンポーネントを選択し、ダブルクリ

ックするだけで追加できます。ファイルからの入力の場合は、ファイルダイアログを使い

ます。形状モデルの場合は、形状に応じて角度や半径などの入力ダイアログが立ち上がり

ます。 

 

以上の操作で、指定されたデータが読み込まれると、”Component”の下に”Tip”という項目が

追加され、探針の情報が表示されます。同時に Main View 上に探針が描画されます。試料、

画像についても同様の手順で追加していくことができます9。 

 

【画像ファイルの追加】 

bmp や jpg などの画像ファイルは、明るさの情報はもちますが、高さ情報はもっていませ

ん。したがって、明度をコンポーネントの高さ情報に変換する処理が必要となります10。ま

た、画像の大きさ（幅、高さ）が現実に何Åに相当するかを指定する必要があります。以

下では試料の場合を例にとって画像ファイルの読み込みについて説明します。 

 

                                                                                                                                                     
表示できます。 
8試料は[Database]および[File]から、画像は[File]からのみ入力可能です。  
9試料は複数個追加することができますが、探針および画像はひとつだけしか追加できません。 
10 画像の明度と試料の高さが比例関係にない場合には、画像ファイルを追加しても正しい計算は行えません。 
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1. “Project Editor” → “Setup”タブ 

2. “Component”右クリック → コンテキストメニュー11 

3. [Add Sample] → [File] → “Import File”ダイアログ → 画像ファイル指定 → [開く] 

4.”Set Image Width”ダイアログ → “width”入力 → [OK] 

5.”Set Image Height”ダイアログ → “height”入力 → [OK] 

6.”Set Value Range”ダイアログ → “value range”入力 → [OK] 

 

“Set Image Width”および“Set Image Height”ダイアログで、画像ファイルの幅と高さが実際

に何Åに相当するのかを指定します。さらに“Set Value Range”ダイアログで、画像の明度

[0.0,1.0](黒=0.0、白=1.0 で表現)がどれくらいの試料の高低差（Å）に相当するのかを指定

します。 

 
 
 
 
 
 

【置換】 

                                                   
11このメニューは、 “Menu Bar” → [Edit] を選択すること、あるいは “Main View” 上で右クリックすることでも
表示できます。 
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1. “Project Editor” → “Setup”タブ 

2. “Tip”右クリック → コンテキストメニュー 

3. a. [Replace] → [Database] → “DB View” → コンポーネントダブルクリック 

b. [Replace] → [File] → “Import File”ダイアログ → ファイル指定 → [開く] 

c. [Replace] → 形状モデル → パラメータ入力ダイアログ → 半径・角度入力 → 

[OK] 
 

置換と追加の違いは、2.の操作において”Component”ではなく、置換したいコンポーネント

（探針の場合は”Tip”）を右クリックすることと、3.の操作においてコンテキストメニューの

内容が、[Add Tip]ではなく[Replace]に変わることです。 

 

【削除】 

 
1. “Project Editor” → “Setup”タブ 

2. “Tip”右クリック → コンテキストメニュー 

3. [Remove] 
 

指定されたデータが削除されると、”Component”の下から”Tip”という項目が削除されます。

同時に Main View 上からも探針の可視化画像が削除されます。 
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（２） 初期配置設定（移動・回転・リセット） 

コンポーネントは、探針・試料・画像の３種類ありますが、以下では探針の場合を例にと

って説明します。 

 

【移動】 

 
ここでは、z 座標の移動を例にとって説明します。 

1. “Project Editor” → “Setup”タブ 

2. a. “Tip” → “Position”12 → “z”の”value”ダブルクリック → スピンボックス 

  b. “Tip” → “DistanceFromSamples”13の”value”ダブルクリック → スピンボックス14 

3. 数値入力15 → リターン 

以上の操作で、Main View 上に表示されている探針が、指定された座標に移動します。 

 

【回転】 

                                                   
12 ”Position”以下には、コンポーネントの座標（単位はÅ）が格納されています。探針に関し
て、”x”、”y”、 ”z”の”value”値は、探針最下端位置の座標を表します。一方、試料と画像に関しては、”x”
と”y”の”value”値は、各々コンポーネント中心の x座標(xmin+xmax)/2 , y座標(ymin+ymax)/2 を表します。”z”
の”value”値はコンポーネント最下端の z座標（zmin）を表します。 
13 ”DistanceFromSamples”の”value”値（単位はÅ）は、（探針最下端の z座標－試料最上端の z座標）を表します。
試料が存在しない場合、この値は 0となります。 
14 この操作は z座標移動の場合のみ有効となります。 
15 数値変更は、”Main View”内のスライダーバーつまみを移動させること、あるいは”Main View”上で”Shift”キ
ーを押しながらマウスを移動させることによっても行えます。ただし”Main View”上のマウス操作でコンポーネント
を移動・回転（後述）させる場合、”Project Editor”の”Setup”タブ内で、そのコンポーネントを選択（９節）して
おく必要があります。何も選択されていない場合は、視点が変更されます。 
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ここでは、x 方向軸に関する回転を例にとって説明します16。 

1. “Project Editor” → “Setup”タブ 

2. “Tip” → “Rotation”17 → “alpha”の”value”ダブルクリック → スピンボックス 

3. 数値入力18 → リターン 

 

以上の操作で、Main View 上に表示されている探針が、x 方向の軸を中心に、指定された角

度だけ回転します。y および z 方向軸の回転に関しても同様です。なお、画像に関しては回

転操作を行うことができません。 

 
 
 

【リセット】 

 
1.“Tool Bar” → [Reset Layout] 

 

以上の操作で各コンポーネントの位置座標および回転角度は、その時点で保存されている

プロジェクトファイルの値にリセットされます。同時に、Main View 上に描画されているコ

ンポーネントの配置もリセットされます。 

 
 
                                                   
16 現在回転操作を行えるのは、”～.pdb”、”～.xyz”、”～.txyz”形式のデータをもつコンポーネン
トのみとなっています。 
17 ”Rotation”以下には、軸に対する回転角度（単位は degree）が格納されています。”alpha”、”beta”、”gamma”
の”value”値は、各々回転中心を原点とした場合の x、y、z方向の軸に対する回転角度を表します。回転中心は、探
針の場合、探針最下端位置となります。一方試料の場合、コンポーネントの中心座標が回転中心となります。回転は
“alpha”→“beta”→“gamma”の順序で行います。 
18 入力できる数値の範囲は[-180degree , 180degree]となっています。数値変更は、”Main View”上でマウスを移動
させることによっても行えます。 

Reset Layout 
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（３） データ表示・属性変更 

以下では試料のデータを表示する場合について説明します。 

 
1.“Project Editor” → “Setup”タブ 

2.“Sample”右クリック → コンテキストメニュー → [Show] → “Data View” 

3.“Relax”19および”Charge”列の数値入力20→ [OK] 

 

以上の操作で、各原子の属性が書き換えられ、変更内容はプロジェクトファイルに保存さ

れます。”Relax”の値を 1 にした場合、シミュレーション途中で働く力に応じて原子が動く

ことがあります。この場合、原子の配置が変更されることにより分子（コンポーネント）

が変形します。 

スキャンエリア設定・表示 

 

ここでは、スキャンエリアの高さ（z 軸方向の走査範囲）の変更を例にとって説明します。 

                                                   
19 “Relax”=0は原子座標の「移動不可」、“Relax”=1は「移動可」を表します。 
20 現在属性変更を行えるのは、”～.pdb”、”～.xyz”、”～.txyz”形式のデータをもつコンポーネントのみとな
っています。なお、原子種および原子座標は編集することができません。 
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1.“Project Editor” → “Setup”タブ 

2.“Tip” → “ScanArea”21 → “h”の”value”ダブルクリック → スピンボックス 

3.数値入力→ リターン 

4.“Main View”右クリック → コンテキストメニュー → [Show Scan Area]22 

 

以上の操作で、プロジェクトの走査範囲が変更され、その範囲が”Main View”上に青色の直

方体で表示されます。同様にして、走査範囲の幅（x 軸方向）や深さ（y 軸方向）について

も、“ScanArea”の“w”や“d”を用いて変更できます。 

 

シミュレータ選択とパラメータ設定 

 

以下では量子論的 SPM 像シミュレータ(DFTB)を選択する場合について説明します。 

                                                   
21 ”ScanArea”以下には、走査範囲の幅 w、奥行き d、高さ h（単位はÅ）が格納されています。w、d、h各々の値は、
探針の最下端を始点とし、x方向、y方向、-z方向へどれだけ走査するかを表します。 
22 [Show Scan Area]はトグルボタンであり、繰り返しクリックすることで走査範囲の表示／非表示を交互に切り替えら
れます。 
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1.“Tool Bar” → “Simulator Combo Box” → [MD/CG/DFTB/FEM/LIQ]23 

2.“Project Editor” → “Simulator Tab” 

3.各パラメータの”value”ダブルクリック → 各種入力コントロール24 

4.データ入力→ リターン 

 

パラメータ設定を行うためには、まず設定したいシミュレータを選択する必要がありま

す。”Simulator Combo Box”から MD/CG/DFTB/FEM/LIQ の内、いずれかを選択します25。

選択されたシミュレータに応じて“Simulator Tab”の文字は自動的に変更されます（図では

DFTB）。次に“Simulator Tab”内で各パラメータ値を入力します。各パラメータの意味につい

ては、別紙「リファレンスマニュアル」を参照してください。なお新規プロジェクトを作

成した場合でも、各パラメータには予めデフォルト値が設定されています。 

 

どのシミュレータを選択しても、”Simulator Tab”内に”Output”という項目が存在し、その直

下に”Directory”という項目があります。”Directory”以下は計算結果ファイル名のリストです。

シミュレーション実行時に、このディレクトリにファイルが出力されますが、既に同名フ

ァイルが存在する場合、それらのファイルは上書きされますので注意してください26。 

                                                   
23 シミュレータ選択は、”Menu Bar” → [Simulation] → [Solver]からでも行えます。 
24 入力コントロールは、数値の場合はスピンボックス、文字の場合はテキストボックスといったように、要求される
データ形式に応じて自動的に変化します。 
25 GEOに関しては使用法が異なります。３章１節『高速相互予測 AFMシミュレータ』の説明をご覧ください。 
26 ただし、以前のファイルに対しては、“ファイル名~”というバックアップファイルが自動作成されます。 

 

Simulator Combo Box 

Simulator Tab 
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6 シミュレーション 

 

実行・再生・停止・一時停止 

【実行・再生】 

 
1. “Tool Bar” → “Calculation/Replay Combo Box” → [Calculation/Replay] 

2. “Tool Bar” → [Start] 

 

Calculation/Replay Combo Box Start 

６ シミュレーション 

す 
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まず“Calculation/Replay Combo Box”で、計算を行う27（Calculation）か、予め行われた計

算結果を再生（Replay）するかを決定します。次に、[Start]ボタンを押すと、計算／再生が

開始されます。実行中”Main View”上で、時々刻々変化する探針移動や試料の変形の様子を

見ることができます。また計算結果は可視化され”Result View”上に表示されます。シミュレ

ータからのメッセージは、”Log View”上に表示されます。 

 

【停止・一時停止】 

 
1.“Tool Bar” → [Stop] or [Pause] 

 

計算／再生開始後、[Start]ボタンが使用不可となり、[Stop]ボタンが使用可能となります。

[Stop]ボタンを押せば実行を停止します。[Pause]ボタンは再生の場合のみ使用可能です。

このボタンを押すことで、再生を一時停止できます。再開するには、再び[Start]ボタンを押

します。なおシミュレーションの進捗状況は、”Progress Bar”で見ることができます。 

 
 

結果表示 

 

【表示データ選択】 

 
1.“Result View” → [Result Data Combo Box] → 結果出力ファイル選択 

                                                   
27 “Simulator Combo Box”で選択されたシミュレータが実行されます。 

Progress Bar Stop Pause 

Result Data Combo Box 
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”Result Data Combo Box”内には、”Project Editor” → “Simulator Tab” → ”Output” → 

“Directory”以下に書かれている出力結果ファイルのリストが表示されます28。リストからデ

ータを選択すると、データ形式に応じて、グラフや濃淡図などが”Result View”上に描画され

ます。 

 

【数値表示】 

1.“Result View”右クリック → コンテキストメニュー → [Show Data]  

 
 

【名前を付けて保存】 

 
1.“Result View”右クリック → コンテキストメニュー → [Save As…] → “Save As”ダイア

ログ 

2. ファイル名入力 → [保存] 

  

この操作によって、結果出力ファイルを別名、および別の形式で保存できます。 

                                                   
28 表示されるリストは、”Simulator Combo Box”で選択されるシミュレータに応じて変化します。 
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【濃淡図 3D 表示】 

 
 

1.“Result View”右クリック → コンテキストメニュー → [3D-View] 

 

【視点の変更】 

 
1.”Result View”右クリック → コンテキストメニュー → [Top/Front/Side] 

この操作を行うことで、真上（Top）、正面（Front）、真横（Side）に視点が変更されます。

また、Result View 上をドラッグすることにより視角を自由に変更することもできます。

[Shift]+ドラッグすることにより、視点を平行移動させることができます。 

 

【Zoom All】 
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1.”Result View”右クリック → コンテキストメニュー → [Zoom All]29 

この操作によって、描画が”Result View”画面全体に収まるように、自動的に拡大縮小および

平行移動が行われます。 

 

【拡大縮小】 

1. マウスホイール→回転 

マウスホイールを回転させることで、任意の倍率にスケーリングすることができます。 

 

【遠近法表示】 

 
1. ”Result View”右クリック → コンテキストメニュー → [Perspective] 

 

                                                   
29 この操作は、“Tool Bar” → “Zoom All”ボタンをクリックすることによっても行えます。 
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[Perspective]はトグルボタンであり、この操作によって遠近法表示のオンオフを切り替える

ことができます。 
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【濃淡図断面図】 

 
 

1.“Result View”上ダブルクリック → 始点決定 

2.“Result View”上ダブルクリック → 終点決定 

3.“Result View”右クリック → コンテキストメニュー → [3D-View] 

4.“Result View”右クリック → コンテキストメニュー → [Cross-Section] → [Clipping] 
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7 可視化設定 

 
 

コンポーネントの表示／非表示 

 
以下では探針の場合を例にとって説明します。 

 
1.”Main View”右クリック → コンテキストメニュー → [Show Tip]30 

 
試料、画像の表示／非表示も同様の操作で切り替えることができます。 

 
 

視点の変更・Zoom All・拡大縮小・遠近法表示  

 

【視点の変更】 

                                                   
30  [Show Tip] [Show Sample] [Show Image]は各々トグルボタンであり、繰り返しクリックすることでコンポーネン
トの表示／非表示を交互に切り替えられます。 

７ 可視化設定 

す 
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1.”Main View”右クリック → コンテキストメニュー → [Top/Front/Side] 

 
この操作を行うことで視角が変更され、真上（Top）、正面（Front）、真横（Side）から見た

コンポーネントが描画されます。また、どのコンポーネントも選択していない状態で Main 

View 上をドラッグすることにより視角を自由に変更することもできます。[Shift]+ドラッグ

すること、あるいは x と z スライダーバーを動かすことにより、視点を平行移動させるこ

とができます。 

 

Front Top Side 
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【Zoom All】 

 
1.”Main View”右クリック → コンテキストメニュー → [Zoom All]31 

この操作によって、コンポーネントが”Main View”画面全体に収まるように、自動的に拡大

縮小および平行移動が行われます。 

 

                                                   
31 この操作は、“Tool Bar” → “Zoom All”ボタンをクリックすることによっても行えます。 
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【拡大縮小】 

 

1. マウスホイール→回転 

マウスホイールを回転させることで、任意の倍率にスケーリングすることができます。 

 

【遠近法表示】 

 
1. ”Main View”右クリック → コンテキストメニュー → [Perspective] 

[Perspective]はトグルボタンであり、この操作によって遠近法表示のオンオフを切り替えることができます。 

 

View Option 設定 
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【分子描画法切り替え】32 

 
1.”Main View”右クリック → コンテキストメニュー 

2.[View Option] → [Auto/Dot/Ball/Ball&Stick/Cartoon] 

 
この操作によって、分子の描画法を変更できます。[Auto]はコンポーネントデータから適切

な描画法を自動判定します。なお、これらの表示はファイル形式によって表示できないも

のがあります。Ball&Stick は原子間結合情報が必要で、Cartoon は PDB ファイルのみに対

応しています。 

 

【半透明／不透明切り替え】 

                                                   
32現在この操作を行えるのは、”～.pdb”、”～.xyz”、”～.txyz”の拡張子をもつコンポーネントデー
タのみとなっています。  

Dot Cartoon Ball Ball & Stick 
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1.”Main View”右クリック → コンテキストメニュー 

2.[View Option] → [transparent]33, 34 

 

                                                   
33 [transparent]はトグルボタンであり、繰り返しクリックすることで不透明／半透明の表示を交互に切り替えられま
す。 
34 この操作は、”～.cube”、”～.csv”、”～.bmp”、”～.jpg”の拡張子をもつ Grid 形式のファイルに対して有
効です。 
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【等高線表示／非表示切り替え】 

 
1.”Main View”右クリック → コンテキストメニュー 

2.[View Option] → [with wire]35 36 

                                                   
35  [with wire]はトグルボタンであり、繰り返しクリックすることで等高線の表示／非表示を交互に切り替えられま
す。 
36 この操作は、”～.cube”、”～.csv”、”～.bmp”、”～.jpg”の拡張子をもつ形式のファイルに対して有効で
す。 
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8 GUI の終了  

 
 
 
 

 
 
 

1.”Menu Bar” → [File] → [Quit] 

 
 
 
 
 
 
 
  

８ GUI の終了 

す 
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9 その他 

 
 

画面の表示／非表示 

 

 
 

1.”Menu Bar” → [Display] → [Project Editor/Result View/Log View]37 

以上の操作で画面の表示／非表示38の切り替えを行うことができます。また各画面上部の名

称（”Project Editor”など）が書かれているバーをダブルクリックすることで、GUI との切り

                                                   
37 [Project Editor] [Result View] [Log View]はトグルボタンであり、繰り返しクリックすることで画面の表示／非
表示を交互に切り替えられます。 
38非表示は、各画面上部の”×”印をクリックすることでも行えます。 

９ その他 

す 
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離し／ドッキングが行えます。なお、”Main View”を非表示にすることや、GUI と切り離す

ことはできません。 

 
 

コンポーネントの選択 

【選択】 

 
 

1. a. ”Tool Bar” →”Component Combo” → コンポーネント名選択39 

b. ”Project Editor”  → コンポーネント項目クリック 

c. ”Main View”  → コンポーネント周辺ダブルクリック40 

 

1a、1b、1c いずれの方法でもコンポーネントを選択できます。コンポーネントが選択され

ると、”Main View”上で選択コンポーネントを囲む外枠の色が緑から赤に変化します。ある

コンポーネントが選択されている場合、マウスやスライダーバー、キーボードなどの操作

によって、そのコンポーネントの移動、回転を行えます。一方何も選択されていない場合、

同様の操作を行うと視点が変更されます。 

 

【選択解除】 

                                                   
39 “Project Editor”に表示されているコンポーネントのリストがここに表示されます。 
40 この方法で選択できるのは、”～.pdb”、”～.xyz”、”～.txyz”の拡張子をもつコンポーネントデータのみとな
っています。 

Component Combo Box 
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1. a.”Tool Bar” →”Component Combo” →[No Selected] 

b.”Project Editor”  → “Component”クリック 

c.”Main View”  → 背景ダブルクリック 

 

1a、1b、1c いずれの方法でもコンポーネントの選択を解除できます。 

 
 

コンポーネントのデータベース登録 

 

探針データは 

 “インストールディレクトリ¥data¥Tip¥” 

 

試料データは 

 “インストールディレクトリ¥data¥Sample¥” 

以下にデータを直接コピーしてください。ここに登録されたデータは、探針用と試料用

の”DB View”に各々表示されます。なお登録は、”～.pdb”、 ”～.xyz”、 ”～.txyz”の拡張子を

もつコンポーネントデータのみ可能です。また、データと同名の画像ファイル（"データフ

ァイル名.gif”）を同じディレクトリに置いておくと、”DB View”にアイコンが表示されます。 

 
 

イメージの保存 

 

【Main View 画面の保存】 
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1.“Manu Bar”→ [File] → [Export Image] → “Save Capture”ダイアログ 

2. 画像ファイル名入力 → [保存] 
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【Result View 画面の保存】 

 
1.“Result View”右クリック → コンテキストメニュー 

2. [Export Image] → “Save Capture”ダイアログ 

3. 画像ファイル名入力 → [保存] 
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第３章 

計算事例 

 
 

この章では、SPM シミュレータに同梱されているサンプルデータファイルを使って、各シ

ミュレータに代表的な事例と、その計算方法をご紹介いたします。 

なお、ここで紹介されている図は実際のものと異なる場合がございます。 

 
 

1 探針・試料・測定 AFM 像予測シミュレータ 

 

はじめに 

 

「探針・試料・測定 AFM 像高速相互予測シミュレータ」は、探針の立体的な形状データ、

試料表面の凹凸を表現した形状データ、測定 AFM 像データ、の三種類のデータのうち、二

種類のデータから、残り一種類のデータを高速に予測するシミュレーションを実行します。

実際のシミュレーション計算においては、探針－試料間の相互作用(ファンデルワールス力)

は考慮されず、また、探針・試料の 3 次元立体形状は変形しないと仮定して、純粋に幾何

学的な計算により、データを相互予測します。本シミュレーション計算では、カンチレバ

ーは常に試料に接していると仮定しており、いわゆる AFM のコンタクトモードの測定に対

応しています。 

 

本シミュレータは、古典論あるいは量子論の物理学的な方程式を一切考慮せず、探針、試

料、AFM 測定像を、単なる幾何学的な構造物としてとらえ、「測定中、探針は常に試料と接

触している」という仮定だけで、計算を行います。従って、量子論的な性質が支配的なミ

クロの領域での現象を調べるには、本シミュレータは、適していません。一方、ナノスケ

ールオーダーの半導体デバイスの AFM 像をシミュレートする、あるいは、高分子有機化合

物からなる生体試料の AFM による観察画像をシミュレートする、といった、マクロとミク

ロの中間的な領域のスケールでの用途に、本シミュレータは非常に適しています。 

 

以下に、本シミュレータの使用方法を、具体例を交えて説明します。探針・試料・測定 AFM

像高速相互予測シミュレータ(以下、GeoAFM と略する)の使い方として、以下の三種類を紹

介します。 

 探針形状データ、試料表面形状データを元にして、測定 AFM 像データを求める。 

 探針形状データ、測定 AFM 像データを元にして、試料表面形状データを求める。 

 試料表面形状データ、測定 AFM 像データを元にして、探針形状データを求める。 

 

１ 探針・試料・測定 AFM 像高速相互予測シミュレータ

ータ 
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これらのシミュレーション方法を、順を追って見て行きます。 

 

探針形状データおよび試料表面形状データから測定 AFM像データを求める 

 

ここでは、探針がピラミッド型のカンチレバーを使って、HOPG（Highly Oriented Pyrolytic 

Graphite：高配向熱分解黒鉛）上に配置された一個のラクトン系高分子量ポリマー(CLG：ε

カプロラクトン・(L)ラクチド・グリコリド共重合体)の AFM 像を求めることにします。 

 

まず、新しいプロジェクトファイルを作成します。[File]→[New]をクリックすることにより、

[Create new project]というタイトルのボックスが現れます。[Project name]の欄は空欄にな

っています。ここでは、”test-geoafm001”という文字列を直接タイプ入力して、この名前の

プロジェクトファイルを作成することにします。 

 

なお、[Create new project]のボックスの、上から二つ目の項目[Directory]の欄には、本シミ

ュレータの実行ファイルが収められているディレクトリの絶対パスが、予め自動的に書き

込まれています。これは、[Directory]欄内に書き込まれている絶対パスの指定するディレク

トリの直下に、プロジェクト名と同じ名前のディレクトリが作られ、そのディレクトリ内

に、プロジェクトファイルを始めとする様々なデータファイルが自動的に収められること

を意味します。今の場合、このような設定の方が、シミュレーションに関係するデータフ

ァイルが、一か所にまとめられて便利なので、このまま[OK]をクリックします。 

 

次に、[Project Editor]の、[Setup]タブをクリックして選択します。ページの先頭の、項目

[Component]から、探針形状データ、試料表面形状データを、読み込むことにします。まず、

項目[Component]を右クリックして、[Add Tip]の[Pyramid]を選択します。すると、ピラミッ

ド形状の探針先端部分の角度 angle (deg)を要求するボックスが現れます。デフォルト値で

32.0 度が与えられていますので、ここでは、そのまま [OK]とします。次に、再び項目

[Component]を右クリックして、[Add Sample]の[Database]を選択します。すると、予め用

意された試料データの一覧が現れます。ここでは、データベースの先頭に置かれている

[1clg-HOPG]を選択します。 

 

この時点で、ウィンドウは、以下のような画像を表示します。図の中央の水色の正方形が、

ピラミッド型探針を下から見上げた様子を表しています。縦に連なる鎖上の高分子構造、

基盤となるグラファイトの分子も、図に表示されていることが分かります。 
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念のため、この段階で、プロジェクトファイルを保存することにします。[File]→[Save]で、

test-geoafm001.pro ファイルが保存されます。ある程度まとまった作業が完了するたびに、

このようにしてプロジェクトファイルの保存を行うことが可能です。 

 

これより、GeoAFM の計算実行に移ります。マウスを操作して、探針及び試料が表示され

ているウィンドウの適当な場所に、カーソルを配置し、そこで右クリックします。すると、

下の図のように、縦長のコンテキストメニューが現れます。 
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まず、シミュレータの画像解像度を設定します。コンテキストメニューの最も下の項目で

ある[GeoAFM]を選択し、さらに、[Set GeoAFM Resolution]をクリックします。これにより

解像度の数値を直接入力することが出来ます。解像度は、シミュレーション計算を行う際

の、長さの最小単位を表します。解像度は、Å単位で 0.1 以上の実数値を設定することが可

能です。値は、0.1 刻みで変化させることが可能です。また、解像度の最大値は 10 となっ

ています。なお、解像度のデフォルト値は 5[Å]に設定されています。 

 

ここでは、解像度を 1[Å]に設定してみましょう。なお、シミュレータの実際の運用では、

解像度の値は、実験で用いる AFM の解像度を参考にした値を、ユーザーが各自で設定する

のが良いでしょう。また、本シミュレータを使用する際、サンプル全体の大きさに比べて、

非常に小さな値の解像度を取った場合、プログラムの演算処理量が急激に増大してしまい、

事実上、プログラムが止まってしまう(freeze してしまう)場合が有ります。従って、解像度

の決定は、十分な配慮の上で行って下さい。 

 

次に、再び、コンテキストメニューの最も下の項目である[GeoAFM]を選択し、さらに、[Show 

Simulated Image]をクリックします。すると、下図のように、ウィンドウ内に、オレンジ色

の等高線を表現した図が現れます。これが、予測される AFM 画像です。 
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予測 AFM 画像を表示する範囲を変えることができます。[Setup]タブから、探針の始点(x, y)

座標(Å) を[Tip]>[Position]の x, y に入力し、スキャンエリアのサイズを[Tip]>[ScanArea]の

w, d に入力しますと、指定した矩形範囲で AFM 画像を出力できます。一方、[Tip]>[ScanArea]

の w または d のいずれかをゼロにしますと、スキャンエリアは試料サイズを網羅するよう

に自動的に決められます。ここではスキャンエリアを自動的に決める方法を採用します。 

 

出来上がった予測 AFM 画像を見やすくするために、ウィンドウ内から、探針および試料の

画像を取り除くことにします。画像が表示されているウィンドウ内の適当な場所にカーソ

ルを配置し、そこで右クリックします。縦長のコンテキストメニューが現れますので、メ

ニュー内の項目[Show Tip]および[Show Sample]を左クリックして、チェックを外します。 

 

これにより、ウィンドウ内には、予測される AFM 画像のみが表示された状態となります。

ウィンドウ画面内でカーソルをドラッグすると、画像は自由に立体的に回転しますので、

AFM 画像の凹凸が良く見える角度に視点を定めることが可能です。また、ウィンドウ上部

の虫眼鏡マークをクリックすると、画像がウィンドウ内に適切に収まるよう、自動的に画

像表示の拡大・縮小が行われます。例えば、以下の図のように、試料である高分子鎖の高

さの変化が良く見える角度に設定することが可能です。 
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上で求められた予測 AFM 画像を、再利用可能なデータとして保存することにします。画像

が表示されているウィンドウ内の適当な場所にカーソルを配置し、そこで右クリックしま

す。縦長のコンテキストメニューが現れますので、メニュー内の項目[GeoAFM]→[Export 

Simulated Data]を選択します。保存ファイル名を要求されますので、ここでは、

"test-geoafm001-image"と入力します。この結果、予測 AFM 画像は、test-geoafm001- 

image.cube というファイルに保存されます。 

 

以上の作業が終わったら、ひとまず、[File]→[Save]および[Close]として、プロジェクトを

終了させましょう。 

 
 

探針形状データおよび測定 AFM像データから試料表面形状データを求める 

 

ここでは、ピラミッド型の探針形状データと、1clg-HOPG の測定 AFM 像データを元にして、

試料表面形状データを求める方法を説明します。測定 AFM 像データは、前の小節において、

HOPG（Highly Oriented Pyrolytic Graphite：高配向熱分解黒鉛）上に配置された一個のラ

クトン系高分子量ポリマー(CLG：εカプロラクトン・(L)ラクチド・グリコリド共重合体)に

ついて計算して得られた、test-geoafm001-image.cube ファイルを用いることとします。 

まず、新しいプロジェクトファイルを作成します。[File]→[New]により、[Create new project]

ボックスを呼び出します。ここでは、[Project name]の空欄に、”test-geoafm002”という文

字列を直接タイプ入力して、この名前のプロジェクトファイルを作成することにします。 
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[Project Editor]の、[Setup]タブをクリックして選択します。まず、探針形状データを読み込

むことにします。ここでは、前と同じく、ピラミッド形状の探針を選択し、angle (deg)も

デフォルト値の 32.0 度とします。 

 

次に、測定 AFM 像データを読み込むことにします。前と同じく、Component という項目

を右クリックして、[Add Image]、さらに、[File]を選択します。ここで、前の小節で作成し

た、ディレクトリ test-geoafm001 内の test-geoafm001-image.cube という名前のファイル

を選択します。 

 

この時点で、ウィンドウは、以下のような画像を表示します。ただし、ここでは、ウィン

ドウ上部の虫眼鏡マークをクリックして、画像がウィンドウ内に適切に収まるよう、自動

的に拡大・縮小しています。 

 

 
 

ここで、前に説明したのと同様の手順で、シミュレータの画像解像度を、1[Å]に設定しま

す。さらに、前で説明したときと同様に、 [GeoAFM]→[Show Simulated Sample]をクリッ

クします。すると、下図のように、ウィンドウ内に、緑色の等高線を表現した図が現れま

す。これが、シミュレーションによって得られた、試料表面形状データです。(図では、緑

色の試料表面形状データの等高線と、オレンジ色の AFM 像データの等高線が、同時に表示

されているため、黄色っぽい画像になっています。) 
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出来上がった試料表面形状の画像を見やすくするために、項目 [Show Tip]および[Show 

Image]を左クリックしてチェックを外し、ウィンドウ内から、探針および AFM 像の画像を

取り除くことにします。これにより、ウィンドウ内には、試料表面形状データ画像のみが

表示された状態となります。試料画像を適切に立体回転、拡大・縮小して、以下の図のよ

うに、試料である高分子鎖の高さの変化が良く見える角度に設定することが可能です。 
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上で求められた試料表面形状データ画像を、再利用可能なデータとして保存することにし

ます。画像が表示されているウィンドウ内の適当な場所にカーソルを配置し、そこで右ク

リックします。縦長のコンテキストメニューが現れますので、メニュー内の項目[GeoAFM]

→[Export Simulated Data]を選択します。保存ファイル名を要求されますので、ここでは、”

test-geoafm002-sample ” と 入 力 し ま す 。 こ の 結 果 、 試 料 表 面 形 状 デ ー タ は 、

test-geoafm002-sample.cube というファイルに保存されます。 

 
 

試料表面形状データおよび測定 AFM像データから探針形状データを求める 

 

ここでは、1clg-HOPG の試料表面形状データ、および、測定 AFM 像データを元にして、探

針形状データを求める方法を説明します。測定 AFM 像データは、前の小節において、HOPG

（Highly Oriented Pyrolytic Graphite：高配向熱分解黒鉛）上に配置された一個のラクトン

系高分子量ポリマー(CLG：εカプロラクトン・(L)ラクチド・グリコリド共重合体)について

計算して得られた、test-geoafm001-image.cube ファイルを用いることとします。 

 

まず、新しいプロジェクトファイルを作成します。[File]→[New]により、[Create new project]

ボックスを呼び出します。ここでは、[Project name]の空欄に、”test-geoafm003”という文

字列を直接タイプ入力して、この名前のプロジェクトファイルを作成することにします。 

さらに、試料表面形状データを読み込みます。まず、[Setup]タブ上の項目[Component]を右

クリックして、[Add Sample]の[Database]を選択します。すると、予め用意された試料デー

タの一覧が現れます。ここでは、データベースの先頭に置かれている、[1clg-HOPG]を選択

します。 

 

次に、測定 AFM 像データを読み込むことにします。前と同じく、[Component]という項目

を右クリックして、[Add Image]、さらに、[File]を選択します。ここで、前の小節で作成し

た、ディレクトリ test-geoafm001 内の test-geoafm001-image.cube という名前のファイル

を選択します。 

 

この時点で、ウィンドウは、以下のような画像を表示します。 
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ここで、前の小節で説明したように、シミュレータの画像解像度を、1[Å]に設定します。

さらに、[GeoAFM]→[Show Simulated Tip]をクリックします。出来上がった探針の画像を見

やすくするために、ウィンドウ内から、試料および AFM 像の画像を取り除きます。これに

より、以下の図のように、ウィンドウ内には、探針形状データ画像のみが表示された状態

となります。 

 

 
 

上で求められた探針形状データ画像を、再利用可能なデータとして保存することにします。
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画像が表示されているウィンドウ内の適当な場所にカーソルを配置し、そこで右クリック

します。縦長のコンテキストメニューが現れますので、メニュー内の項目[GeoAFM]→

[Export Simulated Data]を選択します。保存ファイル名を要求されますので、ここでは、”

test-geoafm003-tip”と入力します。この結果、試料表面形状データは、 test-geoafm003- 

tip.cube というファイルに保存されます。 
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2 連続弾性体 AFMシミュレータ 

 

はじめに 

 
「連続弾性体 AFM シミュレータ」は、古典力学に基づき、非接触時では探針－試料間での

ファンデルワールス力を考慮し、接触時では探針-試料間で JKR(Johnson, Kendall, Roberts)

理論によって引き起こされる凝着力を考慮します。その上で、探針及び試料が弾性方程式

に従うと仮定して、測定 AFM 像を予測するシミュレーションを実行します。弾性方程式の

解法としては、探針・試料を格子分割した、有限要素法が用いられています。従って、実

際のシミュレーション計算においては、探針形状データおよび試料表面形状データを入力

として、測定 AFM 像データを予測・出力することになります。なお、探針・試料が電解溶

液中にある場合の、電荷イオンのふるまいを考慮した AFM 画像がシミュレーションを行う

機能も実装されています。 

 

本シミュレータでは、以下の三つのモードが用意されています。 

 [ノンコンタクトモード]：カンチレバー先端の探針が、試料表面から数Å離れた状態で

原子間に働く相互作用を測定しつつ、試料表面を走査する状況に対応しています。 

 [周波数シフト像モード]：カンチレバーを外力によって一定の周波数で振動させながら、

非接触で試料表面に近付け、探針-試料間の相互作用により生じる周波数シフトの分布

画像を求める状況に対応しています。 

 [粘弾性接触解析モード]：試料表面の一点上において、外力によってカンチレバーを一

定の周波数で振動させ、探針が試料に接触し、試料内部に押し込まれてから、引き戻

されて離脱する直前までの様子を再現します。 

 [DLVO 理論解析モード]：探針・試料が電解溶液中にある場合の AFM 画像シミュレー

ションを行います。電解溶液中のイオンのふるまいを DLVO (Derjaguin, Landau, 

Verwey, Overbeek)理論で記述します。 

 

本シミュレータは、あくまで、電荷を帯びていない分子・原子間で働くファンデルワール

ス力および JKR 理論を基本とした、古典力学で説明可能な現象を再現する、原子間力顕微

鏡(AFM: Atomic Force Microscope)のシミュレータです。従って、原子・分子を直接観察す

る極微なスケールの現象のシミュレーションには、本シミュレータは不向きと言えます。

しかし、一方、メソスコピックスケールオーダーの半導体デバイスの AFM 像をシミュレー

トする、あるいは、高分子有機化合物からなる生体試料の AFM による観察画像をシミュレ

ートする、といった、マクロとミクロの中間的な領域での現象を調べる用途には、本シミ

ュレータは非常に適しています。 

 

前にも述べましたように、本シミュレータでは、純粋な量子力学的な効果は考慮されませ

２ 連続弾性体 AFM シミュレータ 
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ん。電子のトンネル現象を画像データに取り込む、いわゆる走査型トンネル顕微鏡(STM)

や、その他、様々な量子現象から物質の画像をとらえる走査型プローブ顕微鏡(SPM)のシミ

ュレーションは、本シミュレータの適用範囲外となります。これら、量子力学的効果を取

り入れた SPM シミュレーションは、同梱されている「量子論的 SPM 像シミュレータ」が

適しています。また、量子力学的な取り扱いは行わずに、原子・分子の極微なスケールで

の振る舞いを調べるには、同梱されている「原子分子ナノ材料 AFM 像シミュレータ」が適

しています。 

 

さらに、注意すべき事項としては、本シミュレータは、常に真空(もしくは室温大気中の)

環境下で、AFM 実験が行われていると仮定しています。液体中での AFM 像の再現機能は、

本シミュレータには含まれていません。このような事例の解析には、「液中ソフトマテリア

ル AFM シミュレータ」が適しています。 

 

高分子量ポリマーの測定 AFM 像データ予測(ノンコンタクトモード)  

 

以下に、連続弾性体 AFM シミュレータ(以下、FemAFM と略する)の[ノンコンタクトモード]

での使用方法を、具体例を元にして説明します。探針の受けるファンデルワールス力の試

料表面での分布像が出力されます。 

 

ここでは、探針がピラミッド型のカンチレバーを使って、HOPG（Highly Oriented Pyrolytic 

Graphite：高配向熱分解黒鉛）上に配置された一個のラクトン系高分子量ポリマー(CLG：ε

カプロラクトン・(L)ラクチド・グリコリド共重合体)の AFM 像を求めることにします。た

だし、カンチレバーの先端の探針は、試料から一定の距離だけ離れていて、ノンコンタク

トモードで原子間力を検出するものと仮定します。 

 

まず、新しいプロジェクトファイルを作成します。[File]→[New]をクリックすることにより、

[Create new project]というタイトルのボックスが現れます。[Project name]の欄は空欄にな

っています。ここでは、”test-femafm100”という文字列を直接タイプ入力して、この名前の

プロジェクトファイルを作成することにします。 

 

次に、 [Project Editor]の、 [Setup]タブをクリックして選択します。ページの先頭の

[Component]という項目から、探針形状データ、試料表面形状データを、読み込むことにし

ます。まず、項目[Component]を右クリックして、[Add Tip]の[Pyramid]を選択します。する

と、ピラミッド形状の探針先端部分の角度 angle (deg)を要求するボックスが現れます。デ

フォルト値で 32.0 度が与えられていますので、ここでは、そのまま[OK]とします。次に、

再び項目[Component]を右クリックして、[Add Sample]の[Database]を選択します。すると、

予め用意された試料データの一覧が現れます。ここでは、データベースの先頭に配置され

ている[1clg-HOPG]を選択します。 
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さらに、有限要素法の解像度を設定します。それには、ウィンドウの左側に表示されてい

る[Project Editor]の[FEM]タブを選択します。そのページに設定されている項目のうち、

[simulation]下の[resolution]の右隣の数値にカーソルを合わせて、左ダブルクリックして下さ

い。これにより解像度の数値を直接入力することが出来ます。ここでは、2 [Å]と設定しま

す。 

 

解像度は、シミュレーション計算を行う際の、長さの最小単位を表します。もっと具体的

に述べると、試料および探針に対して有限要素法を行う際の、格子間隔を表しています。

解像度は、Å単位で 0.1 以上の実数値を設定することが可能です。値は、0.1 刻みで変化さ

せることが可能です。また、解像度の最大値は 10 となっています。なお、解像度のデフォ

ルト値は 2 [Å]に設定されています。シミュレータの実際の運用では、解像度の値は、実験

で用いる AFM の解像度を参考にした値を、ユーザーが各自で設定するのが良いでしょう。 

 

この時点で、ウィンドウは、以下のような画像を表示します。 

 

 
 

これより、探針先端部の走査(スキャン)する領域を指定します。まず、[Setup]タブを開いて、

[Sample]の[Size]の項目に注目します。試料の大きさが、幅 w：66.861 [Å]、奥行き d：156.464 

[Å]、高さ h：23.152 [Å]であると、表示されています。 

 

そこで、探針が走査(スキャン)する領域を、幅 w：72 [Å]、奥行き d：160 [Å]と定めます。

これにより、試料全体が走査領域内に完全に含まれることになります。また、走査領域の

縦 w = 72 [Å]、横 d = 160 [Å]の長さが、先ほど指定したシミュレーション解像度 2 [Å]で

割り切れる値であることにも注意します。これにより、探針の走査範囲が、有限要素法の
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格子に丁度の大きさで分割されることが保証されます。 

 

なお、この例では、走査範囲は、36×80 の格子に分割されています。通常、格子サイズが

150×150 を超えると、一般的なパソコンの計算能力を超えることになり、計算時間が目立

って長くなり始めます。例えば、格子数が 200×200 のシミュレーションを行おうとすると、

たいていのパソコンは freeze してしまい、事実上、シミュレーションが不可能となってし

まいます。これらの点に注意して、resolution を設定することをお勧めします。 

 

試料の中央付近に、三次元空間の座標系の原点が設定されています。そこで、[Setup]のタ

ブの[Tip]の項目の下の、[Position]、[ScanArea]の値を、以下のように直接入力します。 

[Position] x = ”-36”, y = ”-80”, z = ”30” 
[ScanArea] w = ”72”, d = ”160”, h = ”0” 
 

ここで、以下の点に注意します。すなわち、[Tip]>[Position]の z の値は、[Sample]>[Size]

の h の値より、十分大きな値を取った方が、有限要素法のシミュレーション計算の実行が

容易になります。試料の最大高さより、探針の高さを十分大きく取らないと、原子間力相

互作用の影響が大きくなり過ぎて、計算が不安定になってしまう可能性があるからです。

（探針と試料の間で働く原子間相互作用の力は、距離の 7 乗に反比例するため、あまり、

探針先端部分と試料とが接近し過ぎると、事実上計算が不可能になる場合が有ります。） 

 

以上の設定の後、マウスを操作して、探針及び試料の画像が表示されているウィンドウの

適当な場所に、カーソルを配置し、そこで右クリックします。すると、縦長のコンテキス

トメニューが現れます。コンテキストメニューの [Show Scan Area]の項目にチェックを入

れると、ウィンドウは、以下のような画像を表示します。紫色の領域が、走査範囲となり

ます。 
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さらに、探針および試料に与えるべき物性値として、ヤング率[GPa]、ポアソン比(無次元量)、

ハーマーカー定数[zJ]が用意されています。これらは、[Setup]タブ以下の、[Tip]>[Property]

および[Sample]>[Property]で入力することが出来ます。これらはデフォルトで、[young] 76.5 

[GPa]、[poisson] 0.22、[hamaker] 50 [zJ]に設定されていますが、適宜変更可能です。ここ

では、デフォルトの値をそのまま使うこととします。 

 

最後に、シミュレーション計算を適切に実行するために、以下の設定を行います。[FEM]

タブ以下の、[OpenMP_threads]の値を入力します。これは、並列化計算を行う際の、CPU

のコア数を表しています。並列化計算を行わない場合は 1 を、例えば四つのコアで並列化

計算する場合は 4 を入力します。デフォルトでは 1 に設定されています。また、[FEM]タブ

の最初の[simulation_mode]から、”femafm_Van_der_Waals_force”を選択します。デフォル

トでこれが設定されていますので、今の場合、そのままにしておきます。 

 

上記の準備の後、ウィンドウの上部のツールバーに配置されている項目を、 [FEM], 

[Calculation]として、三角形のボタンをクリックすると、シミュレーション計算が開始され

ます。最終的に得られる AFM 画像は、メニューバーの[Display]→[Result]で、以下のように

表示されます。 
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さらに、上記 AFM 画像を表示しているウィンドウ内にカーソルを配置して右クリックする

と、コンテキストメニューが現れ、そこで、[3D-View]を選択することが可能です。これに

より、以下の立体的な画像を得ることが出来ます。 

 
 

 
 

シミュレーションによって得られた AFM 画像について、以下の注意が必要です。それは、

試料表面上に与えられた数値が、高さを固定された探針先端の受ける力を表しており、試

料表面の立体形状としての高さ(長さの次元を持つ物理量)を表現した値ではないというこ

とです。具体的には、AFM 画像の試料表面上の各点に与えられた値の単位は[N](ニュートン)

となります。 

 

シリコン結晶表面の AFM 周波数シフト像データ予測(周波数シフト像モード)  

 

以下に、FemAFM シミュレータの[周波数シフト像モード]での使用方法を、具体例を元にし
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て説明します。外力によってカンチレバーを一定の周波数で振動させた際の、探針の試料

から受ける相互作用によって引き起こされる周波数シフトの分布像が出力されます。 

 

ここでは、探針がピラミッド型のカンチレバーを使って、シリコン結晶 Si(001)表面の AFM

周波数シフト像を求めることにします。ただし、カンチレバーの先端の探針は、試料から

離れていて、接触することは無いものと仮定します。 

 

まず、新しいプロジェクトファイルを作成します。[File]→[New]をクリックすることにより、

[Create new project]というタイトルのボックスが現れます。[Project name]の欄は空欄にな

っています。ここでは、”test-femafm200”という文字列を直接タイプ入力して、この名前の

プロジェクトファイルを作成することにします。 

 

次に、 [Project Editor]の、 [Setup]タブをクリックして選択します。ページの先頭の

[Component]という項目から、探針形状データ、試料表面形状データを、読み込むことにし

ます。まず、項目[Component]を右クリックして、[Add Tip]の[Pyramid]を選択します。する

と、ピラミッド形状の探針先端部分の角度 angle (deg)を要求するボックスが現れます。デ

フォルト値で 32.0 度が与えられていますので、ここでは、そのまま[OK]とします。次に、

再び項目[Component]を右クリックして、[Add Sample]の[Database]を選択します。すると、

予め用意された試料データの一覧が現れます。ここでは、 [si001]を選択します。 

 

さらに、有限要素法の解像度を設定します。それには、ウィンドウの左側に表示されてい

る[Project Editor]の[FEM]タブを選択します。そのページに設定されている項目のうち、

[simulation]下の[resolution]の右隣の数値にカーソルを合わせて、左ダブルクリックして下さ

い。これにより解像度の数値を直接入力することが出来ます。ここでは、2[Å]と設定しま

す。 

 

この時点で、ウィンドウは、以下のような画像を表示します。 
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これより、探針先端部の走査(スキャン)する領域を指定します。まず、[Setup]タブを開いて、

[Sample]の[Size]の項目に注目します。試料の大きさが、幅 w：14.28665 [Å]、奥行き d：

13.52978 [Å]、高さ h：8.16468 [Å]であると、表示されています。 

 

そこで、探針が走査(スキャン)する領域を、幅 w：16 [Å]、奥行き d：16 [Å]と定めます。

これにより、試料全体が走査領域内に完全に含まれることになります。また、走査領域の

縦 w = 16 [Å]、横 d = 16 [Å]の長さが、先ほど指定したシミュレーション解像度 2 [Å]で割

り切れる値であることにも注意します。これにより、探針の走査範囲が、有限要素法の格

子に丁度の大きさで分割されることが保証されます。 

 

試料の中央付近に、三次元空間の座標系の原点が設定されています。そこで、[Setup]のタ

ブの[Tip]の項目の下の、[Position]、[ScanArea]の値を、以下のように直接入力します。 

[Position] x = ”-8”, y = ”-8”, z = ”26” 
[ScanArea] w = ”16”, d = ”16”, h = ”0” 
 

以上の設定の後、マウスを操作して、探針及び試料の画像が表示されているウィンドウの

適当な場所に、カーソルを配置し、そこで右クリックします。すると、縦長のコンテキス

トメニューが現れます。コンテキストメニューの [Show Scan Area]の項目にチェックを入

れると、ウィンドウは、以下のような画像を表示します。紫色の領域が、走査範囲となり

ます。 

 

 
 

さらに、探針および試料に与えるべき物性値として、ヤング率[GPa]、ポアソン比(無次元量)、

ハーマーカー定数[zJ]が用意されています。これらは、[Setup]タブ以下の、[Tip]>[Property]

および[Sample]>[Property]で入力することが出来ます。これらはデフォルトで、[young] 76.5 

[GPa]、[poisson] 0.22、[hamaker] 50 [zJ]に設定されていますが、適宜変更可能です。ここ

では、デフォルトの値をそのまま使うこととします。 

 

これら以外のシミュレーションに必要な物性値は、[FEM]タブ以下で設定します。探針の密
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度、および、カンチレバーのばね定数を、[Tip]>[Property]以下の、[density]と[spring_constant]

に入力します。これらの値は、デフォルトでは、 [density] 2329.0 [kg/m3] お よ び

[spring_constant] 0.05 [N/m]と設定されています。試料の表面張力は、[Sample]>[Property]

以下の[surface_tension]に入力します。デフォルトでは、[surface_tension] 0.108 [N/m]と設

定されています。ここでは、これらの値をそのまま使うこととします。 

 

また、カンチレバーの外力による振動を定めるために、振幅と周波数を指定します。これ

には、[FEM]タブの、[simulation]以下の[amplitude]と[frequency]で定義します。ここでは、

[amplitude] 150 [angstrom]、[frequency] 0.5 [GHz]と入力します。 

 

最後に、シミュレーション計算を適切に実行するために、以下の設定を行います。[FEM]

タブ以下の、[OpenMP_threads]の値を入力します。これは、並列化計算を行う際の、CPU

のコア数を表しています。並列化計算を行わない場合は 1 を、例えば四つのコアで並列化

計算する場合は 4 を入力します。デフォルトでは 1 に設定されています。また、[FEM]タブ

の最初の[simulation_mode]の項目を “femafm_frequency_shift” に切り替えます。Value に

対応する入力部をダブルクリックすることで切り替えることができます。 

 

 
 

上記の準備の後、ウィンドウの上部のツールバーに配置されている項目を、 [FEM], 

[Calculation]として、三角形のボタンをクリックすると、シミュレーション計算が開始され

ます。最終的に得られる AFM 周波数シフト画像は、メニューバーの[Display]→[Result]で、

以下のように表示されます。なお、このグラフで表示される 2 次元分布画像の高さ方向の

物理量の単位は[Hz]となります。 
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さらに、上記 AFM 周波数シフト画像を表示しているウィンドウ内にカーソルを配置して右

クリックすると、コンテキストメニューが現れ、そこで、[3D-View]を選択することが可能

です。これにより、以下の立体的な画像を得ることが出来ます。 

 

 
 
 

シリコン結晶表面の AFM 粘弾性接触解析データ予測(粘弾性接触解析モード)  

 

以下に、FemAFM シミュレータの[粘弾性接触解析モード]での使用方法を、具体例を元にし

て説明します。外力によってカンチレバーを一定の周波数で振動させ、探針を試料表面上

のある一点に近付けた際の、探針が試料に接触した後、次に試料内部に押し込まれ、最後

は引き戻されて試料表面から離脱する直前までの、探針の振る舞いをシミュレートします。 

 

ここでは、探針がピラミッド型のカンチレバーを使って、シリコン結晶 Si(001)表面の粘弾

性接触力学を調べることにします。ただし、カンチレバーの先端の探針は、外力によって

一定の周波数で振動しているものとします。 

 

まず、新しいプロジェクトファイルを作成します。[File]→[New]をクリックすることにより、

[Create new project]というタイトルのボックスが現れます。[Project name]の欄は空欄にな

っています。ここでは、”test-femafm300”という文字列を直接タイプ入力して、この名前の

プロジェクトファイルを作成することにします。 

 

次に、 [Project Editor]の、 [Setup]タブをクリックして選択します。ページの先頭の

[Component]という項目から、探針形状データ、試料表面形状データを、読み込むことにし

ます。まず、項目[Component]を右クリックして、[Add Tip]の[Pyramid]を選択します。する

と、ピラミッド形状の探針先端部分の角度 angle (deg)を要求するボックスが現れます。デ

フォルト値で 32.0 度が与えられていますので、ここでは、そのまま[OK]とします。次に、

再び項目[Component]を右クリックして、[Add Sample]の[Database]を選択します。すると、
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予め用意された試料データの一覧が現れます。ここでは、 [si001]を選択します。 

 

さらに、有限要素法の解像度を設定します。それには、ウィンドウの左側に表示されてい

る[Project Editor]の[FEM]タブを選択します。そのページに設定されている項目のうち、

[simulation]下の[resolution]の右隣の数値にカーソルを合わせて、左ダブルクリックして下さ

い。これにより解像度の数値を直接入力することが出来ます。ここでは、2[Å]と設定しま

す。 

 

この時点で、ウィンドウは、以下のような画像を表示します。 

 

 
 

これより、探針先端部の走査(スキャン)する領域を指定します。[粘弾性接触解析モード]に

おいては、探針を試料表面のある一点に接触させるので、走査領域を指定する必要はない

のですが、形式的に設定します。ただし、調べたい試料上の一点は、走査領域内に含まれ

ている必要が有ります。まず、[Setup]タブを開いて、[Sample]の[Size]の項目に注目します。

試料の大きさが、幅 w：14.28665 [Å]、奥行き d：13.52978 [Å]、高さ h：8.16468 [Å]で

あると、表示されています。 

 

そこで、探針が走査(スキャン)する領域を、幅 w：16 [Å]、奥行き d：16 [Å]と定めます。

これにより、試料全体が走査領域内に完全に含まれることになります。また、走査領域の

縦 w = 16 [Å]、横 d = 16 [Å]の長さが、先ほど指定したシミュレーション解像度 2 [Å]で割

り切れる値であることにも注意します。これにより、探針の走査範囲が、有限要素法の格

子に丁度の大きさで分割されることが保証されます。 

 

試料の中央付近に、三次元空間の座標系の原点が設定されています。そこで、[Setup]のタ

ブの[Tip]の項目の下の、[Position]、[ScanArea]の値を、以下のように直接入力します。 

[Position] x = ”-8”, y = ”-8”, z = ”6” 
[ScanArea] w = ”16”, d = ”16”, h = ”0” 
 

以上の設定の後、マウスを操作して、探針及び試料の画像が表示されているウィンドウの
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適当な場所に、カーソルを配置し、そこで右クリックします。すると、縦長のコンテキス

トメニューが現れます。コンテキストメニューの [Show Scan Area]の項目にチェックを入

れると、ウィンドウは、以下のような画像を表示します。紫色の領域が、走査範囲となり

ます。 

 

 
 

さらに、探針および試料に与えるべき物性値として、ヤング率[GPa]、ポアソン比(無次元量)、

ハーマーカー定数[zJ]が用意されています。これらは、[Setup]タブ以下の、[Tip]>[Property]

および[Sample]>[Property]で入力することが出来ます。これらはデフォルトで、[young] 76.5 

[GPa]、[poisson] 0.22、[hamaker] 50 [zJ]に設定されていますが、適宜変更可能です。ここ

では、デフォルトの値をそのまま使うこととします。 

 

これら以外のシミュレーションに必要な物性値は、[FEM]タブ以下で設定します。探針の密

度、および、カンチレバーのばね定数を、[Tip]>[Property]以下の、[density]と[spring_constant]

に入力します。これらの値は、デフォルトでは、 [density] 2329.0 [kg/m3] お よ び

[spring_constant] 0.05 [N/m]と設定されています。試料の表面張力は、[Sample]>[Property]

以下の[surface_tension]に入力します。デフォルトでは、[surface_tension] 0.108 [N/m]と設

定されています。ここでは、これらの値をそのまま使うこととします。 

 

また、カンチレバーの外力による振動を定めるために、振幅と周波数を指定します。これ

には、[FEM]タブの、[simulation]以下の[amplitude]と[frequency]で定義します。ここでは、

[amplitude] 150 [angstrom]、[frequency] 0.5 [GHz]と入力します。さらに、探針を接触させ

る試料表面上の一点を指定します。これには、[FEM]タブの、[JKR_position]以下の[ix]と[iy]

で指定します。この[ix]、[iy]は、前で指定したスキャン(走査)エリアを、resolution で分割し

た際の格子点を意味します。左下隅から数えて x 方向に[ix]番目、y 方向に[iy]番目というよ

うに指定します。ここでは、[ix]として 5、[iy]として 1 を入力します。 

 

最後に、シミュレーション計算を適切に実行するために、以下の設定を行います。[FEM]
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タブ以下の、[OpenMP_threads]の値を入力します。これは、並列化計算を行う際の、CPU

のコア数を表しています。並列化計算を行わない場合は 1 を、例えば四つのコアで並列化

計算する場合は 4 を入力します。デフォルトでは 1 に設定されています。また、[FEM]タブ

の最初の[simulation_mode]の項目を “femafm_JKR” に切り替えます。Value に対応する入

力部をダブルクリックすることで切り替えることができます。 

 

上記の準備の後、ウィンドウの上部のツールバーに配置されている項目を、 [FEM], 

[Calculation]として、三角形のボタンをクリックすると、シミュレーション計算が開始され

ます。計算結果は、フォルダ test-femafm300 内の、femafm_simulation_tip_delta_force.csv

という名前のファイルに収められます。 

 

ファイル femafm_simulation_tip_delta_force.csv は、Excel で開くことが出来ます。数値デ

ータは、四つの列にまとめられており、左から順番に、計算時間ステップ数(整数値)、時刻

[sec]、探針の変位[m]、探針が試料から受ける外力[N]となっています。 

 

探針の変位及び外力は、以下の図に示すように定義されています。変位δは、変形前の試料

表面を高さゼロの原点として、探針先端部の深さを表すとします。探針にかかる外力 F は、

上向きを正として、探針-試料間の相互作用を表すとします。従って、外力 F には、カンチ

レバーを振動させる励振のための外部から印加される力は含まれないとしています。 

 
このとき、探針の変位-外力のグラフは以下のようになります。 

 

δ 

0 
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分かりやすくするため、グラフの右上部分 ( 1.01.0   [nm], 2.02.1  F [nN]) を拡

大すると、以下のグラフが得られます。 

 

 
 

上のグラフの見方は、以下の通りとなります。探針は、赤い矢印に沿って動くものとしま

す。すなわち、探針は、まず、試料表面から上部に突き出た部分で接触し、そのまま試料

の内部に押し込まれます。凝着力がゼロになる位置まで押し込まれると、探針は、今度は、

試料から離れる方向に引き戻されることになります。シミュレーションでは、探針が試料

から離脱する直前まで計算がなされています。 

 

今の場合、カンチレバーのばね定数が小さいため、ファンデルワールス力の領域から JKR

理論の領域へ slip-in する際の、グラフの直線の傾きは小さく、ほとんど水平に近くなって
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います。また、探針が試料から離脱する過程はシミュレーションでは再現されない設定と

なっています。これは、探針が JKR 理論からファンデルワールス分子間力に slip-out する

過程では、カンチレバーのばね定数が小さい場合、無限遠に近い距離に飛ばされてしまう

ケースが多いからです。 

 

酸化シリコン基板上に付着している分極した水分子の AFM 画像予測(DLVO 理論解

析モード) 

 

以下に、FemAFM シミュレータの[DLVO 理論解析モード]での使用方法を、具体例を元にし

て説明します。DLVO 理論とは、Derjaguin, Landau, Verwey, Overbeek 理論の略で、電解溶

液中に形成される電気二重層の相互作用を記述する理論です。DLVO 理論では、探針・試料

表面には負イオンが付着し、マイナスに帯電しているとします。探針・試料は、正・負の

両方のイオンが溶け込んだ電解溶液中にあるとします。溶液中の正イオンは、探針・試料

表面に沿って、電気二重層を形成します。このため、探針・試料間に斥力が生じます。探

針・試料表面と電気二重層の間の距離は、デバイ長さと呼ばれる量で特徴付けられます。

FemAFM シミュレータの[DLVO 理論解析モード]では、ファンデルワールス力と、電気二重

層による斥力の、二種類の相互作用を考慮して、AFM 像をシミュレートします。 

 

シミュレーションにおいては、探針は、高さ一定モードで試料表面をスキャンするとしま

す。また、試料表面に、電荷を置くことが可能です。例えば、正の電荷と負の電荷を、試

料表面上に約 1[Å]の距離だけ離して並べると、分子オーダーの電気双極子を形成すること

ができます。これを、分極した水分子と見なすことができます。 

 

この節で説明するシミュレーションの具体例に関するデータ類は、SPM シミュレータがイ

ンストールされているフォルダ内にある、SampleProject という名前のフォルダに全て収め

られています。その中には、project ファイルも含まれています。ですので、その project フ

ァイルを、SPM シミュレータで開いて見ながら説明を行うこととします。 

 

まず、SPMSimulator.exe という実行ファイルをダブルクリックして、SPM シミュレータを

起動します。[File]->[Open]をクリックします。すると、project ファイルを選択する画面が

現れます。ここでは、SampleProject/FEM/FemAFM_DLVO/FemAFM_DLVO_Inorganic_001

というフォルダ内の、FemAFM_DLVO_Inorganic_001.pro というん前のファイルを開いて

ください。すると、以下の画面が現れます。 
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この画面では、探針と試料が小さく描かれていますので、これを拡大することにします。

画面の黒い背景にマウスのカーソルを置いて右クリックします。そこで、[Top (X-Y)]を選択

します。すると、画像は以下のように拡大されます。 
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これより、各項目の設定方法を説明します。まず、探針の設定方法を説明します。

[Component]を右クリックして、[Add Tip]->[Sphere]を選択します。すると、radius(A)を尋

ねられますので”1”[angstrom]と設定します。次に、[Position]->[x], [y], [z]を入力します。こ

の段階では、[Position]->[x]は”0”となっているはずです。そこで、この数字の”0”の部分をダ

ブルクリックすると、数値を入力できるようになります。ここでは、”-6”と入力してくださ

い。同様にして、[y]として”-6”を、[z]として”4”を入力してください。さらに、さらに、

[ScanArea]として、[w]に”12”を、[d]に”12”を、[h]に”0”を入力してください。 

 

次に、試料の設定方法を説明します。[Component]を右クリックして、[Add Sample]->[File]

を選択します。すると、試料のデータファイルを選択する画面が現れます。ここでは、

SampleProject/FEM/FemAFM_DLVO/FemAFM_DLVO_Inorganic_001 というフォルダ内の、

sample.cube という名前のファイルを選択します。これで、試料の設定は終わりです。 

 

探針・試料を設定する際、 

Young 76.5[GPa] 
Poisson 0.22 
Hamaker 50[zJ] 

というように、ヤング率、ポアソン比、ハーマーカー定数が設定される。これらの値は酸

化シリコン基板を参考にしたものである。 

 

ここで、いったん、project ファイルを保存することにします。[File]->[SaveAs]をクリック

します。すると。Save Project という画面が現れます。Project name は、”test001”としま

す。Directory は、SampleProject/FEM/FemAFM_DLVO/FemAFM_DLVO_Inorganic_001 と

します。Directory を選択するには、右側の[Ref]というボタンをクリックします。[OK]ボタ

ンをクリックして保存してください。ここで、[File]->[Close]として、ファイルを一度閉じ

ます。 

 

この段階で、フォルダ 

SampleProject/FEM/FemAFM_DLVO/FemAFM_DLVO_Inorganic_001 内に、test001 という

名前の新しいフォルダができているはずです。このフォルダ内を見てみましょう。すると、

test001.pro という名前のファイルがあります。これから、このファイルを編集することに

します。ファイル test001.pro を適当なテキストエディタで開いてください。編集するのは

二か所です。 

 

まず一か所目は、<FEM headers="name,value,unit,descriptions">という記述の下に、次の

文を挿入します。 

<simulation_mode 
options="femafm_Van_der_Waals_force,femafm_frequency_shift,femafm_JKR,femafm_DL
VO">femafm_DLVO</simulation_mode> 

これにより、SPM シミュレータは、FemAFM ソルバーにおいて DLVO 理論解析モードで動

作することになります。 
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次に、二か所目は、</JKR_Position>という記述の下に、DLVO_parameters として、次の文

を挿入します。 

<DLVO_parameters><number_density_ions unit="M">0.01</number_density_ions> 
            <valency_ion type="int">1</valency_ion> 
            <temperature unit="K">300</temperature> 
            <relative_permittivity>80.4</relative_permittivity> 
            <boundary_condition 
options="surface_potential,surface_charge_density">surface_potential</boundary_conditio
n> 
            <surface_potential_tip unit="V">-0.05</surface_potential_tip> 
            <surface_potential_sample unit="V">-0.05</surface_potential_sample> 
            <surface_charge_density_tip unit="C/m2">-0.3</surface_charge_density_tip> 
            <surface_charge_density_sample 
unit="C/m2">-0.3</surface_charge_density_sample> 
            <local_charges><number_local_charges 
type="int">12</number_local_charges> 
                <charge_value_0 unit="e">0.38</charge_value_0> 
                <charge_position_x_0 unit="angstrom">3.5</charge_position_x_0> 
                <charge_position_y_0 unit="angstrom">1.0</charge_position_y_0> 
                <charge_value_1 unit="e">-0.38</charge_value_1> 
                <charge_position_x_1 unit="angstrom">3.5</charge_position_x_1> 
                <charge_position_y_1 unit="angstrom">2.0</charge_position_y_1> 
                <charge_value_2 unit="e">0.38</charge_value_2> 
                <charge_position_x_2 unit="angstrom">0.9</charge_position_x_2> 
                <charge_position_y_2 unit="angstrom">3.5</charge_position_y_2> 
                <charge_value_3 unit="e">-0.38</charge_value_3> 
                <charge_position_x_3 unit="angstrom">0.0</charge_position_x_3> 
                <charge_position_y_3 unit="angstrom">4.0</charge_position_y_3> 
                <charge_value_4 unit="e">0.38</charge_value_4> 
                <charge_position_x_4 unit="angstrom">-2.6</charge_position_x_4> 
                <charge_position_y_4 unit="angstrom">2.5</charge_position_y_4> 
                <charge_value_5 unit="e">-0.38</charge_value_5> 
                <charge_position_x_5 unit="angstrom">-3.5</charge_position_x_5> 
                <charge_position_y_5 unit="angstrom">2.0</charge_position_y_5> 
                <charge_value_6 unit="e">0.38</charge_value_6> 
                <charge_position_x_6 unit="angstrom">-3.5</charge_position_x_6> 
                <charge_position_y_6 unit="angstrom">-1.0</charge_position_y_6> 
                <charge_value_7 unit="e">-0.38</charge_value_7> 
                <charge_position_x_7 unit="angstrom">-3.5</charge_position_x_7> 
                <charge_position_y_7 unit="angstrom">-2.0</charge_position_y_7> 
                <charge_value_8 unit="e">0.38</charge_value_8> 
                <charge_position_x_8 unit="angstrom">-0.9</charge_position_x_8> 
                <charge_position_y_8 unit="angstrom">-3.5</charge_position_y_8> 
                <charge_value_9 unit="e">-0.38</charge_value_9> 
                <charge_position_x_9 unit="angstrom">0.0</charge_position_x_9> 
                <charge_position_y_9 unit="angstrom">-4.0</charge_position_y_9> 
                <charge_value_10 unit="e">0.38</charge_value_10> 
                <charge_position_x_10 unit="angstrom">2.6</charge_position_x_10> 
                <charge_position_y_10 unit="angstrom">-2.5</charge_position_y_10> 
                <charge_value_11 unit="e">-0.38</charge_value_11> 
                <charge_position_x_11 unit="angstrom">3.5</charge_position_x_11> 
                <charge_position_y_11 unit="angstrom">-2.0</charge_position_y_11> 
            </local_charges> 
        </DLVO_parameters> 

しかし、これらの文章を書きこむのは大変なので、既に用意されている project ファイル

FemAFM_DLVO_Inorganic_001.pro をテキストエディタで開いて、コピー＆ペーストする

のが良いでしょう。DLVO_parameters の各項目の意味は、以下で説明します。 
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編集した project ファイル test001.pro、または、既に用意されていた project ファイル

FemAFM_DLVO_Inorganic_001.pro を、SPM シミュレータで開いてみてください。シミュ

レータのウィンドウ画面の上部中央にある、ソルバー選択欄を”FEM”とします。そして、ウ

ィンドウ画面左側上部のタブとして、”FEM”を選択してください。すると、以下の画面にな

ります。 

 

 
 

画面の左半分に、DLVO 理論解析モードに必要な情報が表示されています。まず、一番上の

行に、simulation_mode として femafm_DLVO が表示されています。これは、FemAFM ソ

ルバーの DLVO 理論解析モードが選択されていることを表しています。 

次に、DLVO_parameters を見てみます。各項目の意味は、次の通りです。 

 

(1) [number_density_ions] 

電解溶液中の正イオンの濃度を表しています。単位は[M]です。ここでの単位[M]は、

モル毎立方デシメートル[
3 mol dm ]を意味します。 

(2) [valency_ion type] 

電解溶液中の正イオンの電荷数を表しています。無次元量です。例えば、
Na イオン

が溶け込んでいるなら、この値は”1”となります。 

(3) [temperature] 

温度を表しています。単位は[K]です。 

(4) [relative_permittivity] 

電解溶液の比誘電率を表しています。無次元量です。 
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(5) [boundary_condition] 

DLVO 理論の境界条件の取り方を指定します。値としては、surface_potential と

surface_charge_density の二種類があります。surface_potential を選択すると、探

針・試料の表面電位を指定しなくてはなりません。surface_charge_density を選択す

ると、探針・試料の表面電荷を指定しなくてはなりません。 

(6) [surface_potential_tip] 

境界条件として指定される、探針表面の電位を表しています。単位は[V]です。

boundary_condition が surface_potential に指定されたときだけ有効です。典型的な

表面電位の値は-100[mV]から-50[mV]の間です。 

(7) [surface_potential_sample] 

境界条件として指定される、試料表面の電位を表しています。単位は[V]です。

boundary_condition が surface_potential に指定されたときだけ有効です。典型的な

表面電位の値は-100[mV]から-50[mV]の間です。 

(8) [surface_charge_density_tip] 

境界条件として指定される、探針の表面電荷密度を表しています。単位は[
2/ mC ]です。

boundary_condition が surface_charge_density に指定されたときだけ有効です。典

型的な表面電荷密度の値は、およそ-0.3[
2/ mC ]です。 

(9) [surface_charge_density_sample] 

境界条件として指定される、試料の表面電荷密度を表しています。単位は[
2/ mC ]です。

boundary_condition が surface_charge_density に指定されたときだけ有効です。典

型的な表面電荷密度の値は、およそ-0.3[
2/ mC ]です。 

(10) [local_charges] 

試料表面に局所的に置かれる電荷を指定します。 

(11) [number_local_charges] 

試料表面に置かれる電荷の総数を表しています。例えば、2 個の電荷を試料表面に置き

たいなら、”2”を指定します。電荷を置かない場合は”0”を指定してください。 

(12) [charge_value_0] 

1 番目の電荷の電気量を表しています。単位は電気素量[|e|]です。” charge_value_0”

という文字列の末尾の番号が、何番目の電荷かを表しています。”0”番から始まること

に注意してください。 

(13) [charge_position_x_0] 

1 番目の電荷の位置の x 座標を表しています。単位は[angstrom]です。 

(14) [charge_position_y_0] 

1 番目の電荷の位置の y 座標を表しています。単位は[angstrom]です。 

 

試料表面上に局所的に電荷を置く場合、次の点に注意が必要です。FemAFM ソルバでは、
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試料は有限要素法に従って小さなメッシュに分割されます。局所電荷は、指定された(x,y)

座標の位置の試料表面に自動的に設置されます。ですから、局所電荷の z 座標は指定しな

い仕様となっています。そして、もし指定した(x,y)座標の位置に試料のメッシュ要素が存

在しない場合は、局所電荷を設置できないこととなり、エラーとなってシミュレーション

計算は停止します。この際、以下のエラーメッセージが表示されます。 

Error: A local charge is not put on the surface mesh element: charge_No. i=0 

これは、”0”番の局所電荷、すなわち、1 番目の局所電荷を設置しようとしたところ、対応

する試料のメッシュ要素が存在しなかったことを表しています。 

 

この時点で、SPM シミュレータのウィンドウに表示されている画面の黒い背景にマウスの

カーソルを置いて、右クリックして[Show Scan Area]を選択してみてください。以下の画

面が表示されるはずです。 

 

 
 

赤い四角形は局所的に置かれた正電荷を、緑の四角形は局所的に置かれた負電荷を表して

います。以上の入力作業が終わったら、シミュレーションを開始することができます。ウ

ィンドウ上部の三角形のボタンをクリックすればシミュレーションがスタートします。 

 

なお、並列計算により高速化を行いたい場合は、ウィンドウの左側の FEM のタブで表示さ

れる項目の中の、OpenMP_threads を例えば”4”に指定すれば、4 コアで並列計算が行われ

ます。 
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project ファイルには、<simulation><resolution>という項目が設定されています。これ

は、有限要素分割する際のメッシュの長さの単位を表しています。Resolution の設定可能

な最小長さは 0.1[angstrom]です。この resolution をあまり小さく設定すると、メッシュ

の数が増大し、計算時間が増大してしまうことがありますので、注意が必要です。 

 

この節で紹介した計算例によって得られる AFM 画像を以下に示します。 

 

正・負に帯電したイオンの双極子が、分極した水分

子を表現しています。正の電荷イオンは引力を、負

の電荷イオンは斥力を引き起こします。 

 

なお、シミュレーション計算が終了すると、計算を

行ったフォルダ内に log.txt という名前のファイル

が生成されます。このファイル内には、いくつかの

重要な計算データが含まれています。そのことにつ

いて、以下で説明します。 

 

 

まず、log.txt を適当なテキストエディタで開いてください。そして、”Debye_length”と

いうキーワードで検索してください。すると、例えば、以下のような行を見つけることが

できます。 

Debye_length =3.088188e-009 [m] 

これは、今回、シミュレーション計算した系においては、デバイ長さが約 3.09[nm]である

ことを示しています。 

 

また、”derived_”というキーワードで検索すると、例えば、以下の行を見つけることがで

きます。 

derived_surface_charge_density_tip=-1.152580e-002 [C/m2] 

derived_surface_charge_density_sample=-1.152580e-002 [C/m2] 

これらは、boundary_condition を surface_potential とした場合の、その表面電位から導

出される、探針・試料表面のバックグラウンドとしての表面電荷密度を表しています。こ

れらの表面電荷密度の値には、局所的に置かれた電荷の影響は考慮されていません。一方、

boundary_condition が surface_charge_density の場合には、その表面電荷密度から導

出される、探針・試料のバックグラウンドとしての表面電位が、 

derived_surface_potential_tip および derived_surface_potential_sample として出力
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されます。これらの表面電位の値には、局所的に置かれた電荷の影響は考慮されていませ

ん。 

 

なお、ファイル log.txt は、シミュレーションをするたびに、追加で上書きされます。です

ので、”Debye_length”、 ”derived_”でキーワード検索する際は、ファイル中の、なるべ

く後ろの方の、当該行を参照してください。 
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3 液中ソフトマテリアル AFM シミュレータ 

 

はじめに 

 

ここでは、液中ソフトマテリアル AFM シミュレータで計算することのできる事例を紹介

いたします。現在まだ開発段階ですが、本シミュレータとしては以下のような計算を行う

ことができます。 

 

   ✎流体抗力、試料との接触応力を受けて稼動するカンチレバーの振動・変形 

✎探針が試料に接触した際に働く力 

   ✎カンチレバーの共鳴振動スペクトルの特性（開発中） 

 

 カンチレバーの根元を強制振動させると、カンチレバー全体が振動し周辺の流体が攪拌

され流れの場が生じます。そのため、レバーは流体の圧力や粘性力を受けることになりま

す。 

 
また、レバーの先端に取り付けられた探針が粘弾性試料に接触した際には、その接触力も

受けます。これらの力とレバー自身の弾性変形による応力のため、レバーの振動は複雑な

動きになります。本シミュレータではゴム表面や細胞表面など比較的マクロスケールの粘

弾性ソフトマテリアル試料の AFM 像計測をシミュレーションするのに適しております。 

 

計算を実行するための初期条件として、大きく分けて、カンチレバー、液体、試料の３種

類の条件設定があります。各分類には下記のようなパラメータがあります。 

 

  ➢カンチレバーの設定 

    ・形状（長さ、幅、厚さ、傾き） 

・密度、縦弾性係数(ヤング率)、横弾性係数(ポアソン比) 

    ・振動モード(振幅，周波数，多重波，捩れ角度) 

        

➢流体の設定 

  ・物性（密度、動粘性率） 

 

➢ソフトマテリアル試料の設定 

・形状（高さ） 

・物性（ヤング率、ダンパー定数、メニスカスの張力） 

３ 液中ソフトマテリアル AFM シミュレータ 



 93 

 

これらの条件設定を元に計算を実行すると、以下の値が結果として出力されます）。 

 

➢カンチレバーの各点での物理量の時間変化 

  ・上下振動：高さ、速度、傾き、流体抗力 

  ・捩れ振動：捩角、捩角速度、流体抗力モーメント 

➢探針に働く力、探針に働くモーメント 

➢カンチレバーの共鳴曲線 

 
※現在は、カンチレバー先端の高さの時間変化、振幅の時間変化、捩れ角度、探針が受け

る力の時間変化のみの出力に対応しております。 

 

今後は、ソフトマテリアル、及びバイオ系材料の SPM 計測での高速スキャンにも対応した

シミュレーションを可能にする予定です。 

 
 

水中でのカンチレバーの動作 

 

※ご注意※ 

SPM Simulator のインストール先に[SampleProject/LIQ]フォルダが存在する場合は、フ

ォルダごと削除してください。今回のバージョンでは、前回のプロジェクトファイルを読

むことはできませんのでご注意ください。 

 

ここでは、水中でカンチレバーを振動させたときのシミュレーション事例をご紹介いたし

ます。カンチレバーが振動する様子を視覚的に表示することができます。 

 

同梱されております、ソフトウェア LiqGUI.exe を起動してください。そして、プロジェク

トを新規作成してください。プロジェクトの作成方法に関しましては、他のソフトウェア

と同様ですので、p 23 を御覧になり手順に沿っておこなって下さい。すると以下の画面が

立ち上がります。 
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基本的な画面構成は、SPMSimulator.exe と同じです。ただし、右側のメイン画面にはカン

チレバーが表示され、画面左側の[Project Editor]には、本ソフトウェア専用の設定画面

になっています。 

 

画面左側の[Project Editor]を見てください。 

 [LIQ]ー[Mode setting]タブが左図の

ようになっています。 

ここでは、赤枠で囲った部分の設定を行

ないます。 

 

① シミュレーションモードの選択 

② 測定環境の設定 

③ 並列計算の設定 

 

まず、① Simulation Mode では計算モ

ードを選択します。ここでは、[Point 

oscillation]になっていることを確認

してください。これはカンチレバーを１

点のみ、指定した回数振動させるモード

です。 

 

これに対して、試料の表面を平面走査す

る計算モードもあります（開発中）。 

 

次に、② environment を設定します。 

① 

② 

③ 
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ここではカンチレバーを真空中か液体中のどちらで振動させるかを設定します。今回は水

中で振動させるので[Fluid]を選択してください。 

 
 

最後に、③ Number of CPUs で並列計算の設定を行ないます。 

 
計算に使用するスレッドの数を入力してください。▲▼ボタンで数値を上下させることも

できます。 

この項目は液中計算のみに設定可能となります。従って、①で[vacuum]を選択した場合は

設定できません。流体計算には非常に時間がかかるので、並列処理によって時間短縮を図

ることができます。お使いのコンピュータに搭載されている CPU コア数（HT テクノロジ

ー搭載であれば、スレッド数＝コア数×２など）を上限として、任意の数値を入力すること

が可能です。 

 

次に、[input data]タブを選んでください。すると以下のような画面になります。 
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ここでは、具体的な初期パラメータの数値入力を行ないます。 

重要なものは赤枠で囲った箇所④～⑩で、大まかな意味は以下のとおりです。詳しくは別

冊「リファレンスマニュアル」を御覧下さい。 

 

④ 

⑤

 

⑥ 

⑦ 

⑧ 

⑨ 

⑩ 
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           ④ 流体の設定 

           ⑤ カンチレバーの物性に関する設定 

           ⑥ カンチレバーの形状に関する設定 

           ⑦ カンチレバーの振動に関する設定 

           ⑧ 探針―試料間の距離の設定 

           ⑨ 試料の物性に関する設定 

           ⑩ 時間ステップ、計算の収束判定に関する設定 

            

このサンプルプロジェクトファイルには、④に水の物性値と、⑤にシリコンカンチレバー

の物性値を予め入力してあります。液体の物性値とカンチレバーの材料物性値を変更した

い場合は、この項目を修正してください。 

 

⑥では、基本となるカンチレバーの形状を入力します。カンチレバーの分割を多くして詳

細に計算したい場合は[sections]欄を大きい数にしてください。ただし、計算時間がかか

るのでご注意ください。 

 

⑧では、探針の最下端と試料の上端との距離を設定しますが、カンチレバーの振幅（⑦の 

[amplitude] の値）と試料の高さ（⑨の[touch]）を考慮して、探針を試料に近づけすぎ

ないように注意してください。 

 

また、液中の計算は時間がかかるので、この⑩の数値を調節することで計算時間の短縮を

図ることができます。真空中のシミュレーションでは比較的短時間で終了するので値を大

きく設定しても支障ありません。例えば水中計算の場合は[simulation] > [time] > 

[max_cycles]を 30 程度に、真空中計算の場合は 300 程度にするといいでしょう。

[convergence] > [criterion]には “0.0” を入力します。 

 

 
 

その他のパラメータについての詳細はリファレンスマニュアルを参照して下さい。 

 
 

各パラメータについて、単位を変更したい場合は、[unit]

欄の単位をダブルクリックしてください。すると、単位の一

覧が表示されるので、その中から選んで変更してください。 

[um]：μm、[ang]：Å です。 

 
 

最後にカンチレバーの形状を設定します。[Cantilever]タブをクリックして下さい。 
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以下のような画面が表示されます。 

 
 

⑪ 探針位置 

⑫ カンチレバー形状 

⑬ 穴の形状 

 

まず、⑫でカンチレバーの形状を設定します。図中の灰色の長方形がカンチレバーを表し

ており、右側が先端となります。緑のひし形が探針を表します。 

 
 

上図のように、Ⓐ、Ⓑのスライダーバーでカンチレバーを削っていき、形状を設定してく

ださい。同時にメイン画面を見ながらカンチレバーの形状を確認してください。 

 

次に、⑪Tip Position で探針位置を設定します。スライダーバーⒸを動かして探針位置

を決めてください。カンチレバーの先端に探針が付いている場合は、特に動かす必要はあ

りません。 

 

⑪ 

⑫ 

⑬ 

Ⓒ 

Ⓑ 

Ⓐ 
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穴の空いたカンチレバーの場合は、⑬Slit を設定します。 

 
 

[Slit]にチェックを入れると、スリットの長さと幅を入力できるようになります。[Basic 

Structure]の項目を見ながら、穴の大きさがカンチレバー全体より大きくならないように注

意してください。そして、スライダーバーⒹで穴の位置を移動してください。 

メイン画面にも形状を修正したカンチレバーが表示されます。 

 

 
 

以上で液中シミュレーションをする場合の基本的な設定は終了です。 

初期設定が終了したら、シミュレーションを開始する前にメニューバーから[Display]―

[Result View]を選択してグラフウィンドウを表示して下さい。 

 

スタートボタンを押して計算を開始すると下図のようにカンチレバーの運動の様子を動画

で見ることができます。 

Ⓓ 
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液体中のシミュレーションの場合、カンチレバーの周りの流体の速度が表示されます。 

 
 

カンチレバーの動きや流体の速度をもっと誇張したい場合は、メイン画面でマウスを右ク

リックしてください。右クリックをすると以下のようなメニューが表示されます。 

 
      show bar ・・・・・・・カンチレバーの表示／非表示。 

      enlarge motion  ・・・・カンチレバーの動きが大きくなります。 

      shrink motion ・・・・・カンチレバーの動きが小さくなります。 

      show fluid velocity ・・・流体の速度の表示／非表示。 

      enlarge velocity  ・・・・流体の速度が大きくなります。 
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      shrink velocity ・・・・・流体の速度が小さくなります。 

 

計算が開始されると、結果がファイルに次々と出力され、グラフに表示されます。 

 
この計算で出力されるものは以下のものです。 

  

出力内容 ファイル名 ファイル形式 

カンチレバーの動画 barmotion.bar バイナリ 

流体の速度 （液中計算の場合のみ） fluidmotion バイナリ 

探針の高さの時間変化 height.csv テキスト（CSV） 

カンチレバー各点の振幅の時間変化 height_amplitude.csv テキスト（CSV） 

探針に働く力 tipforce.csv テキスト（CSV） 

 

[Result View]ウィンドウの上部に表示されているフォルダに、計算結果ファイルが出力され

ています。動画以外のファイルは CSV 形式ですので、お使いのテキストエディタ、もしく

は Microsoft Office Excel などを使用して開くこともできます。 

 
 

次のグラフは、計算条件の違いによるカンチレバーの振動の時間変化をまとめた例です。

横軸：時間、縦軸：カンチレバー先端（探針位置）高さです。それぞれの線については、

赤線：真空中（試料なし）、緑線：真空中（弾性体試料あり）、青線：水中（弾性体試料あ

り）です。 
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真空中で試料が無い場合は、きれいな正弦波を描いています（赤線）。試料は簡単な弾性体

を模擬していますが、探針が試料に接触すると力を受け、カンチレバーの挙動が大きく変

化する様子が分かります。 

また、次のグラフは、真空中と水中におけるカンチレバーの振幅の違いをまとめました。 

 
計算が進むにしたがって、カンチレバーの振動の振幅が一定値に収束していく様子が分か

ります。初期条件設定によっては振幅が収束せず、発散する場合がございますのでご注意

ください。 

 

その他、下図のようなトライアングル型のカンチレバーを作成してシミュレーションする

こともできます。カンチレバーの種類については、今後増やしていく予定です。 

vacuum-free 

vacuum-sample 

liquid-sample 
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ここで、出力ファイルの height.dat と height_amplitude.dat の違いについて説明します。

例として、SampleProject 以下の、フォルダ LIQ/non_viscoelastic/test_nv_001 について考

えます。このフォルダ内の project ファイルに従ってシミュレーションを行った場合、出力

ファイルとして、次のグラフに示される height.dat と height_amplitude.dat が得られます。 

 

 
出力ファイル height.dat をグラフ化したもの。縦軸

は、カンチレバーの先端の高さ、横軸は時間を表し

ている。 

 
出力ファイル height_amplitude.dat をグラフ化した

もの。縦軸は、外力による励振周波数の振幅、横軸

は時間を表している。 

 

height.dat は、カンチレバー先端部の高さの時間変化を、そのまま出力しています。一方、

height_amplitude.dat は、各時刻での、カンチレバー先端の振動のうち、外力による励振の

周波数成分の振幅を抽出して出力したものとなっています。 

 

今の例では、周波数 4.0[kHz]、振幅 5.0[nm]で外力により、カンチレバーの根元を振動させ

ています。グラフ height.dat を見ると、時刻 t=0 より、カンチレバー先端部は順調に振動し



 104 

ているように見えます。 

 

しかし、実際は、時刻 t=0 付近でのカンチレバーの振動は、主たる振動周波数 4.0[kHz]だけ

でなく、様々な周波数成分の振動の重ね合わせとなっています。このような、周波数成分

の広がりが生じる理由は、カンチレバー自体の固有周波数や、流体の抵抗力から生じる揺

らぎが原因と考えられます。(グラフ height.dat では、32 時間ステップ毎にグラフの点をプ

ロットしているので、細かな揺らぎは見えなくなってしまっています。) 

 

時間が経過するにつれて、カンチレバーの振動の主たる周波数成分は、外力による励振周

波数 4.0[kHz]に収束します。系が定常状態に近付くにつれて、雑音となる周波数成分は消え

て行くことになります。グラフ height_amplitude.dat は、その様子を再現しています。 

 
 

カンチレバーの周波数特性 ―共鳴曲線― 

 

次に、真空中におけるカンチレバーの周波数特性を計算する事例をご紹介いたします。 

カンチレバーの周波数特性を得るためには、さまざまな周波数で振動させてその振動振幅

がどう変化するのかを調べます。 

まず、前の小節と同じようにプロジェクトの新規作成を行なってください。そして、下図

の よ う に [Project Editor] の [LIQ] ― [Simulation Mode] か ら [Parameter 

Scan(Resonance Curve)]を選択してください。 

 
すると、[Parameter Scan]の項目が入力できる状態になります。 

なお、今回は真空中での計算を行ないますので、[environment]の項目は[Vacuum]にチェ

ックが入った状態にしてください。 

 

次に、カンチレバーの周波数特性を調べるために、どの周波数範囲で振動させるかを設定

します。 [Parameter Scan]の Frequency―[start]、[end]、[step]をそれぞれ入力し

てください。 
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上図のように入力した例だと、20.0kHz～50.0kHz までの範囲を 11 分割して計算すること

になります。 

              ３kHz おきに合計１１ステップ 

 

                ・ ・・･･･・ ・  ・ 

[kHz]  20.0   23.0    26.0                                 44.0   47.0   50.0 

次に、[Input data]タブの設定を行ないます。 

前の小節と同様に設定を行なうのですが、ここで注意点は以下の３点です。 

１つめは、⑦[motion]―[frequency]の項目です。前の小節の[Point Oscillation]モー

ドでは、数値の入力が可能でしたが、今回の[Parameter Scan]モードでは先ほどの[mode 

setting]タブー[Parameter Scan]で入力した内容が反映されており、この項目を直接編集

することはできません。 

 

 
 

２つめは、探針と試料間の距離です。前の小節の計算では探針と試料が接触してカンチレ

バーの振動に及ぼす影響を計算しましたが、今回の計算では探針と試料は接触させません。

従って、探針と試料の距離を遠ざけてください。⑧DistanceFromSamples の値を大きくし

て試料と接触しないように調整してください。 

 
 

３つめは、⑩simulation の項目です。今回の計算ではカンチレバーの振幅がある程度一

定値に収束するまで振動させる必要があるので、[max_cycles]の値は比較的大きくして振

動回数を増やしてください。現在のところ、最大値は 100 サイクルまでとなっております。

水中での計算を行なう場合は、非常に計算時間を要しますのでご注意ください。 

 
また、[convergence]―[criterion]には「0.0」の値を入力してください。 

 

以上の項目に注意して、その他のパラメータやカンチレバーの形状設定に関しては前の小

節と同様に行なってください。 
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全ての設定が終わりましたら、プロジェクトを保存してシミュレーションをスタートして

ください。 シミュレーションをスタートしてしばらくすると[Result View]には下図のよ

うな共鳴曲線が表示されます。 

 
 

横軸は周波数[Hz]で、縦軸は振幅[m]です。 

 

さらに詳しく共振周波数付近を調べたい場合は、計算したい周波数範囲とステップ数を変

更して、再度同じ流れで計算を実行してください。 

   
                

この部分を再計算 

 

以下に、パラメータスキャンモードを利用して、作成した共鳴曲線を作成した例をご紹介

いたします。 

計算するための測定環境は水中／空気中／真空中で、それぞれカンチレバーの根元の振動

周波数を変更しながら、レバー先端（探針取付け位置）の振動の時間変化を計算しました。

計算結果について、周波数と振動振幅の関係をグラフにまとめることでカンチレバーの動

作特性が得られます。その様子を下図に示します。横軸：周波数、縦軸：振幅で、赤線：

真空中、緑線：空気中、青線：水中での共鳴曲線を表しています。 
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水中でシミュレーションした場合の共振周波数が、真空中及び空気中で計算した値より小

さくなっている様子が分かります。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

このように、カンチレバーの物性値、測定環境等の条件を入力して計算し、周波数特性を

導き出すことができ、実際のカンチレバーの設計を検討する際にも役立ちます。 

 

より複雑な形状のカンチレバーを使ったシミュレーション  

この小節では、より複雑な形状のカンチレバーを使ったシミュレーション方法について説

明します。具体的な例として、プログラムに同梱されているプロジェクトファイル 

¥non_viscoelastic¥test_nv_002¥test_nv_002.pro を使用することとします。 

 

このプロジェクトファイルで指定されているカンチレバーの形状は以下の図のようになり

ます。 

 
 

このカンチレバー形状は、プロジェクトファイル test_nv_002.pro 内の、<bar><structure>

というタグの下にある、以下の記述により指定されます。 
<body display="false"> <section display="false">0.0 1.0 1.0</section> 

    <section display="false">0.75 1.0 1.0</section> 

<section display="false">1.0 0.4 1.0</section> 

</body> 

<split display="false"> 

<section display="false">0.125 0.0 0.1</section> 

<section display="false">0.25 0.0 0.1</section> 
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</split> 

<split display="false"> 

<section display="false">0.125 0.25 0.35</section> 

<section display="false">0.25 0.25 0.35</section> 

</split> 

<split display="false"> 

<section display="false">0.375 0.0 0.1</section> 

<section display="false">0.5 0.0 0.1</section> 

</split> 

<split display="false"> 

<section display="false">0.375 0.25 0.35</section> 

<section display="false">0.5 0.25 0.35</section> 

</split> 

<split display="false"> 

<section display="false">0.625 0.0 0.1</section> 

<section display="false">0.75 0.0 0.1</section> 

</split> 

<split display="false"> 

<section display="false">0.625 0.25 0.35</section> 

<section display="false">0.75 0.25 0.35</section> 

</split> 

 

複雑な形状のカンチレバーを指定する場合、以下の点に注意します。上で示したカンチレ

バーの図を見ると分かるように、レバーは長さ方向に 0.125 の割合で 8 個に分割されたブ

ロックを単位として構成されています。そこで、カンチレバーの動きを差分方程式で表現

する場合、レバーは長さ方向に 8 の倍数で領域分割されると、数値計算に都合が良いと考

えられます。実は、ソルバーの都合上、差分のための要素分割数は、見掛け上のブロック

数の 2 倍以上という制限が有ります。そこで、この場合は、カンチレバーの長さ方向の差

分分割数は 16 以上の 8 の倍数にしなくてはなりません。このような事情から、ここでは、

32 分割を指定することとします。 

 

このカンチレバーの長さ方向の差分計算用分割数が 32 という指定は、プロジェクトファイ

ル test_nv_002.pro 内の、<bar><structure>というタグの下にある、<sections>により指定

されます。ここでさらに、以下の注意が必要となります。すなわち、タグ<sections>に与え

る数字は、差分計算用分割数に 1 を加えたものでなくてはならないという規則が有ります。

そこで、最終的には、 

<sections>33</sections> 

と記入します。 

 

最後に、流体の速度ベクトルの表示と、差分計算用分割数との関係について説明します。

下図に示されるように、シミュレーション実行時(Caluculation)および Replay 時に、カンチ

レバーの動きと流体の速度ベクトル場が、メイン・ウィンドウ上に表示されます。流体の

速度場は、カンチレバーを切断する面について表示されます。この流体速度場を表示する
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断面は、4 個の差分用分割領域毎に表示されるように設定されています。従って、カンチレ

バーの分割数は、4 の倍数だと、メイン・ウィンドウ上に表示される画像が見やすくなりま

す。従って、<bar><structure><sections>で指定する分割数は、4 の倍数に 1 を加えた値を

入れると良いでしょう。 

 

 
 

粘弾性接触力学を考慮したシミュレーション 

この小節では、カンチレバー先端探針と試料間の粘弾性接触力学を考慮したシミュレーシ

ョンを行う方法について説明します。液中ソフトマテリアルAFMシミュレータには、粘弾

性接触力学をシミュレーション計算に含めるオプションが用意されています。このオプシ

ョンを使用すると、探針先端探針と粘弾性の有る試料が接触した際の動力学が、

Johnson-Kendall-Roberts (JKR)理論によって記述されると仮定され、表面張力に由来する

凝着現象がシミュレーション計算に取り入れられます。この機能を使えば、例えば、探針

が試料表面との相互作用で受ける外力の変化の様子を、手軽にシミュレーション計算する

ことが可能となります。 

粘弾性接触力学を考慮したシミュレーション用のサンプル・プロジェクトは、フォルダ

¥viscoelasticの下にまとめられています。下の表に示される三種類のサンプル・プロジェク

トが用意されています。用途に合わせて参考にして下さい。 
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testp_v_001 真空中での測定を仮定。カンチレバーの弾性率は小さめに設定。 

testp_v_002 真空中での測定を仮定。カンチレバーの弾性率は大きめに設定。 

testp_v_003 液体中での測定を仮定。カンチレバーの弾性率は大きめに設定。 

 

粘弾性接触力学を考慮したシミュレーションを実行する場合、projectファイルに書き込む

べき重要な項目がいくつかあります。それらは以下の表にまとめられます。 

<LIQ><fluid><material><kviscosity> 流体の動粘性係数(unit="m^2/s") 

<LIQ><fluid><material><density> 流体の密度(unit="kg/m^3") 

<LIQ><fluid><material><impulse> 流体が受ける分子のランダムな撃力

(unit="N/ms") 

<LIQ><bar><material><density> カンチレバー材質の密度(unit="kg/m^3") 

<LIQ><bar><material><young> カンチレバー材質のヤング率(unit="GPa") 

<LIQ><bar><material><poisson> カンチレバー材質のポアソン比(無次元量) 

<LIQ><bar><material><friction> カンチレバー材質の摩擦係数(無次元量) 

<LIQ><bar><material><hamaker> カンチレバー材質のハーマーカー定数

(unit="J") 

<LIQ><bar><structure><tip><radius> カンチレバー先端探針半径(unit="nm") 

<LIQ><bar><motion><frequency> 

 

カンチレバーを外力で振動させる際の周波

数(unit="kHz") 

<LIQ><bar><motion><amplitude> カンチレバーを外力で振動させる際の振幅

(unit="nm") 

<LIQ><bar><motion><baseheight> 試料表面から静止時のカンチレバー中心ま
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での高さ(unit="nm")[探針を試料に接触さ

せたいので、この値はカンチレバーの振動の

振幅と、ほぼ等しい値が望ましい] 

<LIQ><bar><DistanceFromSamples> baseheightと等しい値を入れる

(unit="nm") 

<LIQ><sample><material><point> 

<young> 

試料のヤング率(unit="GPa") 

<LIQ><sample><material><point> 

<poisson> 

試料のポアソン比(無次元量) 

<LIQ><sample><material><point> 

<damper> 

ダンパー定数(unit="Ns/m")[探針の速度に

比例した抵抗力を生成させたい場合に使用

する] 

<LIQ><sample><material><point> 

<tension> 

探針-試料接触時の張力(unit="uN") 

<LIQ><sample><material><point> 

<touch> 

静止時の探針から試料表面に接触するまで

の距離(負の値となる)[baseheightの反対符

号の値を入れる](unit="nm") 

<LIQ><sample><material><point> 

<detach> 

静止時の探針と、探針が試料表面から離脱す

る点までの距離(負の値となる)[touchと等

しい値を入れる](unit="nm") 

<LIQ><sample><material><point> 

<hamaker> 

試料のハーマーカー定数(unit="J") 

<LIQ><sample><material><point> 

<adhesive> 

試料の表面張力(unit="N/m") 

<LIQ><simulation><time> カンチレバーが外力によって振動する際の、
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<max_cycles step="smooth">1.6 シミュレーションの開始から終了までの周

期(無次元量)[1.6程度とすると良い] 

<LIQ><Output><Directory> 

<delta_tipforce where="head" 

interval="1" displaytype="1D" 

ctrl="label">delta_tipforce.csv 

出力ファイルとしてdelta_tipforceを指定す

ると、探針-試料間の距離および引力・斥力

の時間変化を得る事が出来る 

 

粘弾性接触力学を考慮したシミュレーションは、以下の手順で実行できます。まず、GUI

画面左側のProject Editorウィンドウ内に配置されているLIQ→Mode settingタブの、

viscoelasticityボタンをonにします。(このボタンは、デフォルトではoffとなっています。)

次に、通常のシミュレーション計算と同じく、Calculationをスタートさせます。 

 

 

例えば、サンプル・プロジェクト・フォルダ/viscoelastic/testp_v_002内の、testp_v_002.pro

について、シミュレーション計算を実行した場合、出力ファイルdelta_tipforce.csvより以下

のフォースカーブが得られます。(このグラフは、サンプル・プロジェクト・フォルダ

/viscoelastic/testp_v_002/output内に収められている、delta_tipforce_ref.xlsxという名前のフ

ァイルに保存されています。) 
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上の図は、真空中において、ばね定数の大きなカンチレバーで探針を試料に接触させたと

きの、探針先端部の変位と探針先端部にかかる外力との関係をプロットしたグラフです。

ただし、上のグラフでは、横軸を探針先端部の変位、縦軸を探針先端部にかかる外力とし

ています。横軸の変位は、試料表面をゼロとして、下向きを正としています。縦軸の外力

は、上向きを正としています。 

 
 

 

タッピング機能による周波数シフト・位相シフト AFM像シミュレーション 

この小節では、LiqAFMのタッピング機能によって、周波数シフト・位相シフトAFM像シミ

ュレーションを行う方法を説明します。 

タッピング機能では、探針の付いたカンチレバーを一定の周期・振幅で振動させ、試料表

面を走査します。探針が試料表面から離れているときはファンデルワールス力が働くと仮

定します。探針が試料表面に接触しているときは、系はJohnson-Kendall-Roberts (JKR)理

論によって記述されると仮定します。一般に、JKR理論では、探針が試料表面に接触・離脱

する瞬間は、試料表面は一定の高さだけ盛り上がった状態になります。LiqAFMのタッピン

グ機能では、探針が試料表面に接触する際は、試料表面の接触高さは確率的に変動するも

のとします。探針が試料表面から離脱する際は、試料表面の接触高さはJKR理論で定められ
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る限界まで高くなると仮定します。ですから、ファンデルワールス力領域からJKR理論領域

への遷移は確率的ですが、JKR理論領域からファンデルワールス力領域への遷移は確率的で

はなく決定論的です。 

探針が試料に接触している間は、系はJKR理論で記述されるので、粘弾性接触力学が考慮さ

れていることになります。従って、表面張力による凝着現象が再現されます。 

探針が試料表面に接触する際の試料表面の高さが確率的に選ばれる一方、探針が試料表面

から離脱する際は試料表面の高さは一定の限界値まで高くなると定めましたので、探針が

試料内部に押し込まれる際のフォースカーブと、探針が試料から引き戻される際のフォー

スカーブは一致しなくなります。これにより、フォースカーブにはヒステリシスが発生し

ます。位相シフトの値は、このフォースカーブのヒステリシスの程度に依存します。 

下の図は、フォースカーブを示しています。グラフの横軸は、試料表面と探針の距離を表

しています。距離はz軸高さ方向の下向きを正に取っています。ですから、横軸が正の値の

ときは、探針が試料内部にめり込んでいる様子を表しています。横軸が負の値のときは、

探針が試料表面の初期高さよりも高い位置にあることを示しています。グラフの縦軸は、

探針の感じる力を表しています。力はz軸高さ方向の上向きを正としています。従って、力

の値が正のときは試料から反発力を受け、力の値が負のときは試料から引力を受けている

ことを表します。(下のグラフは、フォルダ

SampleProject/LIQ¥LiqAFM_Tapping/LiqAFM_Tapping_Polymer_001b/output内の、ファイ

ルdelta_tipforce_dash.xls内に収められています。) 
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下の図は、液中環境下でのDNA分子の周波数シフトAFM像、位相シフトAFM像を示してい

ます。 

 

最大値：0.0297[kHz] 

最小値：-8.48[kHz] 

 

 

最大値：2.73e-3[radian] 

最小値：-1.01e-1[radian] 

 

 

 

タッピング機能の計算例が、SampleProjectフォルダの下の、LIQ/LiqAFM_Tappingフォルダ

内に集められています。例えば、上の図で示した液中環境下でのDNA分子のシミュレーシ

ョンについては、フォルダLiqAFM_Tapping_Polymer_001bに入出力データが集められてい

ます。 

以下に、LiqAFM_Tapping_Polymer_001bを例にとって、実際のシミュレーションの操作方

法を説明します。 

LiqAFMによるシミュレーションを行う前に、試料データdna.cubeを用意しなくてはなりま

せん。それには、GeoAFMを使います。 

(1) まず、SPMSimulator.exeをダブルクリックして、SPMシミュレータを立ち上げます。 

(2) [File]→[Open]で、LiqAFM_Tapping_Polymer_001bフォルダ内の、
GeoAFM/test_dna/test_dna.proを開きます。 

(3) SetupタブのComponentを見ると、Tipとしてco.xyzが選択されているのが分かります。
これは、探針としてCO分子が選ばれていることを意味します。また、Sampleとして
pdb3gbi_ent.pdbが選択されていることが分かります。これは、ProteinDataBank 
(http://www.rcsb.org/pdb/home/home.do)からダウンロードされた分子構造データ・フ
ァイルです。SPMシミュレータの画面上には、DNAの分子構造が表示されています。 

(4) DNA分子が表示されているSPMシミュレータの画面上にカーソルを置いて、マウスを
右クリックします。[GeoAFM]→[Set GeoAFM Resolution]で、解像度を設定するウィ
ンドウが表示されますので、1.0[Å]とします。次に、[GeoAFM]→[Show Simulated 
Image]とすると、画面上にAFM像が表示されます。さらに、[GeoAFM]→[Export 
Simulated Data]で、このAFM像をdna.cubeとして保存します。このdna.cubeファイル
を、LiqAFMの入力データとして利用します。 

http://www.rcsb.org/pdb/home/home.do
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(5) 上記で作成したファイルdna.cubeを、LiqAFM_Tapping_Polymer_001bフォルダ内に
入れてください。 

 

いよいよ、LiqAFMの操作方法を説明します。 

(1) まず、liqgui.exeをダブルクリックして、LiqAFMシミュレータを立ち上げます。 

(2) [File]→[Open]で、LiqAFM_Tapping_Polymer_001bフォルダ内の、liqafm_dna2.pro
を開きます。 

(3) SetupタブのComponentを見ると、Sampleとしてdna.cubeが選択されていることが分
かります。 

(4) SetupタブのComponentにおいて、TipのPositionを、x=”-45”, y=”-20”, z=”0”としてく
ださい。これらの単位はÅです。 

(5) SetupタブのComponentにおいて、TipのScanAreaを、w=”90”, d=”40”, h=”0”としてく
ださい。これらの単位はÅです。 

(6) LIQタブのInput dataを見てください。ここで、様々な物性値が設定されます。項目bar
のmotionにおいて、frequency=”20”[kHz], amplitude=”30”[nm], basehight=”30”[nm]
と設定してください。また、項目barにおいて、DistanceFromSamples=”30”[nm]と設
定してください。通常、amplitude, basehight, DistanceFromSamplesには、同じ値を
入れます。 

(7) 項目sample→material→pointにおいて、touch=”-30”[nm], detach=”-30”[nm]と設定し
てください。通常、touch, detachには、barのamplitudeの反対符号の値が入ります。 
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(8) 項目sample→material→pointにおいて、試料の物性値として、ヤング率(young)、ポア
ソン比(poisson)、ハーマーカー定数(hamaker)、表面張力(adhesive)、粘性抵抗(viscosity)
が設定できます。 

(9) LIQタブの、Mode settingを見てください。項目environmentがFluidになっていること
が分かります。このように液中環境では、並列計算が可能です。項目Number of CPUs
で、並列化で使用するCPUの個数を指定できます。 

(10) 項目viscoelasticityはデフォルトでoffになっています。これを、on (tapping over a 
sample surface)にマークしてください。 

(11) LiqAFMシミュレータのウィンドウの上部にある三角形のボタンをクリックして
ください。これで、シミュレーションが開始されます。 
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LiqAFMには、Toolとして、GeoAFMとAnalyzerが用意されています。これらの使い方を説

明します。 

GeoAFMは、[Tool]→[GeoAFM]で起動します。今の場合、GeoAFM画面上には、DNA分子

が表示されているはずです。GeoAFM画面上を右クリックし、Show Scan Areaを選択すれ

ば、走査範囲が表示されます。 
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Analyzerは、[Tool]→[Analyzer]で起動します。Analyzerのウィンドウ上で、[File]→[Open]

により、フォルダLiqAFM_Tapping_Polymer_001b/output内の、ファイルfrequency_shift.csv

およびphase_shift.csvを選択すると、それぞれ、周波数シフトAFM像、位相シフトAFM像

が表示されます。 

 

 

タッピング機能による逆問題シミュレーション 

この小節では、LiqAFMのタッピング機能によって、周波数シフト・位相シフトの観測値を

元にして、試料表面のヤング率、表面張力、基板からの高さを求めるシミュレーションの

実行方法を説明します。 
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前節では、試料表面の物性値として、ヤング率、ポアソン比、ハーマーカー定数、表面張

力、粘性抵抗、それに試料表面の基板からの高さを与えて、それらの値から、周波数シフ

ト、位相シフトを求めました。この節では、その逆問題を考えます。すなわち、周波数シ

フト、位相シフトの値が観測値として既に与えられていると仮定して、それより、ヤング

率、表面張力、試料表面の基板からの高さを求めます。 

例えば、周波数シフト、位相シフトの値が観測値として与えられているとして、それらの

値を再現するヤング率、表面張力を求める問題を考えます。これは、以下に説明する最適

化問題と見なすことができます。まず、周波数シフト、位相シフトのずれ関数として、以

下を定義します。 
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ただし、 

 ：シミュレーション計算で得た周波数シフト 

obs
：観測値として得られた周波数シフト 

0 ：カンチレバーの共鳴振動周波数 

 ：シミュレーション計算で得た位相シフト 

obs
：観測値として得られた位相シフト 

としています。上記のずれ関数の値を最小にするようなヤング率、表面張力を求めれば良

いことになります。これは一種の最適化問題です。 

ずれ関数を最小にする、最適なヤング率、表面張力を求める方法として、ここでは二通り

の考え方を採用します。一つ目は大局的に最適値を探索する方法で、この方法を

global_modeと呼びます。二つ目は局所的に最適値を探索する方法で、この方法を

local_modeと呼びます。 

一つ目の計算方法であるglobal_modeは、ある一定の範囲内のヤング率、ある一定の範囲

内の表面張力を考え、それによって定められる2次元パラメータ平面上での、ずれ関数値の

分布を調べます。2次元パラメータ平面上で、ずれ関数の値が最小になる点が、最適解であ

ると見なします。 

下の図は、global_modeで求めたヤング率と表面張力から成る2次元パラメータ平面上での
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ずれ関数値の分布です。ヤング率は70.0～80.0[GPa]、表面張力は0.1～0.5[N/m]の範囲

とし、パラメータ値の範囲を400分割して、合計160000個の点上でずれ関数の値を求めて

います。この場合、ずれ関数を最小にするパラメータの組は、ヤング率が76.5[Gpa]、表

面張力が0.4[N/m]でした。 

 

二つ目の計算方法であるlocal_modeは、ヤング率、表面張力の初期値を考え、そこから、

ヤング率、表面張力を少しずつランダムに変化させて、ずれ関数の値が小さくなる方向に

進んで行く方法です。ヤング率、表面張力の2次元パラメータ空間で考えると、初期値の点

から、ランダム・ウォークの要領で1ステップずつ進んで行くことに相当します。1ステッ

プ進んで、ずれ関数の値が小さくなる場合は、その点にとどまります。1ステップ進んで、

ずれ関数の値が大きくなる場合は、元の位置に戻って、新たにランダムなステップを選び

直します。下の図を見ると、分かり易いでしょう。 

 

計算方法local_modeの場合、ずれ関数の収束値をあらかじめ定めておきます。そして、ス

テップを進んで行くうちに、ずれ関数が収束値以下になったら、計算を終了させ、そのと

表面張力 

ヤング率 
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きのヤング率、表面張力の値を最適値と見なします。 

以下に、global_mode、local_modeのシミュレーション操作方法を説明します。具体的な

計算例が、SampleProjectフォルダの下の、LIQ/LiqAFM_TappingInverseフォルダ内に集め

られています。 

まず、global_modeについて説明します。例えば、最適解を求めるパラメータとしてヤン

グ率と表面張力を選んだ場合のシミュレーションについては、フォルダ

LiqAFM_TappingInverse_Polymer_002に入出力データが集められています。 

以下に、LiqAFM_TappingInverse_Polymer_002を例にとって、実際のシミュレーションの

操作方法を説明します。 

まず、liqgui.exeをダブルクリックして、LiqAFMシミュレータを起動します。[File]→[Open]

により、フォルダLiqAFM_TappingInverse_Polymer_002内の、liqafm_dna1.proファイルを

開きます。 

LIQタブのInput dataを見てください。計算モードglobal_modeで大切な設定は、以下の通り

です。 

項目名(<sample><material><point>以下) 内容 

<young_initial_min> ヤング率の最小値を入れます。今の場合、

70.0[GPa]とします。 

<young_initial_max> ヤング率の最大値を入れます。今の場合、

80.0[GPa]とします。 

<young_division_number> ヤング率の範囲の分割数を入れます。今の場

合、400とします。 

<poisson_initial_min> ポアソン比の最小値を入れます。今の場合、

0.22とします。 

<poisson_initial_max> ポアソン比の最大値を入れます。今の場合、

0.22とします。 

<poisson_division_number> ポアソン比の範囲の分割数を入れます。今の

場合、ポアソン比は変化させないので、0と

します。 

<adhesive_initial_min> 表面張力の最小値を入れます。今の場合、
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0.1[N/m]とします。 

<adhesive_initial_max> 表面張力の最大値を入れます。今の場合、

0.5[N/m]とします。 

<adhesive_division_number> 表面張力の範囲の分割数を入れます。今の場

合、400とします。 

<viscosity_initial_min> 粘性抵抗の最小値を入れます。今の場合、

10.0[N/m]とします。 

<viscosity_initial_max> 粘性抵抗の最大値を入れます。今の場合、

10.0[N/m]とします。 

<viscosity_division_number> 粘性抵抗の範囲の分割数を入れます。今の場

合、粘性抵抗は変化させないので、0としま

す。 

<height_sample_initial_min> 試料表面の基板からの高さの最小値を入れ

ます。今の場合、0.0[nm]とします。 

<height_sample_initial_max> 試料表面の基板からの高さの最大値を入れ

ます。今の場合、0.0[nm]とします。 

<height_sample_division_number> 試料表面の基板からの高さの範囲の分割数

を入れます。今の場合、試料表面の基板から

の高さは変化させないので、0とします。 

 

項目名 内容 

<frequency_shift_observed> 周波数シフトの観測値を入れます。今の場

合、24.888[Hz]とします。 

<phase_shift_observed> 位相シフトの観測値を入れます。今の場合、

-0.00123181[radian]とします。 

 

項目名(<simulation>以下) 内容 

<parameter_search_mode> シミュレーション計算モードを指定しま
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す。今の場合、global_modeとします。 

<global_two_dimensional_parameter_plot> 変化させる二つのパラメータを指定しま

す。三種類の選択肢であるyoung-height, 

adhesive-height, young-adhesiveのうち、

一つを選びます。今の場合、

young-adhesiveとします。 

 

項目viscoelasticityはデフォルトでoffになっています。これを、on (inverse problem)にマー

クしてください。これらの設定の後、LiqAFMシミュレータのウィンドウの上部にある三角

形のボタンをクリックしてください。これで、シミュレーションが開始されます。 

計算結果は、フォルダoutput内に、ファイルとして出力されます。まず、ヤング率と表面張

力の2次元パラメータ平面上での、ずれ関数値の分布は、

two_dimensional_parameter_plot.cubeという名前のファイルに出力されます。このファイ

ルは、[Tool]→[Analyzer]としてAnalyzerを起動して、[File]→[Open]で開くことができます。

また、two_dimensional_parameter_plot.csvという名前のファイルにも、全く同じデータが

格納されており、これもAnalyzerで開くことができます。 

ファイルtwo_dimensional_parameter_plot.cubeをAnalyzerで開いた場合、パラメータの分

割点数を単位として横軸、縦軸が表示されます。ファイル

two_dimensional_parameter_plot.csvをAnalyzerで開いた場合は、横軸、縦軸は、その物理

量の単位を元に表示されます。 

ファイルtwo_dimensional_parameter_plot.datにも、2次元パラメータ平面上での、ずれ関数

値の分布のデータが格納されています。このファイルは、フリーのグラフ表示ソフトgnuplot

で開くことを想定しています。フリーソフトgnuplotでのグラフ表示方法は、以下の通りで

す。まず、gnuplotを起動します。次に、 [File]→ [Change Directory …]で、フォルダ

SampleProject/LIQ/LiqAFM_TappingInverse/LiqAFM_TappingInverse_Polymer_002/output

を指定します。(なお、gnuplotは、日本語のフォルダ名を受け付けません。開こうとするフ

ォルダの絶対path全体にわたって、日本語の文字列が含まれていない状態にしてください。)

次に、gnuplotに下記のコマンドを入力します。 

gnuplot> set pm3d 

gnuplot> splot “two_dimensional_parameter_plot.dat” with pm3d 

すると、グラフが下図のように示されます。 
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ヤング率と表面張力の2次元パラメータ平面上で、ずれ関数値が最小となる点は、outputフ

ォルダ内のファイルinverse_problem_parameters.datに出力されます。このファイルは、テ

キスト形式で書かれていますので、一般的なエディター・ソフトで開けます。 

次に、local_modeについて説明します。例えば、最適解を求めるパラメータとしてヤング

率と表面張力を選んだ場合のシミュレーションについては、フォルダ

LiqAFM_TappingInverse_Polymer_005に入出力データが集められています。 

以下に、LiqAFM_TappingInverse_Polymer_005を例にとって、実際のシミュレーションの

操作方法を説明します。 

まず、liqgui.exeをダブルクリックして、LiqAFMシミュレータを起動します。[File]→[Open]

により、フォルダLiqAFM_TappingInverse_Polymer_005内の、liqafm_dna1.proファイルを

開きます。 

LIQタブのInput dataを見てください。計算モードlocal_modeで大切な設定は、以下の通り

です。 

項目名(<sample><material><point>以下) 内容 

<young_initial> ヤング率の初期値を入れます。今の場合、

78.2[GPa]とします。 

<poisson_initial> ポアソン比の初期値を入れます。今の場合、

0.22とします。 

<adhesive_initial> 表面張力の初期値を入れます。今の場合、

0.52[N/m]とします。 

<viscosity_initial> 粘性抵抗の初期値を入れます。今の場合、
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10.0[N/m]とします。 

<height_sample_initial> 試料表面の基板からの高さの初期値を入れ

ます。今の場合、0.0[nm]とします。 

 

項目名 内容 

<frequency_shift_observed> 周波数シフトの観測値を入れます。今の場

合、24.888[Hz]とします。 

<phase_shift_observed> 位相シフトの観測値を入れます。今の場合、

-0.00123181[radian]とします。 

 

項目名(<simulation>以下) 内容 

<parameter_search_mode> シミュレーション計算モードを指定します。

今の場合、local_modeとします。 

<local_search_parameters> 変化させるパラメータを指定します。六種類

の選択肢であるyoung_height, 

adhesive_height, young_adhesive, 

young_only, adhesive_only, height_onlyのう

ち、一つを選びます。今の場合、

young_adhesiveとします。 

<number_trials_frequency_phase_shift> ランダムにパラメータを変化させる総ステ

ップ数の最大値を入れます。今の場合、8000

とします。 

<frequency_phase_shift_convergence> 周波数シフト、位相シフトのずれ関数の収束

値を入れます。ずれ関数の値が、ここで指定

される値以下になると計算ステップを終了

します。今の場合、2.0e-6とします。 

<local_parameter_delta> 1ステップ当たりの、ヤング率、表面張力の

変化の幅を、初期値に、ここで指定される値

を掛け合わせたものに設定します。ちなみ

に、試料表面の基板からの高さの、1ステッ
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プ当たりの変化の幅は0.1[Å]に定められて

います。今の場合、2.0e-3とします。 

 

項目viscoelasticityはデフォルトでoffになっています。これを、on (inverse problem)にマー

クしてください。これらの設定の後、LiqAFMシミュレータのウィンドウの上部にある三角

形のボタンをクリックしてください。これで、シミュレーションが開始されます。 

計算結果は、フォルダoutput内の、ファイルinverse_problem_parameters.datとして出力さ

れます。このファイルは、テキスト形式で書かれていますので、一般的なエディター・ソ

フトで開くことができます。ファイルinverse_problem_parameters.datの末尾

に、”convergence!”という文字列が書かれていれば、計算は無事収束したことになります。

文字列”convergence!”の直前に書かれているパラメータ値が、ずれ関数値を局所的に最小と

します。一方、ファイルinverse_problem_parameters.datの末尾に、” temporal minimum”

という文字列と、young, poisson, adhesive, viscosity height_sample, minimumFunctionの六

つのパラメータ値が書かれている場合は、計算が収束しなかったことを意味します。これ

は、ずれ関数が収束値以下になるパラメータの組が見つからなかったことを示しています。 
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4 macroKPFM シミュレータ 

 
 

帯電した球体の LCPD像シミュレーション 

 

この節では、帯電した球体の LCPD(Local Contact Potential Difference、局所接触電位差)

像を macroKPFM シミュレータで求める方法を説明します。この計算例は、SampleProject

内に収められている計算実施例 macroKPFM_LCPD_Inorganic_005 に相当します。必要な

project ファイルは、SPMsimulator がインストールされているフォルダ内の、ディレクトリ

SampleProject/macroKPFM/macroKPFM_LCPD/ macroKPFM_LCPD_Inorganic_005 内で

見つけることができます。 

 

左の図のような状況を考えます。半径が5[nm]の球体を

考えます。球体の材質は二酸化ケイ素(SiO2)とします。

球体の北極付近の表面には、負の電荷が均一に分布して

いるとします。球体の南極付近の表面には、正の電荷が

均一に分布しているとします。この球体を試料として、

探針を近づけKPFM観察したとき、どのようなLCPD像

が得られるかを調べます。なお、左の図では、電荷がゼ

ロの表面は緑色、負に帯電した表面は青色、正に帯電し

た表面は赤色で表示されています。 

シミュレーションの手順としては、まず第一に、試料の形状および表面電荷を記述するデ

ータファイルを用意しなくてはなりません。いきなり、試料の形状と表面電荷を同時に指

定するのは難しいので、最初に、球体の形状データを作成し、次に、表面電荷分布を指定

することにします。 

球体の形状データの作成方法は以下の通りです。まず、KPFMSimulator.exeを起動します。

[File]→[New]をクリックすると、”Create new project”というウィンドウが表示されますので、

そのウィンドウ内の”Project name”の欄に、”sphere”と入力し”OK”ボタンをクリックします。

すると、”Setup”というタブが表示されます。”Setup”タブ内の”Component”という項目を右

４ macroKPFM シミュレータ 
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クリックして、[Add Tip]→[Spheroid]を選択します。すると、radius_c、radius_a、

division_levelの値を入力するようにウィンドウが現れますが、デフォルトで設定されている

値のまま”OK”ボタンをクリックします。再び、項目”Component”を右クリックして、今度は

[Add Sample]→[Spheroid]を選択します。さらに、radius_cとし5.0[nm]、radius_aとして

5.0[nm]、division_levelとして5を入力します。 

この段階で、”Setup”タブ内の項目”Component”以下に、TipおよびSampleのデータが表示さ

れます。そこで、項目”Component”→”Sample”→”Position”→”z”の値を”0”から”1”に変更しま

す。そして、KPFM Simulatorウィンドウ内の上側のバーにある、三角形のボタンをクリッ

クします。すると、シミュレーションが開始されますが、計算はすぐに途中でストップし

てしまいます。今の場合、球体の形状データを作成するだけなので、計算が途中で止まっ

てしまっても構いません。 

“sphere”という名前のフォルダ内に、”sampleTemp.bem”という名前のファイルがあるはず

です。これが、球体の形状データになります。ここまでの作業は、ディレクトリ

SampleProject/macroKPFM/macroKPFM_LCPD/ macroKPFM_LCPD_Inorganic_005/ 

uniform_charge内の、sphere.proというファイルとして保存されています。 

次に、形状データに、表面電荷分布の情報を加える作業に移ります。SampleTemp.bemと

いうファイルをコピーして複製を作り、その名前をsphere.bemに変えます。KPFM 

Simulatorの上部のツールバーにある[Tool]をクリックして、

[uniform_surface_charge_density]を選択します。”Open bem file”というウインドウが現れま

すので、ここで、sphere.bemを選択します。すると、”Set uniform charge density”というウ

ィンドウが現れます。ここでは、”1.0E-5”と入力して”OK”ボタンをクリックしてください。

以上の作業の結果、”sphere_uniform_charge.bem”という名前のファイルができているはず

です。このファイル内のデータは、球体の表面に、1.0E-5[C/m^2]の表面電荷を均一に分布

させたものを表現しています。 

しかし、このままでは、球面全体に均一な正の電荷を分布させた状態なので、北極付近と

南極付近に、負と正の電荷を分布させたことにはなりません。そこで、ファイル
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sphere_uniform_charge.bemを編集することにします。ファイル

sphere_uniform_charge.bemをコピーして複製を作り、sphere_pm_charge.bemという名前

にします。ファイルsphere_pm_charge.bemは、試料である球体の境界要素の情報と、各境

界要素上に配置される電荷量の情報を含んでいます。 

ファイルsphere_pm_charge.bemをテキストエディタで開きます。ファイルの1行目は、境

界要素を構成する点の総数が”182”と表示されています。その後、2行目から183行目までは、

各点の位置座標が書かれています。ファイルの184行目には、境界要素の総数が”200”とし

て表示されています。その後、185行目から384行目までは、各境界要素を構成する点の番

号が順に並べられています。3個の番号が並んでいれば、その境界要素は三角形ということ

になります。4個の番号が並んでいれば、その境界要素は四角形ということになります。 

ファイルの385行目以降は、各境界要素上に配置される電荷量を表しています。単位は

[C/m^2]です。ファイルの445行目から524行目までを”0”とします。また、525行目から584

行目までは、絶対値はそのままで、符号を反転させるマイナスの記号を付与します。これ

で、試料の形状および表面電荷分布を表したデータが完成したことになります。なお、完

成したファイルsphere_pm_charge.bemは、ディレクトリ

SampleProject/macroKPFM/macroKPFM_LCPD/ macroKPFM_LCPD_Inorganic_005内に

も保存されています。 

次に、シミュレーションを実行する方法の説明に移ります。今の時点で、KPFM Simulator

は、計算が途中でストップしているはずです。そこで、いったん計算を終了させるために、

ツールバー内の四角いボタンを押します。そして、[File]→[Close]としてください。そして、

改めて、[File]→[New]として、”Create new project”ウィンドウで、今度は、”Project name”

を、”sphere_pm_charge_vertical_2”と入力してください。 

すると、作業ディレクトリとしてsphere_pm_charge_vertical_2という名前のフォルダが作

られます。そのフォルダ内に、先ほど編集作成したsphere_pm_charge.bemという名前のフ

ァイルを入れます。 
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KPFM Simulatorの”Setup”タブ内の、”Component”という項目を右クリックします。[Add Tip]

→[Spheroid]を選択します。すると、radius_c、radius_a、division_levelの値を入力するよ

うにウィンドウが現れますが、デフォルトで設定されている値のまま”OK”ボタンをクリッ

クします。再び、項目”Component”を右クリックして、今度は[Add Sample]→[File]を選択

します。すると、”Import file”というウィンドウが現れますので、ここで、

sphere_pm_charge.bemを選択します。 

以下に、シミュレーションを行うための細かな設定をします。まず、”Setup”タブ内から始

めます。[Component]→[Tip]→[Position]で、x=-10[nm], y=-10[nm], z=15[nm]とします。

[Component]→[Tip]→[ScanArea]で、w=20, d=20, h=0とします。[Component]→[Sample]

→[Position]で、x=0[nm], y=0[nm], z=1[nm]とします。[Component]→[Sample]→[Property]

で、relative_permittivity=3.8とします。これは、二酸化シリコン(SiO2)の比誘電率に相当し

ます。次に、”KPFM”タブに移ります。[tip]→[Ndiv]で、x=20, y=20, z=0とします。[tip]→

[Voltage]で、maximum=1.0, Ndiv=5とします。これら以外の設定は、デフォルトのままで構

いません。なお、これらの設定は、ディレクトリ

SampleProject/macroKPFM/macroKPFM_LCPD/ macroKPFM_LCPD_Inorganic_005内の、

sphere_pm_charge_vertical_2.proに保存されています。 

以上の設定が終わったら、シミュレーションを開始します。ツールバー上の三角形のボタ

ンをクリックします。すると、シミュレーションが開始されます。なお、計算を行う作業

ディレクトリの絶対パスに、日本語の文字が含まれているとシミュレーションは途中で中

断します。計算作業を行うフォルダ名は、英数字のみとします。計算結果を表示させたい

場合は、ツールバーの[Display]→[Result View]で、lcpd.csvを選択します。計算が無事終了

すれば、以下の図が表示されるはずです。 
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帯電したミオシン分子の LCPD像シミュレーション 

 

この節では、均一な表面電荷分布によって帯電したミオシン分子の LCPD(Local Contact 

Potential Difference、局所接触電位差)像を macroKPFM シミュレータで求める方法を説明

します。この計算例は、SampleProject 内に収められている計算実施例

macroKPFM_LCPD_Polymer_002 に相当します。必要な project ファイルは、SPMsimulator

がインストールされているフォルダ内の、ディレクトリ

SampleProject/macroKPFM/macroKPFM_LCPD/ macroKPFM_LCPD_Polymer_002 内で見

つけることができます。 

シミュレーションのおおまかな手順は以下の通りとなります。まずProtein Data Bankから、

ミオシン分子の分子構造データをダウンロードします。この分子構造データをもとに、

GeoAFMシミュレータで[nm]オーダーのAFM画像データを作成します。このAFM画像デー

タを、境界要素法用データに変換します。次に、このミオシン分子の境界要素法データに、

表面電荷分布情報を付け加えます。こうしてできあがったミオシン分子形状データを入力

として、macroKPFMシミュレータを実行します。これにより、LCPD像が得られます。 

まず、Protein Data Bankから、ミオシン分子の分子構造データをダウンロードします。イ
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ンターネット上の以下のURLにアクセスします。 

http://www.rcsb.org/pdb/home/home.do 

このProtein Data Bankのホームページ上において、PDB IDで検索するための入力用空欄が

設けられています。ここでは、PDB IDとして2dfsを入力して検索します。以下の図を参考

にしてください。

 

すると、以下の図のような、ミオシン分子のデータが保管されているホームページに移動

します。Download Filesの項目をクリックして、PDB Formatを選択します。すると、2dfs.pdb

という名前のファイルが自動的にダウンロードされます。 

この欄に 2dfs と入力して Enter キーを押します 

http://www.rcsb.org/pdb/home/home.do
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次に、ミオシン分子構造データファイル2dfs.pdbをGeoAFMシミュレータで読み込むことに

します。まず、適当な作業ディレクトリを用意して、そこにmyosin_GeoAFMというフォル

ダを作ります。SPMSimulator.exeをダブルクリックして起動します。[File]→[New]とクリッ

クすると、”Create new project”というウィンドウが表示されます。そのウィンドウ

の”Directory”という項目に、先ほど作成した作業ディレクトリ内のフォルダ

myosin_GeoAFMを指定します。指定するには、”Directory”という項目の右端にある”Ref”と

いうボタンをクリックして、「フォルダの選択」というウィンドウで作業ディレクトリ内の

フォルダmyosin_GeoAFMを選択します。次に、Project nameとして”myosin”という文字列

を入力します。 

すると、作業ディレクトリ内のフォルダmyosin_GeoAFMの中に、myosinという名前のフォ

ルダが作成されます。フォルダmyosinの中には、myosin.proというファイルがあるはずで

す。ここで、さきほどProtein Data Bankからダウンロードした2dfs.pdbという名前の分子構

造ファイルを、フォルダmyosinの中に入れます。 

この段階で、SPM Simulatorのウィンドウ上には、”Setup”タブが表示されているはずです。

この”Setup”タブ内の”Component”という項目を右クリックして、[Add Tip]→[Pyramid]を選

択します。パラメータとして、angleの値を入力するようにとのウィンドウが現れますが、

ここをクリックして PDB ファイルをダウンロード 
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デフォルト値の32度で”OK”ボタンをクリックします。次に、再び”Setup”タブ内

の”Component”という項目を右クリックして、今度は、[Add Sample]→[File]を選択します。

すると、”Import file”というウィンドウが現れますので、ここで、先ほどの分子構造ファイ

ル2dfs.pdbを選択します。 

SPM Simulatorウィンドウ内の画面を右クリックして”Top(X-Y)”を選択すると、分子の全体

像が表示されます。ここで、”Setup”タブ内のComponent→Sample→Rotationという項目内

において、alphaを-10度、betaを-20度、gammaを180度に設定します。次に、再び、SPM 

Simulatorウィンドウ内の画面を右クリックして、[GeoAFM]→[Set GeoAFM Resolution]を

選択します。すると、分解能を入力するウィンドウが現れます。ここでは、10[Ang]を入力

します。このあたりの作業については、以下の図を参考にしてください。 

 

ここで、GeoAFMの分解能を10オングストロームと設定しました。この分解能の値の設定

の仕方には、以下の注意が必要です。実は、macroKPFMシミュレータは、数値計算方法と

して境界要素法を採用しています。ですので、ミオシンの分子のAFM像の表面を、三角形

や四角形の境界要素に分解しなくてはなりません。この際、あまり、試料表面の凹凸が激
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しいと、その境界要素上での物理量の積分地が発散する場合があります。ですので、

GeoAFMシミュレータの分解能を、ある程度大きな値に設定して、試料表面の凹凸を緩や

かにする必要があります。ここでは、分解能として10オングストロームという値を選びま

した。GeoAFMの分解能は、試料表面の形状に応じて試行錯誤で調整する必要があります。 

次に、SPM Simulatorウィンドウ内の画面を右クリックして、[GeoAFM]→[Show Simulated 

Image]を選択します。すると、AFM画像がオレンジ色の等高線で表示されます。再び、SPM 

Simulatorウィンドウ内の画面を右クリックして、今度は[GeoAFM]→[Export Simulated 

Data]を選択します。すると、”Save File”というウインドウが表示されますので、

myosinV_GeoAFM_10.cubeというファイル名で保存します。そして、SPM Simulatorを終

了します。 

ここまでの作業内容は、フォルダSampleProject/macroKPFM/macroKPFM_LCPD/ 

macroKPFM_LCPD_Polymer_002/GeoAFM内に、ファイルとして保存されています。プロ

ジェクトファイルmyosin.proを参考にすると良いでしょう。 

次に、AFM画像データを、境界要素法データに変換します。KPFMSimulator.exeをダブルク

リックして起動します。ツールバー上の[Tool]→[cube_to_bem]をクリックします。”Open 

cube file”というウィンドウが表示されますので、ここで、先ほど作成したAFM画像データ

ファイルmyosinV_GeoAFM_10.cubeを選択します。すると、myosinV_GeoAFM_10.bemと

いうファイルが自動的に作成されます。これが、境界要素法データです。 

次に、この境界要素法データに、均一電荷分布のデータを付け加えます。これには、KPFM 

Simulatorウインドウ内のツールバー上の、[Tool]→[uniform_surface_charge_density]をクリ

ックします。”Open bem file”というウィンドウが表示されますので、ここで、先ほど作成し

た境界要素法データファイルmyosinV_GeoAFM_10.bemを選択します。すると均一分布電

荷の値を入力するためのウィンドウが表示されます。単位は[C/m^2]です。ここでは、1.0E-6

と入力します。すると、myosinV_GeoAFM_10_uniform_charge.bemという名前のファイル

が自動的に作成されます。これで、試料の入力データが完成したことになります。 



 137 

いよいよ、macroKPFMによるシミュレーション計算を行います。まず、作業ディレクトリ

内に、myosin_KPFMという名前のフォルダを作成します。KPFM Simulatorのウィンドウの

ツールバー上で、[File]→[New]をクリックします。すると、”Create new project”というウィ

ンドウが表示されます。まず、”Directoy”という項目を、先ほど作成したフォルダ

myosin_KPFMに指定します。それには、”Directoy”という項目の欄の右端の”Ref”というボ

タンをクリックして、フォルダmyosin_KPFMを選択します。次に、”Project name”として、

myosinV_GeoAFM_10_uniform_charge_2という文字列を入力します。 

この時点で、KPFM Simulatorのウィンドウには、”Setup”タブが表示されているはずで

す。”Setup”タブ内の”Component”という項目を右クリックして、[Add Tip]→[Spheroid]を選

択します。パラメータであるradius_c、radius_a、division_levelを入力するためのウィンド

ウが表示されますが、ここではデフォルト値の、10.0[nm]、3.0[nm]、5を選択します。これ

で、探針を設定できたことになります。 

次に、試料データを入力します。そこで、すでに作成した試料データファイル

myosinV_GeoAFM_10_uniform_charge.bemを、作業ディレクトリ内のフォルダ

myosin_KPFM/myosinV_GeoAFM_10_uniform_charge_2に入れます。試料データファイル

myosinV_GeoAFM_10_uniform_charge.bemは、作業ディレクトリ内のフォルダ

myosin_GeoAFM/myosin_test内にあるはずです。”Setup”タブ内の”Component”という項目

を右クリックして、[Add Sample]→[File]を選択します。”Import file”というウィンドウが表

示されますので、フォルダmyosin_KPFM/myosinV_GeoAFM_10_uniform_charge_2内のフ

ァイルmyosinV_GeoAFM_10_uniform_charge.bemを選択します。 

以下に、シミュレーションを行うための細かな設定をします。まず、”Setup”タブ内から始

めます。[Component]→[Tip]→[Position]で、x=-15[nm], y=-20[nm], z=15[nm]とします。

[Component]→[Tip]→[ScanArea]で、w=30, d=40, h=0とします。[Component]→[Sample]

→[Position]で、x=0[nm], y=0[nm], z=0.5[nm]とします。[Component]→[Sample]→[Property]

で、relative_permittivity=80.4とします。これは、水の比誘電率に相当します。次に、”KPFM”

タブに移ります。[tip]→[Ndiv]で、x=30, y=30, z=0とします。[tip]→[Voltage]で、maximum=1.0, 
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Ndiv=5とします。これら以外の設定は、デフォルトのままで構いません。なお、これらの

設定は、ディレクトリSampleProject/macroKPFM/macroKPFM_LCPD/ 

macroKPFM_LCPD_Polymer_002内の、myosinV_GeoAFM_10_uniform_charge_2.proに保

存されています。 

KPFM Simulator上での探針、試料の位置関係は、以下の図の通りとなります。 

 

以上の設定が終わったら、シミュレーションを開始します。ツールバー上の三角形のボタ

ンをクリックします。すると、シミュレーションが開始されます。なお、計算を行う作業

ディレクトリの絶対パスに、日本語の文字が含まれているとシミュレーションは途中で中

断します。計算作業を行うフォルダ名は、英数字のみとします。計算結果を表示させたい

場合は、ツールバーの[Display]→[Result View]で、lcpd.csvを選択します。計算が無事終了

すれば、以下の図が表示されるはずです。 
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DLVO理論に基づいた、有機材料基板上に 12個の電荷を置いた場合の LCPD像シミュ

レーション 

 

この節では、下図のように、有機材料の基板上に12個の正負の電荷を六角形状に並べたと

きの、LCPD像をシミュレーションする方法を解説します。基板は電解質溶液中にあるとし

ます。ここで紹介される計算事例のデータは、SampleProjectフォルダー内の

macroKPFM_DLVO_LCPD_Polymer_001にまとめられています。 
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試料が電解質溶液中にある場合、溶液中のイオンが電気二重層を形成し、デバイ遮蔽と呼

ばれる現象が生じます。デバイ遮蔽では、電荷間で働くクーロン力は、デバイ長さの範囲

を超えると急激に弱まります。この状況を記述するには、DLVO(デリャーギン・ランダウ・

フェルウェー・オーバービーク、Derjaguin-Landau-Verwey-Overbeek)理論が有効とされて

います。ソルバーmacroKPFMには、DLVO理論の効果を考慮したモードとして、

macroKPFM_DLVOというオプションが用意されています。本節で紹介される計算例は、こ

のオプションを使ったシミュレーション方法の説明となります。 

 

まず、試料の形状データを用意します。縦10[nm]、横10[nm]、高さ1.4[nm]の基板の立体構

造データを作成します。基板は、縦、横方向には、幅1[nm]のメッシュで分割されるように

します。高さ方向には、メッシュ分割しないことにします。 

 

基板の立体構造は、cube形式と呼ばれるファイルで準備します。SampleProjectフォルダ内

の、macroKPFM_DLVO_LCPD_Polymer_001という名前のフォルダ内を見てください。そ

こに、cube_to_bemというフォルダが置かれています。そのフォルダ内部に、sample.cube

というファイルが置かれています。このファイルが、基板の立体構造形状データとなりま

す。 

 

Cube形式ファイルの書式は、以下の通りとなります。Cube形式ファイルは、通常のテキス

ト形式のファイルです。1行目、2行目は、「#」という記号だけを書き込みます。先頭の「#」

以降に書かれた文字列は、コメントと解釈され、数値データにはなりません。 

 

3行目に、以下の数値データを記入します。 

0 -5.000000000000000e+001 -5.000000000000000e+001 +0.000000000000000e+000 
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3行目は、1個の整数値と3個の実数値が記入されています。先頭の整数値は、「0」を書き込

みます。続く3個の実数値は、基板の隅の座標値を表しています。上の例では、x=-50[Å]、

y=-50[Å]、z=0[Å]を、基板の隅の座標値とする、という意味になります。実数値の単位は

Åになります。この座標値が、基板形状の、x座標の最小値、y座標の最小値、z座標の最小

値となります。 

 

今の場合、基板の縦、横、高さは、100[Å]、100[Å]、14[Å]です。ですから、基板の正方

形の中心の、最も下の点の座標が、原点(x, y, z)=(0, 0, 0)になります。 

 

4行目には、以下の数値データを記入します。 

11 +1.000000000000000e+001 +0.000000000000000e+000 +0.000000000000000e+000 

先頭の「11」という整数値は、x方向のメッシュの点が11個であることを表しています。ま

た、次に続く三つの実数値は、10[Å]、0[Å]、0[Å]となっていますが、これは、x方向のメ

ッシュの1格子分の差分が10[Å]であることを意味します。基板のx方向の幅は、100[Å]です。

これを、幅10[Å]で分割すると、両端の点を含めて、合計11個の点が得られます。4行目の

数値データは、これらのことを表現しています。 

 

5行目には、以下の数値データを記入します。 

11 +0.000000000000000e+000 +1.000000000000000e+001 +0.000000000000000e+000 

先頭の「11」という整数値は、y方向のメッシュの点が11個であることを表しています。ま

た、次に続く三つの実数値は、0[Å]、10[Å]、0[Å]となっていますが、これは、y方向のメ

ッシュの1格子分の差分が10[Å]であることを意味します。基板のy方向の幅は、100[Å]です。

これを、幅10[Å]で分割すると、両端の点を含めて、合計11個の点が得られます。5行目の

数値データは、これらのことを表現しています。 
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6行目には、以下の数値データを記入します。 

1 +0.000000000000000e+000 +0.000000000000000e+000 +0.000000000000000e+000 

先頭の「1」という整数値は、z方向のメッシュの点が1個であることを表しています。すな

わち、この場合、z方向にはメッシュ分割しないことになります。メッシュ分割しないので、

1格子分の幅は指定する必要がありません。したがって、続く三つの実数値は、0[Å]、0[Å]、

0[Å]となります。 

 

7行目は空行として、それ以下の行に、各格子点でのz軸方向の高さ情報を入力します。ま

ず、3行目で指定した基板の隅の座標から数えて、x方向の1番目の格子の高さ情報を記入し

ます。X方向に1番目の格子においては、y方向に11個のメッシュ上の点が存在します。そこ

で、3行目で指定した基板の隅の座標から数えて、y方向に合計11個の点上の、z方向の高さ

情報を順番に記入します。今の場合、x方向に1番目の格子点上の、y方向に合計11個の点で

は、すべて高さを0[Å]と設定します。ですから、「0」という数値が11行続くことになりま

す。 

 

この後、空行を一つ入れて、x方向に2番目の格子の高さ情報を入力します。今の場合、「0」

を1行書き込んで、それから、「4」を9行続けて書き込んで、最後に、再び、「0」の行を1

行付け加えます。これは、x方向に2番目で、y方向に伸びる格子の列は、両端の高さが0[Å]

で、その間の9個の点の高さは4[Å]であることを表します。 

 

以下に、「0」が1行、「4」が9行、再び、「0」が1行の、合計11行の段落を、合計9個続けて

書きます。各段落は、1行の空行で分離します。そして、最後に、「0」が11行続く段落を一

つ書き加えます。 

 

なお、参考のため、sample.cubeファイルの最初の30行を以下に書き出します。 
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# Gaussian Cube file 

# 

  0 -5.000000000000000e+001 -5.000000000000000e+001 +0.000000000000000e+000 

 11 +1.000000000000000e+001 +0.000000000000000e+000 +0.000000000000000e+000 

 11 +0.000000000000000e+000 +1.000000000000000e+001 +0.000000000000000e+000 

  1 +0.000000000000000e+000 +0.000000000000000e+000 +0.000000000000000e+000 

 

+0.000000000000000e+000 

+0.000000000000000e+000 

+0.000000000000000e+000 

+0.000000000000000e+000 

+0.000000000000000e+000 

+0.000000000000000e+000 

+0.000000000000000e+000 

+0.000000000000000e+000 

+0.000000000000000e+000 

+0.000000000000000e+000 

+0.000000000000000e+000 

 

+0.000000000000000e+000 

+4.000000000000000e+000 

+4.000000000000000e+000 

+4.000000000000000e+000 

+4.000000000000000e+000 

+4.000000000000000e+000 

+4.000000000000000e+000 

+4.000000000000000e+000 

+4.000000000000000e+000 

+4.000000000000000e+000 

+0.000000000000000e+000 
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これで、cube形式の基板形状データファイルが出来上がりました。このcubeファイルは、3

次元の格子のデータです。一方、macroKPFMは、境界要素法シミュレータなので、2次元

の境界要素の形状データを用意しなくてはなりません。境界要素形状データは、bem形式と

いうファイルで定義されます。そこで、macroKPFMに用意されているcube_to_bemという

ツールで、cube形式ファイルをbem形式ファイルに変換します。 

 

それには、まず、SPMSimulatorフォルダ内にインストールされている実行ファイル

KPFMSimulator.exeをダブルクリックして立ち上げます。すると、下の図のようなグラフィ

ック・ユーザー・インターフェースが起動しますので、「Tool」をクリックします。続いて、

プルダウンメニューが表示されますので、その中から、「cube_to_bem」をクリックして選

択してください。すると、ファイルを指定する画面が現れますので、さきほど作った、

sample.cubeファイルを選択します。すると、sample.bemというファイルが生成されます。 

 

 

 

ここで、次の点に注意します。Sample.cubeで作成した基板のサイズは、縦、横10[nm]、高

さ0.4[nm]でした。一方、sample.bemで指定される基板のサイズは、縦、横10[nm]、高さ

1.4[nm]となります。これは、cube_to_bemというツールで3次元格子構造を、2次元の境界
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要素に変換する際、高さ方向は、メッシュのxy方向の1格子長さだけ、かさ上げされる仕組

みになっているからです。今の場合、xy方向のメッシュの単位長さは1[nm]でした。そこで、

もともとの基板高さ0.4[nm]に、1[nm]分だけかさ上げされたことになります。 

 

なお、cube形式ファイルでの長さの単位は[Å]でしたが、macroKPFMソルバーでの長さの

単位は[nm]に統一されています。 

 

次に、いよいよシミュレーションデータを入力します。シミュレーションに必要な物性値

データは、全て、projectファイルに集約されています。今回の例のprojectファイルは、以

下のフォルダ内に収められています。 

SampleProject/macroKPFM/macroKPFM_DLVO_LCPD/macroKPFM_DLVO_LCPD_Polym

er_001 

このフォルダ内のpolymer_twelve-charges_lcpd_001.proというファイルが、それにあたり

ます。 

 

このprojectファイルは、テキスト形式で、一般的なテキスト・エディターで編集できます。

しかし、ここでは、KPFMSimulator上から、このprojectファイルを見ることにします。そ

れには、SPMSimulatorフォルダ内にインストールされている実行ファイル

KPFMSimulator.exeをダブルクリックして立ち上げます。[File]→[Open]で、

polymer_twelve-charges_lcpd_001.proを開きます。すると、以下の画面が現れます。 
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[Setup]というタブをクリックします。まず探針の情報を確かめます。[Tip]として、spheroid

が選択されています。これは、探針形状が回転楕円体であるという意味です。[Position]と

して、x=-6, y=-6, z=4.9が設定されています。この[Position]の座標は、探針先端部分の初期

時刻での位置を表しています。回転角度を表す[Rotation]では、alpha=0, beta=0, gamma=0

と設定されています。これらの角度は、それぞれ、x軸、y軸、z軸を中心とした回転角度を

表しています。[ScanArea]では、探針が走査する範囲を指定します。今の場合、w=12, d=12, 

h=0で、これは、探針の初期位置から、縦横12[nm]の正方形の範囲でスキャンを行うという

意味になります。 

 

[Tip]のspheroidという項目をマウスで右クリックすれば、プルダウンメニューが現れて、探

針形状を変えることができます。例えば、[Replace]→[Spheroid]と選択すれば、回転楕円体

が再定義できて、回転楕円体の半径を変えることができます。[Position]、[Rotation]、

[ScanArea]の各項目の数値は、マウスでダブルクリックすれば、その値を変えることができ

ます。 
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次に、[Sample]のデータについて見てみます。今の例では、[Sample]として、sample.bem

が指定されています。この項目をマウスで右クリックすれば、例えば、別のbem形式ファイ

ルを指定することができます。[Position]や[Rotation]の項目は、[Tip]の場合と同じです。 

 

ここで、一つ注意があります。[Sample]の[Position]のz座標は、0でなく、0.5[nm]とします。

これは、z=0に、自動的に、電位が0の電極が置かれるためです。 

 

項目[Property]で、relative_permittivityを指定します。これは、試料の比誘電率です。ここで

は、80.4という値が与えられています。 

 

その下の、[Point_Charge]は、点電荷を指定する項目です。点電荷の位置座標、x、y、zを

指定します。また、chargeでは、素電荷を単位として電荷の値を指定します。この例では、

12個の点電荷が指定されています。 

 

次に、[KPFM]というタブをクリックしてください。まず先頭に、[simulation_mode]という

項目があります。ここでは、macroKPFM_DLVOを指定します。 

 

次に、[tip]という項目が続きます。[Ndiv]として、x=32、y=32、z=0を指定しています。こ

れにより、探針をスキャンする場合、走査範囲をx、y方向に32分割して計算を行うことに

なります。[voltage]はmaximumを0.5[V]として、Ndivを5と指定しています。これは、LCPD

像を求める際の印加電圧に関する情報です。 

 

次の[environment]という項目で、relative_permittivityを80.4としています。これは、電解質

溶液の比誘電率のことです。 
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次の[DLVO_parameters]で、電解質溶液の物性値を指定します。number_density_ionは、電

解質溶液のイオン濃度で、単位は[M]=[mol/dm^3]です。Valency_ionは、イオン電荷を表し

ます。ここには、正の整数の値が入ります。例えば、溶液中に溶け込んでいるイオンが正

のナトリウムイオンなら、そのイオン電荷は+1なので、valency_ionは+1となります。

Temperatureは温度のことです。室温なら、300[K]を入力します。 

 

これで、入力パラメーターの準備は完了です。あとは、ツールバーの上の三角形のボタン

をクリックして、シミュレーションを開始してください。シミュレーションの実行が終了

しますと、log.txtというファイルが生成されます。Log.txtファイルはテキスト形式で、通常

のテキスト・エディターで読むことができます。Log.txt内で、「Debye_length」というキー

ワードを検索してください。そこに、デバイ長さが[nm]単位で表示されています。 

 

計算結果を表示させたい場合は、ツールバーの[Display]→[Result View]で、lcpd.csvを選択

します。シミュレーション結果として得られるLCPD像は、以下のようになります。 
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DLVO 理論およびファンデルワールス力を考慮した、無機材料基板上に 12 個の電荷

を置いた場合の、探針が感じる力の像 

 

本節では、電解質溶液中に置かれた無機材料基板の上に、12個の正負の電荷が置かれた場

合の、探針が感じる力の像をシミュレーションします。シミュレーション計算では、溶液

中のイオンのふるまいを記述するDLVO理論と、ファンデルワールス力の効果を考慮するこ

とにします。この計算例は、SampleProjectフォルダ内の、

macroKPFM_DLVO_vdW_Force_Inorganic_002としてまとめられています。 

 

DLVO理論とファンデルワールス力の両方の効果を考慮する計算は、simulation_modeとし

て、macroKPFM_DLVO_vanderWaalsを選択します。この、

macroKPFM_DLVO_vanderWaalsというオプションを使用する際は、以下の注意が必要で

す。 
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(1) 試料形状データは、GeoAFMから作られたcube形式ファイルを、cube_to_bemでbem形

式に変換したファイルしか使用できません。 

(2) macroKPFMソルバー上においては、試料形状データを、x軸およびy軸を中心として回

転させることはできません。Z軸を中心とする回転は可能です。試料を、x軸またはy軸を中

心として回転させたい場合は、GeoAFMでcube形式の形状データを生成する前に、回転操

作を行ってください。 

(3) 探針形状は、回転楕円体に限ります。 

 

では、シミュレーション方法を、順を追って説明します。 

 

まず、無機材料基板の形状データを用意します。これは、前の節で説明した、sample.cube

およびsample.bemの作り方に、そのまま従ってください。 

 

SPMSimulatorがインストールされているフォルダ内の実行ファイルKPFMSimulator.exeを

ダブルクリックして、macroKPFMソルバーを立ち上げてください。[File]→[Open]で、以下

のフォルダ内のprojectファイルを開いてください。 

SampleProject/macroKPFM¥macroKPFM_DLVO_vdW_Force/macroKPFM_DLVO_vdW_F

orce_Inorganic_002 

Projectファイルの名前は、sio2_twelve-charges_force_002.proです。すると、以下の画面が

現れます。 
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Projectファイルに入力する物性値は、前の節と基本的に変わりありません。違いは以下の

通りです。まず、KPFMタブをクリックしてください。以下の項目に注意してください。 

(1) simulation_modeは、macroKPFM_DLVO_vanderWaalsを選択します。 

(2) voltageは、maximumを-0.25[V]とします。また、Ndivを0とします。この、Ndivを0とす

ると、探針の感じる力が計算結果として得られます。Ndivを0以外の正の整数とすると、

LCPD像が計算されます。 

(3) van_der_Waals_parametersという項目があります。ここで、探針と試料ののハーマー

カー定数を、hamaker_tipおよびhamaker_sampleとして与えます。単位は[zJ]です。また、

z_divという値も入力します。このz_divは、試料の体積要素の高さ方向の分割数です。

Z_div=10くらいでいいでしょう。 

 

なお、次の点にも注意してください。Setupタブをクリックして、[Sample]の

relative_permittivityを見てください。比誘電率は、3.8になっているはずです。これは酸化シ
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リコンの比誘電率に相当します。この値を代入することで、試料基板が酸化シリコンと見

なせるのです。 

 

ツールバーの上の三角形のボタンをクリックして、シミュレーションを開始してください。

シミュレーションの実行が終了しますと、log.txtというファイルが生成されます。Log.txt

ファイルはテキスト形式で、通常のテキスト・エディターで読むことができます。Log.txt

内で、「Debye_length」というキーワードを検索してください。そこに、デバイ長さが[nm]

単位で表示されています。 

 

計算結果を表示させたい場合は、ツールバーの[Display]→[Result View]で、force_z.csvを選

択します。シミュレーション結果として得られる、探針が感じる力の像は、以下のように

なります。 
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5 原子分子ナノ材料 AFM 像シミュレータ 

 
 

はじめに 

 

この節では「原子分子ナノ材料 AFM 像シミュレータ」で計算することのできる事例を、ソ

フトウェアに同梱しているプロジェクトファイルから選んで、紹介いたします。このシミ

ュレータでは探針を試料に近づけることによる試料分子の変形を考慮したシミュレーショ

ンが可能です。試料分子の変形は、計算手法の違いによって、次の二種の計算モードを選

択することができます。 

 

1. 構造最適化 AFM 像シミュレータ・・・分子内部のエネルギーが最小になるような

原子配置を探索することにより、安定な分子構造を求める方法 

2. 分子動力学 AFM 像シミュレータ・・・原子一つ一つについてニュートンの運動方

程式を解くことにより、分子構造の時間変化を求める方法 

 

このシミュレータでの計算手順は大まかには以下のような流れになっています。 

 

i. 探針モデルと試料モデルを配置する(Setup タブでの設定) 

ii. その他の入力パラメータを設定する(各シミュレータのタブでの設定) 

iii. 計算を実行する 

iv. 計算終了後、結果を見る 

 

なお、計算に必要な入力パラメータの詳細な説明につきましては、「リファレンスマニュア

ル」を参照してください。 

 
 

真空中にあるペンタセンの周波数シフト像計算の例 

 

構造最適化 AFM 像シミュレータによる、有機分子試料を対象とした真空中の原子分解能

AFM 計算の例を紹介します。 ( ここで紹介している例はプロジェクトファイル

SampleProject¥CG¥NC_pentacene¥NC_pentacene.pro に対応しています。) 

探針には、先を CO で修飾したものを想定し CO 分子を用い、試料はペンタセン分子です。

ここでは、ペンタセン分子は構造が変化しないとして、各原子の座標は固定するように設

定します。 

 

5 原子分子ナノ材料 AFM 像シミュレータ 
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入力パラメータの設定は画面左の”Project Editor”で行います。主なパラメータ設定項目は次

の通りです。(詳細は「リファレンスマニュアル」を参照ください) 

 

探針の走査開始位置 

探針の走査範囲(Setup → Tip → ScanArea) 

系の環境(CG → AFMMode) 

スキャンモード(CG → Tip_Control → scanmode) 

解像度(CG → Tip_Control → delta_xy) 

探針の鉛直方向移動数(CG → Tip_Control → NC_Mode_Setting → ThetaStepNumber) 

探針の振幅(CG → Tip_Control → NC_Mode_Setting → TipZamplitude) 

カンチレバーのバネ定数(CG → Tip_Control → NC_Mode_Setting → SpringConst) 

共鳴周波数(CG → Tip_Control → NC_Mode_Setting → ResoFreq) 

 



 155 

 
 

この計算設定条件による周波数シフト像のシミュレーション結果は、Result ビューで参照

することができます。(メニュー → Display → Result を選択し、表示された Result ビュ

ー画面上部のボックスから”test_frq.csv”を選択) 

 

 
 

水中フォースカーブ計算の例 

 

同じく、構造最適化 AFM 像シミュレータを用いた例として、ここでは水中 AFM 計算の例

を 紹 介 し ま す 。 ( こ こ で 紹 介 し て い る 例 は プ ロ ジ ェ ク ト フ ァ イ ル

SampleProject¥CG¥HOPG_RISM¥HOPG_RISM.pro に対応しています。) 探針にはカーボ
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ンナノチューブを想定し、試料はグラフェンシート(HOPG)です。ここでは、構造が変化し

ないとして、各原子の座標は固定するように設定します。 

 

 
 

入力パラメータの設定は画面左の”Project Editor”で行います。水中計算を行うためには 

系の環境(CG → AFMMode) 

の値を CG_RISM に設定する必要があります。水中計算ではほぼ全てのパラメータが計算

に影響しますので、「リファレンスマニュアル」を参照の上、ご設定ください。ここではサ

ンプルプロジェクトにあるように、探針を鉛直方向に下げていったときのフォースカーブ

計算の結果を掲載します。下左図が探針に働く力の鉛直方向成分、下右図が系の全自由エ

ネルギーの値です。水中測定の特徴である振動的な振舞いが再現されています。 

なお、参考データとして水分子に対する相関関数の計算結果が結果の出力されるディレ

クトリに CG_RISM_Corr_VV.csv という名前で出力されます。（ただし、このファイルのデ

ータは GUI で表示できません。） 
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アルカン分子のフォースカーブ計算の例 

 

分子動力学 AFM 像シミュレータによる、有機分子試料を対象とした試料分子の変形とフ

ォースカーブを予測する計算例を紹介します。(ここで紹介する例はプロジェクトファイル

SampleProject¥MD¥FCurve_octane4¥FCurve_octane4.pro に対応しています。) 

探針にはカーボンナノチューブを想定し、試料にはオクタン４分子を用います。ここで

は、オクタン分子の一方の端が基盤に固定されていると考え、端の原子を固定するように

設定し、４つの分子を並べて配置します。固定した原子とは反対の方向からカーボンナノ

チューブ探針を近づけ、探針に作用する力を計算します。 

 

 
 

入力パラメータの設定は画面左の”Project Editor”で行います。主なパラメータ設定項目は
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次の通りです。(詳細は「リファレンスマニュアル」を参照ください) 

 

① 探針の移動開始位置(Setup → Tip → Position ) 

② 探針の移動範囲(Setup → Tip → ScanArea -> h) 

③ 各試料の位置(Setup → Sample → Position ) 

④ スキャンモード(MD → Tip_Control → scanmode) 

⑤ 解像度(MD → Tip_Control → delta_z) 

⑥ 時間刻み幅(MD → MD_Setting → TimeStep) 

⑦ 探針位置あたりの計算ステップ数(MD → MD_Setting → StepNumber) 

⑧ 温度(MD → MD_Setting → Temperature) 

 
この計算設定条件によるフォースカーブのシミュレーション結果は、Result ビューで参照

することができます。(メニュー → Display → Result を選択し、表示された Result ビュ

ー画面上部のボックスから”test_fz.csv”を選択)) 
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フォースカーブ計算中の探針と試料の動きは、Replay を選択し再生することにより見るこ

とができます。 
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6 量子論的 SPM 像シミュレータ 

 
 

はじめに 

 

この節では「量子論的 SPM 像シミュレータ」で計算することのできる事例を、ソフトウ

ェアに同梱しているプロジェクトファイルから選んで、紹介いたします。「量子論的 SPM

像シミュレータ」での計算手順は大まかには以下のような流れになっています。 

 

i. 探針モデルと試料モデルを配置する(Setup タブでの設定) 

ii. その他の入力パラメータを設定する(DFTB タブでの設定) 

iii. 実行を開始する 

iv. 計算終了後、結果を見る 

 

グラフィカルユーザーインターフェースの具体的な操作方法は前節で紹介しています。な

お、計算に必要な入力パラメータの詳細な説明につきましては、「リファレンスマニュアル」

を参照してください。 

 

AFM（周波数シフト像）計算の例 

 

はじめに、本ソフトウェアの他のシミュレータにも備わっている AFM 計算(周波数シフト

像の予測 ) の例を紹介します。 ( この例は同梱されているプロジェクトファイル

SampleProject¥DFTB¥afm_hsi¥afm_hsi.pro によるものです。) 他のシミュレータでは行う

ことのできない精密な AFM シミュレーションを必要とする場合にご利用ください。 

探針は、水素が吸着したシリコン探針の先端をモデル化したものであり、試料は水素終

H 

Si 

6 量子論的 SPM 像シミュレータ 
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端されたシリコン(001)表面です。 

この計算例で注意すべきパラメータは以下の図の通りです。特に重要なものは赤枠で囲

った箇所で、大まかな意味は以下のとおりです。(別の系の計算を行う場合、囲っていない

箇所のパラメータも注意する必要があります。詳しくは「リファレンスマニュアル」を参

照してください。) 

① 探針走査範囲の始点 

② 探針走査範囲のサイズ。周波数シフト像を計算する際にはタグ h の値を 0 よ

り大きくしてください。 

③ 計算モード。DFTB_AFM を選択してください。 

④ カンチレバーの物理パラメータ 

⑤ 探針のマクロ形状に関するパラメータ 

(注) 現時点では構造緩和計算を取り入れることはできません。 

 

 
この設定による周波数シフト像のシミュレーション結果は Result ビューでみることがで

き、以下のようになります。(カラーバーを逆転させています)。設定した探針試料間距離の

場合、水素が置かれている位置では引力が強くなり周波数シフトの絶対量が大きくなるこ

とが分かります。 

 ① 

③ 

④ 

⑤ 

② 
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STM計算の例 

 
（１）トンネル電流像の計算 

 

次に、本ソフトウェアの他のシミュレータには備わっていない STM 計算の例を二つ紹介

します。一つ目はトンネル電流像の予測例を紹介します。(この例は同梱されているプロジ

ェクトファイル SampleProject¥DFTB¥stm_hsi¥stm_hsi.pro によるものです。) 

探針はシリコン探針の先端をモデル化したものであり、試料は水素終端されたシリコン

(001)表面から水素を一つ取り除いたものです。 
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この計算例で注意すべきパラメータは以下の図の通りです。特に重要なものは赤枠で囲

った箇所で、大まかな意味は以下のとおりです。(別の系の計算を行う場合、囲っていない

箇所のパラメータも注意する必要があります。詳しくは「リファレンスマニュアル」を参

照してください。) 

 

① 探針走査範囲の始点 

② 探針走査範囲のサイズ。タグ h の値は 0 として扱われます。 

③ 計算モード。DFTB_STM を選択してください。 

④ 探針の電位(STM モードでは minimum に指定した値のみで計算されます。) 

⑤ 試料の電子状態を計算する際の k 点の分割数。 

 

H 

Si 

この列の H が一つ少ない 
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この設定によるトンネル電流像のシミュレーション結果は Result ビューでみることがで

き、以下のようになります。(カラーバーを逆転させています)。水素が抜けている位置にダ

ングリングボンドがあることにより、電流値が大きくなることが分かります。 

 
 

① 

② 

③ 

④ 

⑤ 
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この他に 4 通りのトンネル電流像の計算事例を同梱しております。 

シリコン探針先端とシリコン(111) DAS 7x7 表面： 

SampleProject¥DFTB¥stm_das7¥stm_das7.pro 

フラーレン探針とシリコン(111) DAS 7x7 表面： 

SampleProject¥DFTB¥stm_das7_c60¥stm_das7_c60.pro 

シリコン(001)-2x1:H 表面とシリコン探針： 

SampleProject¥DFTB¥stm_si001_2x1h¥stm_si001_2x1h.pro 

シリコン(001)-3x1:H 表面とシリコン探針： 

SampleProject¥DFTB¥stm_si001_3x1h¥stm_si001_3x1h.pro 
 
 
（２）STS の計算 

STM 計算の例の二つ目としてトンネル電流分光の計算例を紹介します。(この例は同梱さ

れ て い る プ ロ ジ ェ ク ト フ ァ イ ル

SampleProject¥DFTB¥sts_si001_3x1h¥sts_si001_3x1h.pro によるものです。) 探針は

シリコン探針先端をモデル化したものであり、試料はシリコン(001)-3x1:H 表面です。 

 

 
この計算例で注意すべきパラメータは以下の図の通りです。特に重要なものは赤枠で囲

った箇所で、大まかな意味は以下のとおりです。(別の系の計算を行う場合、囲っていない

箇所のパラメータも注意する必要があります。詳しくは「リファレンスマニュアル」を参

照してください。) 

 

① 探針の位置(STS モードではこの位置でのみ計算が行われます。) 

② 計算モード。DFTB_STS を選択してください。 

③ 探針の電位(最小値、最大値、分割数) 

④ 試料の電子状態を計算する際の k 点の分割数。 
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この設定によるトンネル電流スペクトルの計算結果は Result ビューでみることができ、

以下のようになります。左図が電流電圧カーブ、右図がスペクトル[(dI/dV)/(I/V)の値]です。

横軸の電圧は試料に対する探針での値です。 

 

       
 
 

① 

② 

③ 

④ 
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KPFM計算の例 

 

KPFM 計算(接触電位差像の予測)の例を紹介します。(この例は同梱されているプロジェ

クトファイル SampleProject¥DFTB¥kpfm_c6¥kpfm_c6.pro によるものです。) 

探針は、水素が吸着したシリコン探針の先端をモデル化したものであり、試料はシリコ

ン(001)-c(4x2)表面です。 

 

 
この計算例で注意すべきパラメータは以下の図の通りです。特に重要なものは赤枠で囲

った箇所で、大まかな意味は以下のとおりです。(別の系の計算を行う場合、囲っていない

箇所のパラメータも注意する必要があります。詳しくはリファレンスマニュアルを参照し

てください。) 

 

① 探針走査範囲の始点 

② 探針走査範囲のサイズ。タグ h の値は 0 として扱われます。 

③ 計算モード。DFTB_KPFM を選択してください。 

④ 探針の電荷中性度の探索範囲(最小値、最大値、分割数) 

注) 採用している計算モデルの都合上、電位差での指定は行えません。 
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この設定による接触電位差像のシミュレーション結果は Result ビューでみることができ、

以下のようになります。表面のアップダイマーを繋ぐようにした電位差の大きい領域が見

られます。 

 

① 

③ 

④ 

② 
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この他に 3 通りの接触電位差像の計算事例を同梱しております。 

Si 探針および Si(001)-c(4x2)試料表面、ただし探針試料間距離を短くしたもの： 

SampleProject¥DFTB¥kpfm_c4¥kpfm_c4.pro 

Si 探針および不純物を含む Si(001)-c(4x2)試料表面： 

SampleProject¥DFTB¥kpfm_n6¥kpfm_n6.pro 
SampleProject¥DFTB¥kpfm_n4¥kpfm_n4.pro 

 

バンド計算の例(1) 

 

最後にバンド計算の例を紹介します。 

試料として酸化チタン(IV)を用います。 

 

 
この計算例で注意すべきパラメータは以下の図の通りです。特に重要なものは赤枠で囲

った箇所で、大まかな意味は以下のとおりです。(別の系の計算を行う場合、囲っていない

箇所のパラメータも注意する必要があります。詳しくはリファレンスマニュアルを参照し

てください。) 

 

① 計算モード。DFTB_BAND を選択してください。 

② バンド計算パラメータ(格子タイプ、k 点分割数、プロットする線の分割数) 
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この設定によるバンド計算の結果は Result ビューでみることができ、以下のようになり

ます。 

 
 

 

バンド計算の例(2) 

 

① 

② 
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この節では、バンド構造の計算の具体例を詳しく説明します。計算対象となる化合物とし

て、CdS を取り上げます。 

 

DFTB ソルバーで、化合物のバンド構造を計算する場合、以下の四つの情報が必要になりま

す。 

(1)化合物の結晶格子の空間群番号 

(2)結晶格子の格子定数 

(3)単位結晶格子内の原子の相対的な位置座標 

(4)結晶格子のタイプ 

 

これらの情報を手軽に入手する方法として、以下の Web サイトが便利です。 

AFLOW Automatic-FLOW for Materials Discovery 
http://aflowlib.org/ 

このサイトで、所望の化合物を検索してください。 

例えば、CdS の情報は、以下のホームページにまとめられています。 

http://aflowlib.org/material.php?id=aflow:9ce2472f0e485f6d 
 

 
 

上記のホームページで、まず、Space Group という項目に注目します。ここでは、(#186)

という番号が書かれています。この「186」が空間群の番号です。次に、CIF FILE という項

目をクリックして Save してください。これにより、「jmol.file.txt」というファイルが保存

されます。 

 

ファイル jmol.file.txt の内容は、以下の通りとなります。 

data_NO_RECURSION  [HEX,HEX,hP4] (STD_PRIM 
doi:10.1016/j.commatsci.2010.05.010) 

http://aflowlib.org/
http://aflowlib.org/material.php?id=aflow:9ce2472f0e485f6d
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_pd_phase_name NO_RECURSION  [HEX,HEX,hP4] (STD_PRIM 
doi:10.1016/j.commatsci.2010.05.010) 
_cell_length_a  4.1899541410 
_cell_length_b  4.1899541410 
_cell_length_c  6.8067065783 
_cell_angle_alpha  90.0000000000 
_cell_angle_beta  90.0000000000 
_cell_angle_gamma  120.0000000000 
_symmetry_space_group_name_H-M  'P1' 
_symmetry_Int_Tables_Number  1 
loop_ 
_symmetry_equiv_pos_site_id 
_symmetry_equiv_pos_as_xyz_ 
  1  x,y,z 
loop_ 
 _atom_site_label 
 _atom_site_occupancy 
 _atom_site_fract_x 
 _atom_site_fract_y 
 _atom_site_fract_z 
 _atom_site_thermal_displace_type 
 _atom_site_B_iso_or_equiv 
 _atom_site_type_symbol 
Cd1 1.0 0.6666876437 0.3333123563 0.0000000000  Biso 1.0 Cd 
Cd2 1.0 0.3333123563 0.6666876437 0.5000001605  Biso 1.0 Cd 
S3 1.0 0.6666864455 0.3333135545 0.3769998395  Biso 1.0 S 
S4 1.0 0.3333135545 0.6666864455 0.8769998395  Biso 1.0 S 
 

まず、ファイル jmol.file.txt の 3 行目から 5 行目に、「 cell length」という文字列が書かれて

います。ここで指定されている、a、b、c が、結晶格子の格子定数です。今の場合、

a=4.1899541410[Å]、b=4.1899541410[Å]、c=6.8067065783[Å]となります。 

 

また、ファイル jmol.file.txt の 24 行目に、Cd1 という項目があり、1.0、0.6666876437、

0.3333123563、0.0000000000 の四つの実数値が並んでいます。このうちの、2 番目、3 番

目、4 番目の数値が、Cd 原子の単位結晶格子内の相対的な位置座標となります。今の場合、

x=0.6666876437、y=0.3333123563、z=0.0000000000 となります。次に、ファイル jmol.file.txt

の 26 行目に、S3 という項目があり、1.0、0.6666864455、0.3333135545、0.3769998395

の四つの実数値が並んでいます。このうちの、2 番目、3 番目、4 番目の数値が、S 原子の

単位 結晶格子内の 相対的 な位置座標と なりま す。今の場合 、 x=0.6666864455 、

y=0.3333135545、z=0.3769998395 となります。 

 

なお、Cd2 および S4 の相対的な位置座標は、必要ありません。Modeling Tool で結晶格子

を再現する際、Cd1 と S3 の相対的な位置座標を入力するだけで、Cd 原子が 2 個、S 原子

が 2 個、単位結晶内に生成されるからです。 

 

次に、CdS の情報が集められた AFLOW のホームページに戻ります。ホームページの下の

方に、「Bravais Lattice of the Lattice」という項目があります。その下の、「Bravais Lattice 

Primitive」という項目に、「HEX」という文字列が並んでいます。この「HEX」が、結晶格

子のタイプとなります。 
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これで、バンド構造計算に必要なデータはそろいました。そこで、これらの値をソルバー

に入力することにします。まず、Modeling Tool で結晶格子のデータを作成します。それに

は、SPM シミュレータがインストールされているフォルダ内の、mkatmmain.exe という実

行ファイルをダブルクリックします。すると、以下の画面が現れます。 

 

 
 

[New Slab]というタブをクリックします。[Spg. No.]というボタンをクリックして、空間群

番号「186」を指定します。[Lattice Parameters]として、a[ang]に 4.1899541410、c[ang]

に 6.8067065783 を指定します。 

 

次に、原子の単位結晶格子内の相対的な位置座標を入力します。[Atom Positions]という項

目の、[Spec]というボタンをクリックします。すると周期律表が現れますので、原子番号

48 番の Cd を選択します。そして、x/a、y/b、z/c に、それぞれ、相対的な位置座標である

x=0.6666876437、y=0.3333123563、z=0.0000000000 を入力します。最後に、[Add]ボタ

ンをクリックすると、Cd 原子が登録されます。 

 

同様にして、S 原子を登録します。[Atom Positions]という項目の、[Spec]というボタンをク

リックします。すると周期律表が現れますので、原子番号 16 番の S を選択します。そして、
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x/a、y/b、z/c に、それぞれ、相対的な位置座標である x=0.6666864455、y=0.3333135545、

z=0.3769998395 を入力します。最後に、[Add]ボタンをクリックします。 

 

[Miller Index]は、x=0、y=0、z=1 とします。[Number of Cell]は、x=1、y=1、z=1 とします。

[Hydrogenation]は none を選択します。[Make primitive]をクリックして、チェックを入れま

す。最後に、[Make Surface]ボタンをクリックします。すると、以下の画面が現れます。 

 

 
 

これで、結晶格子が生成されました。そこで、データとして保存します。[File]→[Save as]

として、[in XYZ format]を選択します。「CdS.xyz」という名前のファイルとして保存します。

さらに、再び、[File]→[Save as]として、[in Modeling Project]を選択します。「CdS.mpro」

という名前のファイルとして保存します。 

 

これで、Modeling Tool の作業は終わりましたので、[File]→[Quit]で終了してください。 

 

次に、いよいよ、DFTB ソルバーの操作に移ります。SPM シミュレータがインストールさ

れているフォルダ内の、実行ファイル SPMSimulator.exe をダブルクリックしてください。 

CdS のバンド構造の計算例は、SmpleProject の DFTB_BAND_Inorganic_001 に保存されて

います。そこで、以下のフォルダ内の、project ファイルを開いてみてください。 

SampleProject/DFTB_BAND_Inorganic_001/CdS/test01 
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なお、project ファイルの名前は、test01.pro です。すると、以下の画面が現れます。 

 

 
 

[Setup]タブから見ていきます。[Tip]は、tip_hsi4.xyz を指定します。[Position]、[Rotation]

の全ての値は「0」にします。[Propertyt]は、[young]を 76.5、[poisson]を 0.22、[haymaker]

を 50 に設定します。[ScanArea]は、[w]、[d]、[h]の全てを「0」にします。 

 

[Sample]は CdS.xyz を指定します。これは、さきほど、Modeling Tool で生成したファイル

です。[Position]、[Rotation]の全ての値は「0」にします。[Propertyt]は、[young]を 76.5、[poisson]

を 0.22、[hamaker]を 50 に設定します。 

 

次に、[DFTB]タブをクリックしてください。[property]は、次のように設定します。[mode]

は 、 [DFTB_BAND] を選択します。 [title] は、特に何も書かなくても構いません。

[two_body_parameter_folder] は 、 two_body_parameters と し ま す 。 [stm_mode] は 、

ConstantHeight を指定します。 

 

[tip]は、次のように設定します。[amplitude]は、160.0[Å]とします。[k_cantilever]は、41.0[N/m]

とします。[resonant_freq]は、172.0[kHz]とします。[Ndiv]は、X=30、Y=30、Z=15 としま

す。 

 

[CG_param]は、次のように設定します。[MaxIter]は 0 とします。[TolForce]は、1.0[nN]と

します。 [TolEnergy] は、 0.001[eV] とします。 [displacement] は、 0.1[Å ]とします。

[trial_point_number]は、10 とします。 
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[Broyden_param]は、次のように設定します。[MaxIter]は、150 とします。[TolEnergy]は、

0.1[10^(-6)eV]とします。[output_eigenvalue]は、off とします。 

 

[Fvdw] は 、 次 の よ う に 設 定 し ま す 。 [tip_shape] は 、 conical と し ま す 。

[height_of_highest_adsorbed_molecule] は 、 0.0[ Å ] と し ま す 。 [Hamaker_const] は 、

0.22[aJ/mol]とします。[apex_angle]は、120.0[degree]とします。[tip_height]は、1000.0[Å]

とします。[radius_of_tip_apex]は、1.0[Å]とします。 

 

[feedback_param]は、次のように設定します。[delta_z]は、0.2[Å]とします。[set_point]は、

1000[nA]とします。[TolCurr]は、0.1[nA]とします。[MaxIter]は、150 とします。 

 

[tip_bias_voltage]は、次のように設定します。[minimum]は、-1.0[V]とします。[maximum]

は、1.0[V]とします。[Ndiv]は、100 とします。 

 

[Ndiv_kpoints]は、4 とします。 

 

[DoS]は、次のように設定します。[output_dos]は、on にします。[minimum]は、-5.0[eV]と

します。[maximum]は、+5.0[eV]とします。[Ndiv]は 1024 とします。 

 

[electron_temperature]は、50[K]とします。 

 

[tip_charge_neutrality]は、次のように設定します。[minimum]は、-0.1|e|とします。[maximum]

は、0.1|e|とします。[Ndiv]は、4 とします。 

 

[translational_vector]は、CdS.xyz を読み込んで自動的に設定されるので、そのまま何も設

定しなくて構いません。 

 

[band_calculation]は、次のように設定します。[lattice_type]は、結晶格子のタイプであり、

ここでは、HEX を選びます。[band_kpoints]は、24 とします。[band_ndiv]は、16 とします。 

 

[solver_type]では、CPU と GPU のどちらかを選べます。[OpenMP_threads]で、並列化を

指定することが可能です。 

 

これで、パラメータ設定は完了です。ツールバーの三角形のボタンをクリックすれば、計

算が開始されます。 

 

念のため、以下に、これまで設定したパラメータの値を表にまとめます。参考にしてくだ

さい。 

 

Setup のパラメータ名 設定値 

Tip tip_hsi4.xyz 
Tip, Position, x 0 
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Tip, Position, y 0 
Tip, Position, z 0 
Tip, Rotation, alpha 0 
Tip, Rotation, beta 0 
Tip, Rotation, gamma 0 
Tip, Property, young 76.5 
Tip, Property, poisson 0.22 
Tip, Property, hamaker 50 
Tip, ScanArea, w 0 
Tip, ScanArea, d 0 
Tip, ScanArea, h 0 
Sample CdS.xyz 
Sample, Position, x 0 
Sample, Position, y 0 
Sample, Position, z 0 
Sample, Rotation, alpha 0 
Sample, Rotation, beta 0 
Sample, Rotation, gamma 0 
Sample, Property, young 76.5 
Sample, Property, poisson 0.22 
Sample, Property, hamaker 50 
 

DFTB のパラメータ名 設定値 

Property, mode DFTB_BAND 
Property, two_body_parameter_folder two_body_parameters 
Property, stm_mode ConstantHeight 
Tip, amplitude 160.0 Ang 
Tip, k_cantilever 41.0 N/m 
Tip, resonant_freq 172.0 kHz 
Tip, Ndiv, X 30 
Tip, Ndiv, Y 30 
Tip, Ndiv, Z 15 
CG_param, MaxIter 0 
CG_param, TolForce 1.0 nN 
CG_param, TolEnergy 0.001 eV 
CG_param, displacement 0.1 Ang 
CG_param, trial_point_number 10 
Broyden_param, MaxIter 150 
Broyden_param, TolEnergy 0.1 10^(-6)eV 
output_eigenvalue off 
Fvdw, tip_shape conical 
Fvdw, 
height_of_highest_adsorbed_molecule 

0.0 Ang 

Fvdw, Hamaker_const 0.22 aJ/mol 
Fvdw, apex_angle 120.0 degree 
Fvdw, tip_height 1000.0 Ang 
Fvdw, radius_of_tip_apex 1.0 Ang 
feedback_param, delta_z 0.2 Ang 
feedback_param, set_point 1000 nA 
feedback_param, TolCurr 0.1 nA 
feedback_param, MaxIter 150 
tip_bias_voltage, minimum -1.0 V 
tip_bias_voltage, maximum 1.0 V 
tip_bias_voltage, Ndiv 100 
Ndiv_kpoints 4 
DoS, output_dos on 
DoS, minimum -5.0 eV 
DoS, maximum +5.0 eV 
DoS, Ndiv 1024 
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electron_temperature 50 K 
tip_charge_neutrality, minimum -0.1 |e| 
tip_charge_neutrality, maximum 0.1 |e| 
tip_charge_neutrality, Ndiv 4 
band_calculation, lattice_type HEX 
band_calculation, band_kpoints 24 
band_calculation, band_ndiv 16 
solver_type CPU 
OpenMP_threads 1 
 

計算結果は、[Display]→[Result View]で表示できます。「bandstructure.dat」は、バンド構造

の計算結果です。「density_of_state.csv」は、状態密度の計算結果です。今の例の場合、以

下の計算結果が得られます。 

 

 
 

 
 

なお、テキスト形式のファイル log.txt の中の最後の方に、以下の文が出力されています。 

band gap is  0.32261467E+01[eV] 

これにより、バンドギャップは、約 0.32[eV]であることが分かります。 
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第４章 

実測画像－シミュレーション画像比較機能 

 
 
 

1 概要 

 
 

実測画像－シミュレーション画像比較機能 GUI（以下 Analyzer）では、SPM の測定画像や

各種解析ソフトの出力データ、本シミュレータの計算結果、論文からのキャプチャ画像な

ど、様々な形式のデータを読み込み、２次元、３次元画像として可視化することができま

す。これらの画像を並列表示することで、各画像を容易に比較することができます。また

読み込んだデータを様々な形式で保存できるため、データ形式変換ソフトとしてもご使用

いただけます。また測定の際に生じる傾斜を自動補正する機能や画像からの探針推定機能、

測定画像から探針の影響を取り除く機能なども備えています。さらに、画像のフーリエ解

析や高解像度化機能、ニューラルネットを用いた探針影響除去機能なども備えています。

その他、デジタル画像処理ツールとして、閾値による画像の二値化機能、コントラスト調

整(ガンマ補正)機能、エッジ抽出(Sobel フィルタ処理)機能、ノイズ除去(メディアンフィル

タ処理)機能が用意されています。 

 
 
 

シミュレーション画像 

シミュレータ 

MD 

FEM 

DFTB 

CG 

LIQ 

GEO 

Analyzer 

解析ソフト 

実測画像 

SPM装置 

解析画像 

論文等 

キャプチャ画像 

並列表示 

１ 概要                     
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2 画面説明 

 

 
以下では画面ごとの主な機能について説明します。 

 

【Analyzer】 

Image View 

Menu Bar & Tool Bar 

Cross Section View 

Data View 

Image View 

Image View 

Analyzer 

２ 画面説明 
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ウィンドウ画面全体を表します。 

 

【Menu Bar & Tool Bar】 

データファイル読み込みや保存などのファイル操作、Image View の整列やクローズな

どのウィンドウ操作を行います。 

 

【Image View】 

読み込まれたデータファイルの内容を２次元および３次元画像として可視化します。

マウスやキーボードの操作によって、視点の変更や拡大縮小を自由に行うことができ

ます。またマウス操作によって、対象を任意の位置で切断することができ、その断面

図は Cross Section View で見ることができます。なお、このウィンドウは同時に複数

表示することが可能であり、並列表示などが行えます。 

 

【Cross Section View】 

Image View で切り取られた断面をグラフ表示します。 

 

【Data View】 

読み込んだデータファイルの内容を表形式でテキスト表示します。 

 
 

3 Analyzer の起動と終了 

 
 

【起動】 

 

 

３ Analyzer の起動と終了 
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1. シミュレータ本体 GUI “Menu Bar” → [Tool] → [Analyzer] 

 

以上の操作によって、実測画像－シミュレーション画像比較機能用の GUI である Analyzer

が起動します。 

 

【終了】 

 

 
 

1. Analyzer“Manu Bar”→ [File] → [Exit]  

 

以上の操作で Analyzer は終了しますが、シミュレータ本体の GUI は終了しません。 

 
 

4 ファイル操作 

  
 

Analyzer では、様々なメーカーの SPM 測定画像の他、本シミュレータの計算結果や論文

からのキャプチャ画像などのデータファイルを読み込むことができます。また読み込んだ

データは別の形式に変換して保存できます。さらに Image View の描画を、そのまま画像と

して保存するキャプチャ機能も備えています。ここでは、データファイルの読み込みと保

存、描画のキャプチャ方法について説明します。 

 

４ ファイル操作 

す 
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データファイルの読み込み 

【ファイルダイアログを使用した読み込み】 

 
1. “Menu Bar” → [File] → [Open]41 → ”Open File”ダイアログ 

2. データファイル指定 → [開く] 

 

Analyzer では、一般の画像形式（jpeg,bmp,png,tif）、Cube（本シミュレータ出力形式）、各

種装置メーカー・解析ソフト出力形式（Unisoku、Omicron、Gwyddion、WSxM、SPIP、

Asylum、Surf）に対応しています。指定されたデータファイルが読み込まれると、Image View

                                                   
41 この操作は、”Tool Bar” → Openアイコンをクリックすることでも行えます。 

Image View 
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が表示され、その中に２次元画像42が描画されます。 

 

【最近使用したデータファイルの読み込み】 

 
1. “Menu Bar” → [File] → [Recent Files] → データファイル一覧43→データファイル指定 

 

【一般の画像形式のデータファイルの読み込み】 

bmp や jpg などの画像ファイルは、明るさの情報はもちますが、例えば高さ情報はもって

いません。したがって、データを読み込む際には、明度を実際の高さ情報に変換する処理

が必要となります。また、画像の大きさ（縦横サイズ）が現実に何Åかということを指定

する必要があります。以下では画像ファイルの読み込みについて説明します。 

 
 
                                                   
42 ３次元表示など、描画法の変更については後述します。 
43 最近使ったプロジェクトファイルは最大 10個まで表示されます。 
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1. “Menu Bar” → [File] → [Open]44 → ”Open File”ダイアログ 

2. データファイル指定 → [開く] 

3. ”Set scale”ダイアログ → “Distance between pixels”入力 → [OK] 

4. ”Set Value Range”ダイアログ → “value range”入力 → [OK] 

 

“Set scale”ダイアログで、画像ファイルのピクセル間の距離が実際には何Åに対応するのか

を指定します。さらに“Set Value Range”ダイアログで、画像の明度[0.0,1.0](黒=0.0、白=1.0

で表現)がどれくらいの高低差（Å）に相当するのかを指定します。 

 

データファイルの保存 

 

読み込んだ様々な形式のデータファイルを別名および別形式で保存することができます。 

 

 
1a. “Manu Bar”→ [File]  

1b. “Image View”右クリック45 → コンテクストメニュー 

2. [Save As]46 → “Save As ”ダイアログ → ファイル名指定 → [保存] 

 
 

イメージの保存 

 

                                                   
44 この操作は、”Tool Bar” → Openアイコンをクリックすることでも行えます。 
45 複数の Image Viewが立ち上がっている場合は、保存したいデータが表示されている Image View上で右クリックして
ください。 
46 この操作は、”Tool Bar” → Saveアイコンをクリックすることでも行えます。 
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数値データそのものだけではなく、Image View に表示されている画面自体を画像として保

存することができます。 

 
1a. “Manu Bar”→ [File]  

1b. “Image View”右クリック → コンテクストメニュー 

2. [Export Image]47 → “Export Image ”ダイアログ → ファイル名指定 → [保存] 

 
 

5 画像のフーリエ解析・高解像度化 

 
 

本機能を用いることで、FFT 解析を用いた画像処理、Lanczos 補間を用いた画像の高解像

度化処理を行うことができます。 

 

画像のフーリエ解析 

 
【データ描画】 

 
 

                                                   
47 この操作は、”Tool Bar” → Export Imageアイコンをクリックすることでも行えます。 

５ 画像のフーリエ解析・高解像度化 

す 
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1. “Image View”右クリック → コンテキストメニュー → [Image Processing] →”Image 

Processing View” 

2. “Tool Bar” → “Mode Combo Box” → [Cartesian/Fourier/Power Spectrum] 

 

“Mode Combo Box”において、Cartesian（通常画像）、Fourier（フーリエ画像）48、Power 

Spectrum（パワースペクトルグラフ）49の表示を切り替えることができます。 

 

【画像処理】 

                                                   
48 Fourier画像の値は Log Scaleで表示しています。 
49 Power Spectrumは両対数グラフとして表示しています。 

Image Processing View 

Mode Combo Box 

Cartesian Fourier Power Spectrum 
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1. “Tool Bar” → “Slider Bar” 移動 

2. “Tool Bar” → [Reset] クリック 

 

“Slider Bar”のつまみを移動させることで、パワースペクトルグラフの傾きを連続的に変化

Slider Bar 

Cartesian Fourier Power Spectrum 

Reset 

高周波強調 

低周波強調 
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させることができます50。それに伴って、Cartesian（通常画像）、Fourier（フーリエ画像）

も変化します。つまみを左（右）に移動させると低周波（高周波）を強調した画像になり

ます。また[Reset ]ボタンをクリックすることで、スライダーバーのつまみの位置を、ゼロ

位置に戻すことができます。 

 

【階調補正】 

 

 
1. ”Image Processing View”右クリック → コンテキストメニュー → [Tone Correction]  

 

[Tone Correction]はトグルボタンであり、この操作によって階調補正のオンオフを切り替え

ることができます。 

 

【Analyzer へのエクスポート】 

 
                                                   
50 グラフを、べき分布、つまり両対数グラフで直線として近似し、その傾きを連続的に変化させていきます。 
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1. ”Image Processing View”右クリック → コンテキストメニュー → [Export to Analyzer]  

 

この操作によって、”Image Processing View”上の画像を、Analyzer 上の”Image View”にエ

クスポートすることができます。その際、データは、”ファイル名[1].cube”という Cube 形

式のファイルに自動保存されます。 

 

画像高解像度化 

 

 
 

 
 

1.  “Tool Bar” → [Up Resolution / Down Resolution]  

 

[Up Resolution / Down Resolution]ボタンを押すことによって、画像の解像度を上げたり下

げたり51することができます。画像サイズは”Tool Bar”右端のテキストボックスに表示され

ます。 

 

                                                   
51 解像度を変える際、Lanczosフィルターを用いた補間処理を行っています。 

 

Up Resolution /Down Resolution Button 

 

画像サイズ 

 

高解像度画像 

 

画像サイズ 
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６ ニューラルネットシミュレータ 

す 
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6 ニューラルネットシミュレータ 

 
 

ニューラルネットシミュレータは、「原画像と観測画像」、「低解像度画像と高解像度画像」

といった何らかの関係のある２種類の画像間の関係を学習することができます。例えば形

状が既知の標準試料をトレーナー画像（正解画像）とし、その SPM 画像を入力画像として

両者の関係を学習させるとします。この場合ネットワークは、探針が SPM 画像に及ぼす影

響を学習していると考えられます。学習終了後、このネットワークに、同じ探針で走査し

たある試料の SPM 画像を入力すると、探針の影響を取り除いた画像が出力されると期待で

きます。 

 

 
 
 
 
  

試料 SPM画像 探針 観測過程 

既知試料 既知試料SPM画像 ニューラルネット 学習過程 

推定試料 任意のSPM画像 ニューラルネット 推定過程 

Neuralnet Simulator 

画像１ 画像２ 

画像１と画像２の関係を学習 
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ニューラルネットシミュレータの起動 

 

 
1. Analyser“Menu Bar” → [Tool] → [Neuralnet Simulator] 
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学習データの設定 

 
 

1. Neuralnet Simulator “Menu Bar” → [File] → [Open]52 → ”Select observed images ”ダ

                                                   
52 この操作は、”Tool Bar” → Openアイコンをクリックすることでも行えます。 

入力画像 

 

トレーナー画像 

 

Select original images ダイアログ 

 

Select observed images ダイアログ 

 

Training Data Set ウィンドウ 
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イアログ → 入力画像指定 → [開く] 

2. ”Select original images ”ダイアログ → トレーナー画像指定 → [開く] 

 

以上の操作でニューラルネットシミュレータに学習データ設定されます。学習データは入

力画像、トレーナー画像ともに複数枚指定することができますが、両者は同じ枚数でなけ

ればなりません。設定された画像は、シミュレータの右側（右上：入力画像、右下：トレ

ーナー画像）に表示されます。ただし複数枚指定した場合は、それらの内１セット分だけ

表示されます。 

 
 

学習の実行・停止・一時停止 

 

【実行】 

 
1.  “Tool Bar” → [Start] 

 

 [Start]ボタンを押すと、学習が開始されます。ニューラルネットからのメッセージは、Log 

View 上に表示されます。 

 

【停止・一時停止】 

Start 

Log View 
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1. “Tool Bar” → [Stop/ Pause] 

2. “Menu Bar” → [Display] → [Error View] 

 

学習開始後、[Start]ボタンが使用不可となり、[Stop]ボタンと[Pause]ボタンが使用可能とな

ります。[Stop]ボタンを押せば実行を停止し、ネットワークの状態は初期化されます。

[Pause]ボタンを押すことで、学習を一時停止できます。再開するには、再び[Start]ボタン

を押します。学習を一時停止し、Error View を立ち上げることで、各時点でのネットワーク

の出力画像とトレーナー画像（正解画像）との平均二乗誤差（Mean Square Error:MSE）の

時間発展を見ることができます。なお、各時点での MSE は、”Log View”上にも表示されま

す。 

 

学習結果の保存と読み込み 

 

【保存】 

一時停止、あるいは学習が完了し、ニューラルネットが停止状態にある時には、その時点

での学習状態（ユニット間の重み）を保存することができます53。以下では保存方法につい

て説明します。 

                                                   
53 [Stop]ボタンを押すと、ネットワークの状態が初期化されてしまいます。保存は[Stop]ボタンを押す前に行ってく
ださい。 

Stop Pause 

Error View 
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1. “Menu Bar” → [File] → [Save Weight File] → ”Save Weight File”ダイアログ 

2. 保存ファイル名指定 → [保存] 

 

【読み込み】 

保存された学習結果ファイルは、ニューラルネットワークに読み込むことができます。こ

れによって、ファイルが保存された時点の学習状態を再現することができます。 

 

 
 

1. “Menu Bar” → [File] → [Load Weight File] → ”Load Weight File”ダイアログ 

2. 読み込みファイル名指定 → [開く] 

  

Save Weight File ダイアログ 

Load Weight File ダイアログ 
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学習結果のチェックと新規入力画像に対する試行 

 

【学習結果のチェック】 

 

 
1. “Tool Bar” → [Check] → ”Input Image/Reconstructed Image/Difference Image” 

 

一時停止、あるいは学習が完了し、ニューラルネットが停止状態にある時には、その時点

での学習状態を視覚的にチェックすることができます。ツールバーの[Check]ボタンを押す

と、その時点のネットワークに学習データセット時に指定した入力画像(Input Image)が入力

され、出力結果画像(Reconstructed Image)が表示されます。またこの結果画像と、はじめ

に学習データとしてセットされたトレーナー画像との差分画像(Difference Image)も表示さ

れます。 

 

【新規入力画像に対する試行】 

 

Input Image Reconstructed Image Difference Image 
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1. “Tool Bar” → [Trial] → “Open File”ダイアログ 

2. 画像ファイル指定 →  [開く] → ”Input Image/Reconstructed Image/Difference Image” 

 

学習終了後、学習データセット時に用いられた入力画像とは別の画像を使って、そのニュ

ーラルネットワークをテストすることができます。ツールバーの[Trial]ボタンをクリック

し、”Open File”ダイアログで入力画像を指定すると、その時点のネットワークに指定画像

(Input Image)が入力され、計算結果画像(Reconstructed Image)が表示されます。 

  

Open File ダイアログ 

Input Image Reconstructed Image 
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ウィンドウの表示／非表示・LogViewのクリア 

 

 

【ウィンドウの表示／非表示】 

1. “Menu Bar” → [Display] → [Training Data Set / Input Image / Reconstructed Image / 

Difference Image / Error View] 
 

[Display]メニューから表示／非表示したい Window をクリックします。 [Training Data Set 

/ Input Image / Reconstructed Image / Difference Image / Error View]は各々トグルボタンで

あり、クリックを繰り返すことによって、対応するウィンドウの表示／非表示を切り替え

られます。 

 

【Log View のクリア】 

Input Image 



 201 

 
1. “Tool Bar” → [Clear]  

 

ツールバーの[Clear]ボタンを押すことで、”Log View”に表示されている文字列が全て消去さ

れます。 

 
 

7 探針形状推定・探針影響除去 

 
 

本機能を用いることで、測定データのみから、探針形状を自動推定することができます。

また、測定データからその推定探針の影響を取り除いた画像を作成することができます。 

 

探針形状推定 

 

Clear 

Log View 

７ 探針形状推定・探針影響除去 

す 
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1.  “Image View”右クリック → コンテキストメニュー → [Tip Estimation] 

2.  ”Tip Nx”ダイアログ → 数値入力 → [OK] 

3.  ”Tip Ny”ダイアログ → 数値入力 → [OK] 

4.  ”Parameter”ダイアログ → 数値入力 → [OK] 

 

はじめに Image View に測定データを読み込み、コンテキストメニューから[Tip Estimation]

を選択します。次に Tip Nx と Tip Ny ダイアログで、各々推定する探針の横と縦のサイズ（ピ

クセル単位）を指定します。最後に Parameter（[0.0,1.0]区間の実数）を指定します。この

指定によって、無数にある探針の解候補のうち、最大探針（Parameter=0.0）から、最小探

針（Parameter=1.0）まで推定することができます。推定された探針は、データファイルと

同じフォルダに tip_result.cube というファイル名で自動保存されると同時に、新たな Image 

View が立ち上がり、その形状が描画されます。 

Image View 
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探針影響除去 

 

 

 

 
1. “Image View”右クリック → コンテキストメニュー → [Eliminate Tip Effect] 
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2. ”Select Tip”ダイアログ → ファイル名指定 → [OK] 

 

測定データが表示されている Image View 上のコンテキストメニューから[Eliminate Tip 

Effect]を選択します。次に探針を指定し、測定データから探針の影響を取り除いた画像デー

タ を 出 力 し ま す 。 探 針 影 響 除 去 画 像 は 、 デ ー タ フ ァ イ ル と 同 じ フ ォ ル ダ に

image_eliminated_tip_effect.cube というファイル名で保存されると同時に、新たな Image 

View が立ち上がり、形状が描画されます。 

 
 

8 可視化設定 

 
 

描画法の変更 

 

【2D／3D 表示切り替え】 

 
以下では２次元表示から３次元表示への切り替えについて説明します。 

 
 

1.“Image View”右クリック → コンテキストメニュー → [3D-View] 

 
 

【断面図の表示】 

８ 可視化設定 

す 
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1. “Image View”上ダブルクリック → 始点決定 

2. “Image View”上ダブルクリック → 終点決定 

3. “Image View”右クリック → コンテキストメニュー → [3D-View] 

4. “Image View”右クリック → コンテキストメニュー → [Cross-Section] → [Clipping] 

 
 
 

始点と終点の指定は、２D 表示にして行います。終点の指定が終了すると、自動的に Cross 
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Section View が立ち上がり、断面図がグラフ表示されます。３D 表示に切り替えてコンテキ

ストメニューから[Clipping]を選択することで、３D 画像を切り取ることができます。元に

戻すには、再度[Clipping]を選択します。また[Clear]を選択すると、始点終点位置などの切

断情報がクリアされます。 

 

【Z 軸の反転】 

 

 
 

1. “Image View”右クリック → コンテキストメニュー → [z-range Reverse] 54 

 

【Z 軸の正規化】 

 

 

                                                   
54  [z-range Reverse]はトグルボタンであり、繰り返しクリックすることで Z軸反転の有無を交互に切り替えられま
す。 
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1. “Image View”右クリック → コンテキストメニュー → [z-range Normalize] 55 

 
縦横サイズに比して高低差が非常に小さい場合、３D 表示しても見た目は平面とほとんど変

わりません。そのような場合、Z 軸を正規化することで、高低差を強調して表示することが

できます。 

 

【描画色の設定】 

 
1. “Image View”右クリック → コンテキストメニュー 

2. [Color] → [Monocrome / Gradation / Rainbow] 

 

以上の操作で、描画色の設定を変更することができます。 

 

【ライティング】 

                                                   
55  [z-range Normalize]はトグルボタンであり、繰り返しクリックすることで正規化の有無を交互に切り替えられま
す。 

Rainbow 

Monocrome 

Gradation 
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1. “Image View”右クリック → コンテキストメニュー → [Lighting] 56 

 
この処理は、３D 表示の場合のみ有効です。 

 

【等高線表示／非表示切り替え】 

 

                                                   
56  [Lighting]はトグルボタンであり、繰り返しクリックすることでライティングの有無を交互に切り替えられます。 
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1. ”Image View”右クリック → コンテキストメニュー → [Isoline]57 

 

【表示タイプの切り替え】 

 
1. “Image View”右クリック → コンテキストメニュー 

2. [Display-Type] → [Fill / Wire Frame] 

 

この処理は、３D 表示の場合のみ有効です。 

 
                                                   
57  [Isoline]はトグルボタンであり、繰り返しクリックすることで等高線の表示／非表示を交互に切り替えられま
す。 

Fill 

Wire Frame 
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視点の変更・Zoom All・拡大縮小・遠近法表示 

 
以下の処理は、３D 表示の場合のみ有効です。 

 

【視点の変更】 

 
1. ”Image View”右クリック → コンテキストメニュー 

2. [Top/Front/Side] 
 

この操作を行うことで、真上（Top）、正面（Front）、真横（Side）に視点が変更されます。

また、Image View 上をドラッグすることにより視角を自由に変更することもできます。

[Shift]+ドラッグすることにより、視点を平行移動させることができます。 

 

【Zoom All】 

Front 

Top 

Side 
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1. ”Image View”右クリック → コンテキストメニュー → [Zoom All] 

 

この操作によって、描画が”Image View”画面全体に収まるように、自動的に拡大縮小および

平行移動が行われます。 

 

【拡大縮小】 

1. マウスホイール→回転 

マウスホイールを回転させることで、任意の倍率にスケーリングすることができます。 

 

【遠近法表示】 

 
1. ”Image View”右クリック → コンテキストメニュー → [Perspective]58 

                                                   
58

 [Perspective]はトグルボタンであり、この操作によって遠近法表示のオンオフを切り替えることができます。 
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9 デジタル画像処理機能 

 

Analyzer には、デジタル画像処理ツールとして、以下の四つの機能が用意されています。 

 閾値による画像の二値化機能 

 コントラスト調整(ガンマ補正)機能 

 エッジ抽出(Sobel フィルタ処理)機能 

 ノイズ除去(メディアンフィルタ処理)機能 

これら四つの機能は、一つの画像データに対して、複数の機能で処理できない仕組みにな

っています。これは、例えば、ある一つの Cube 形式ファイルで与えられる画像データに対

して、エッジ抽出を行った後、コントラスト調整を行うことは出来ないことを意味します。

もし、ある一つの Cube 形式画像データに対して、エッジ抽出、コントラスト調整といった

複数の処理を続けて行う場合は、いったんエッジ抽出を行った後で、その結果を Cube 形式

ファイルとして保存し、そのファイルを開き直して、コントラスト調整を行う、という手

順を踏む必要が有ります。 

 

このように、上記の四つのデジタル処理機能が、単一の Cube 形式ファイルに対して連続し

て行えないようになっているのは、以下の理由からです。一般に、上記 4 種類のデジタル

処理機能は、処理を行う順番によって、結果が異なります。例えば、ある Cube 形式画像デ

ータに対して、エッジ抽出を行ってからコントラスト調整した場合と、逆にコントラスト

調整してからエッジ抽出を行った場合とでは、得られる画像は異なったものになります。

従って、ユーザーは、上記 4 種類の画像処理を行う場合、処理の順序や、処理で使用した

パラメータを、ノートなどに記録して残しておく必要が有ります。 

 

閾値による画像の二値化機能 

 

Cube 形式の画像データに対して、以下のよ

うにして、データの二値化、すなわち、白黒

画像への変換が行えます。 

画像が表示されているウィンドウ上を、マウ

スで右クリックすると、コンテキストメニュ

ーが現れます。メニューから、[Black and 

white]を選択すると、[Threshold]というウィ

ンドウが現れます。ここで、白黒二値化の閾

値を入力します。 

 

9 デジタル画像処理機能 

す 
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ここで、白黒二値化の閾値を 0.0 から 1.0 までの範囲

で入力します。なお、閾値はデフォルトで 0.5 が設定

されています。[OK]ボタンを押すと二値化画像が得ら

れます。 
 

Cube 形式の画像データには(x, y, z)の値が含まれ、そ

のうち z は高さ方向の値を意味します。オリジナル画

像全体に対する z 値の最小値を 0.0、平均値を 0.5、

最大値を1.0として、それらを繋ぐ折れ線を考えます。

それに基づいて全体の z 値を 0.0～1.0 に変換したと

き、指定した閾値より大きければ白、小さければ黒に、

それぞれ色を定めます。これが二値化という名前の由

来になります。 

 

 

この図は、白黒画像変換前のオリジナル画像

データを表しています。(左図の画像データ

は、東京工業大学・大学院総合理工学研究科、

材料物理科学専攻、量子表面講座、平山博之

教授から提供して頂いたものです。) 

 

 
 

  

hmin hmax have 

0.0 

0.5 

1.0 

Height 

Threshold 



 215 

オリジナル画像に対して、閾値を 0.4 として

白黒画像変換を施した結果です。 

オリジナル画像に対して、閾値を 0.6 として

白黒画像変換を施した結果です。 
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コントラスト調整(ガンマ補正)機能 

 

Cube 形式の画像データに対して、以下のようにしてコントラスト調整が行えます。画像が

表示されているウィンドウ上を、マウスで右クリックすると、コンテキストメニューが現

れます。メニューから、[Contrast adjustment (Gamma correction)]を選択すると、[Gamma]

というウィンドウが現れます。 

ここで、コントラスト調整パラメータγを 0.25 から 4.0 まで

の範囲で入力します。γはデフォルトで 1.0 が設定されていま

す。[OK]ボタンを押すとコントラスト調整した画像が得られ

ます。 
 

 

  
この図は、コントラスト調整前のオリジナル

データを表しています。画像が全体的に明る

く、そのため、細かな高低差が分かりにくく

なっています。 (左図の画像データは、大阪

大学大学院基礎工学研究科、物質創成専攻、

機能物質化学領域、表面・界面機能化学講座、

福井賢一教授から提供して頂いたもので

す。) 

この図は、左のオリジナル画像に対して、γ

=0.33 でコントラスト変換を施したもので

す。対象物の細かな高低差の構造が良く分か

るように、画像が改善されています。 

 
 

エッジ抽出(Sobelフィルタ処理)機能 

 

Cube 形式の画像データに対して、以下のようにしてエッジ抽出が行えます。画像が表示さ

れているウィンドウ上を、マウスで右クリックすると、コンテキストメニューが現れます。

メニューから、[Edge detection (Sobel filter)]を選択します。すると、エッジ抽出が行われま
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す。 

この図は、エッジ抽出前のオリジナル画像デ

ータを表しています。(左図の画像データは、

東京工業大学・大学院総合理工学研究科、材

料物理科学専攻、量子表面講座、平山博之教

授から提供して頂いたものです。) 

 

 
 

  
この図は、上のオリジナルデータ画像に対し

てエッジ抽出を行ったものです。画像が全体

的に暗くなってしまったので、コントラスト

調整することにします。それには、左の図の

画像データを、一度、Cube 形式で保存して

閉じます。 

先ほど保存した Cube 形式ファイルを開い

て、γ=2.0 でコントラスト調整を施した図で

す。エッジがより見易くなっています。 

 
 

ノイズ除去(メディアンフィルタ処理)機能  

 

Cube 形式の画像データに対して、以下のようにしてノイズ除去を行うことができます。画

像が表示されているウィンドウ上を、マウスで右クリックすると、コンテキストメニュー

が現れます。メニューから、[Noise reduction (median filter)]を選択します。すると、ノイズ
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除去が行われます。 

  
この図は、ノイズ除去前のオリジナルデー

タを表しています。緑の丸印で示した個所

に、小さなノイズが有ることが分かります。

(この画像データは、東北大学大学院理学研

究科物理学専攻、量子物性物理学講座、量

子伝導物性分野、橋本克之助教から提供し

て頂いたものです。) 

オリジナル画像データに対してノイズ除去

を行ったものです。緑の丸印で表された箇

所のノイズが取り除かれていることが分か

ります。 

 

 
10 3 点で指定される角度の計測 

 

“Image View”上で表示されたデータ画像に対して、3 つの点 A, B, C を指定して、線分 AB, BC

の長さ、および、∠ABC の角度を測定することが出来ます。 

 
 

10 3 点で指定される角度の計測 

す 
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(1) この図の、緑の楕円の枠で囲まれた菱形格

子の、辺の長さと角度を調べたいとします。 (左

図の画像データは、東京工業大学・大学院総合

理工学研究科、材料物理科学専攻、量子表面講

座、平山博之教授から提供して頂いたもので

す。) 

(2) まず、”View Image”上のデータ画像

の緑の楕円の枠で囲まれた部分を拡大

します。画像の上にカーソルを置いて、

マウスのホイールを使えば、画像を拡

大・縮小することができます。また、マ

ウスを左クリックして画像上でドラッ

グすれば、画像は移動します。これらの

操作により、データ画像の測定したい部

分を、ウィンドウ内で拡大表示します。 

 

 

 

(3) 次に、画像が表示されているウィンドウ上

を、マウスで右クリックすると、コンテキスト

メ ニ ュ ー が 現 れ ま す 。 メ ニ ュ ー か ら 、

[Measurement of lines and their angle]を選択し

ます。そして、マウスをダブルクリックするこ

とにより、データ画像上に三点 A, B, C を指定

します。 

(4) すると、左の図に示されるウィンド

ウが現れ、線分 AB, BC の長さ、および、

∠ABC の角度が表示されます。 

 
 
 

11 その他 

 
 

データ表示 

 

11 その他 

す 
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1. “Image View”右クリック → コンテキストメニュー → [Show Data]  

 
Data View を用いて、数値データを表形式で閲覧することができます。 

 

傾き自動補正 

 
 

1. “Image View”右クリック → コンテキストメニュー → [Correct tilt]  

 

Image Viewの整列・クローズ 

【タイル表示】 
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1. “Menu Bar” → [Window] → [Tile] 

 

【カスケード表示】 

 
1. “Menu Bar” → [Window] → [Cascade] 

 

【Imege View のクローズ】 
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1. “Menu Bar” → [Window] → [Close All] 

 

この操作によって、全ての Image View が閉じられます。 
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第５章 

試料モデリング機能 

 
 

この章では、SPM シミュレータで用いる試料構造を作成するための補助ツールの使い方

をご紹介いたします。現在この補助ツールは、「１．薄膜モデリング」、「２．分子モデリン

グ」の大きく２つの機能に分かれております。 

両者ともにグラフィカル・ユーザー・インターフェイス（GUI）を備えており、ユーザー

が視覚的に試料構造データを作成することが可能となっております。 

 
 

1 薄膜モデリング 

 
 

はじめに 

SPM シミュレータには補助機能としてモデリングツールが同梱されます。このツールは

理想表面を持つ薄膜モデルを作成でき、そのデータをシミュレータに利用できる形式で出

力します。主にミクロスケール（DFTB・CG・MD）で使用される原子モデルを作成します

が、一部マクロスケールでも使用することができます。また、任意の原子の追加・削除・

移動の編集を行う事ができます。その他、モデルに別の分子モデルをインポートする機能

や、カーボンナノチューブやフラーレン構造をモデリングする機能も備えています。本節

はこのモデリングツールの使い方を紹介します。 

 
 
  

1 薄膜モデリング 
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画面説明 

 

 
 

画面ごとの主な機能を説明します。 

【Menu Bar】 

モデルの新規作成、読み込み、保存などのファイル操作、各画面の表示／非表示の切

り替えなどを行います。 

 

【Structure Controller】 

モデルの作成・編集を行います。次の 4 つのタブから成ります。 “Welcome” タブは初

期画面です。 “New Slab” タブは薄膜モデルを作成します。 “Structure” タブは原子の

Menu Bar 

Tool Bar 

Structure Controller 

Main View 

Log View 

“Structure” Tab “Make CNT” Tab “New Slab” Tab 
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座標を表示し、また原子の編集も行います。 “Make CNT” タブはカーボンナノチュー

ブやその誘導体のモデルを作成します。 

 

【Main View】 

作成したモデルを 3D で可視化します。マウスやキーボード操作によって視点を変更で

き、また原子の選択・移動などを行えます。 

 

【Log View】 

GUI からのメッセージを表示します。 

 
 

モデリングツールの起動 

 SPM シミュレータが正常にインストールされますと、デスクトップとスタートメニュー

にモデリングツールを起動するリンクが作られます。いずれかをダブルクリックするとモ

デリングツールが起動します。59 

 
 

画面の基本操作 

本ツールでは “Main View” をマウスで操作することによってさまざまな動作が実行でき

ます。モデルを見る視点を変更したり、分子の表示の描画方法を変えたりもできます。こ

こではこのような “Main View” における操作方法を紹介します。 

 

【操作の前準備】 

以下の作業の前に、あらかじめモデルを開きます。例えば、 “Make CNT” タブをクリッ

クし、そのまま [Make CNT] ボタンをクリックして下さい。カーボンナノチューブモデル

が “Main View” に表示されます。 

 

【操作モード】 

“Main View”の操作方法として 5 つのモードがあります； “View Mode”, “Edit Mode”, “Link 

Mode”, “Distance Mode”, “Angle Mode”。通常は主に視点の変更を扱う “View Mode” を利用

することになります。その他のモードについては順次説明します。これらのモードを切り

替えるには、ツールバーの対応するアイコンをクリックして下さい。これら 5 つのボタン

は排他的なトグルボタンであり、いずれか一つのみ選択できます。 

                                                   
59 インストールしたディレクトリ（デフォルトでは、"C:/Program Files/SPMSimulator"）の中にある
mkatmstruct.exeがモデリングツールの本体です。 
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また、ショートカットキー [Ctrl+E] によりこれらのモードを順番に切り替えることもで

きます。 

 

【描画方法の設定】 

分子の描画方法を切り替えます。コンテキストメニューから “View Option” を選択し、 

“Auto”, “Dot”, “Ball”, “Ball&Stick”, “Cartoon” のいずれかを選択します。 “Auto” はモデルの

データから適切な描画法を自動判定します。なお、これらの表示はファイル形式によって

表示できないものがあります。 “Ball&Stick” は原子間結合情報が必要で、 “Cartoon” は

PDB ファイルのみに対応しています。 

 
“Dot” 

 
“Ball” 

 
“Ball&Stick” 

 
“Cartoon” 

 
 

【視点の変更】 

コンテキストメニューから “Top”, “Front”, “Side” を選択すると視点が変更でき、それぞ

れ真上(Top)、正面(Front)、真横(Side)から見たモデルが描画されます。“Perspective” を選

択すると遠近感のある描画になります。マウスホイールを回転させると表示の拡大・縮小

ができます。 

“View Mode” のときは、“Main View” 上をマウスでドラッグすることにより、以下のよう

に視点を変更することができます。 

View Mode 

 

視点を回転する 

 

視点を平行移動する 

 

拡大・縮小 

ドラッグ 

キー＋ ドラッグ Shift 

キー＋ ドラッグ Ctrl 

Link Mode 

Edit Mode 

View Mode Angle Mode 

Distance Mode 
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キーボード操作により視点を変えることもできます。 

キーボード操作 動作  

[上, 下, 左, 右] 視点の平行移動  

[Shift]＋[上, 下] 

[Shift]＋[左, 右] 

[Shift]＋[PageUp, PageDown] 

視点の回転 

（右図参照） 

 
[Ctrl]＋[上, 下] 

[PageUp], [PageDown] 

拡大・縮小  

 

【Zoom All】 

ツールバーにある虫眼鏡アイコンをクリックすると、現在の視点の向きをそのままに、

モデルの中心を眺めるように視点を平行移動させ、かつモデルが画面のほぼ全体に収まる

ように視点を拡大／縮小させることができます。 

 
ただし、モデルが 2 原子以上から成り、Perspective がオフのときのみ有効です。 

 

【コンパス】 

視点を回転させたときに現在の視点がどのような向きになっているかを、3 次元のコンパ

スによって表示できます。モデルを描画すると、下図のようにモデル描画画面の右下に 3

つの矢印と X, Y, Z の文字が表示されます。それらはモデルの 3 次元座標軸 x, y, z 軸の正の

向きを示しています。 

 

ホイール回転  

Zoom All 
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右クリックメニューから “Show Compass” をクリックすることで、コンパスの表示／非

表示を切り替えられます。 

 

【モデル範囲の表示】 

ツールバーにある直方体のアイコンをクリックすると、表示されているモデルの範囲を

表す平行六面体が表示されます。もう一度クリックすると非表示になります。 

“New Slab”タブから結晶の情報を利用してモデルを作成した場合は、格子ベクトルを考慮に

入れた平行六面体の超格子が表示されます。一方、格子ベクトル情報を含まないモデルフ

ァイルを読み込んだ場合は、モデル中の原子すべてをぴったり含むような直方体が表示さ

れます。 

Show compass 

Not show compass 

On 

Off 

Not show supercell Show supercell 
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薄膜モデルの作成事例 

薄膜モデルを作成するために必要な情報は、作成し

たい物質の結晶データ（空間群・格子定数・既約原子

位置）、およびミラー指数とスーパーセルの単位胞数

です。これらの情報は、論文やウェブ上で公開されて

いるもの等から得ることができます。 

 

【シリコン（００１）表面の作成方法】 

 ここでは、シリコン(001)表面を摸した薄膜模型を

新規に作成する方法を説明します。新規で作成する場

合は、初期画面から [a new slab] ボタンをクリック

して “New Slab” タブを開きます。直接 “New Slab” 

タブをクリックしてもかまいません。このタブに結晶

データを入力します。まず入力部最上段の “Title” フ

ォームには、ご希望のタイトルを入力してください。ただし省略することが可能で、その

場合は指定した空間群の名称が自動的に代入されます。ここでは例として “Si001” としま

す。全てのフォームへの入力は半角英数字の使用を推奨します。 

  二番目のフォームでは空間群の指定を行います。 [Spg. No.] のボタンをクリックする

と、 “Space group" という名前のポップアップウィンドウが立ち上がり空間群のリストが

表示されます。適切な空間群を選択してクリックしてください。あるいは空間群の番号を

直接タイプすることでも入力可能です。ここでは、シリコンの面心立方構造を想定してい

ますので、227 とタイプします。OK をクリックすると本ウィンドウは閉じ、空間群の入力

が完了します。 

 三番目のフォームでは、格子定数を入力します。それぞれÅと度の単位で直接タイプし

て入力してください。シリコンの場合は、5.4, 5.4, 5.4, 90.0, 90.0, 90.0 となりますが、対

称性から格子定数 a のみを入力するように制限がかかります。 

 次にブラベー格子内の原子種とその既約な座標を入力します。まず原子種を指定します。 

[Spec] ボタンをクリックすると次のような “PeriodicTable” ダイアログが立ち上がります。 

Without supercell information With supercell information 
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元素の周期律表の順番にボタンが並んでいます。適切な原子種、ここでは原子番号 14 の

Si をクリックしてください60。ダイアログが閉じ、原子名フォームに元素記号 Si が入力さ

れます。続いて既約座標、ここでは(0.0, 0.0, 0.0)を入力し、その右の [Add] ボタンを押し

てリストに追加します。シリコンの場合はこれで完了ですが、物質によっては以下、必要

な情報の量だけ同じ作業を繰り返します。入力に失敗した場合、その行を指定し、 [Modify] 

で訂正、 [Delete] で削除することができます。また [Clear all] でリストの全ての情報を削

除することができます。 

 以上で、結晶としての情報を入力することができました。薄膜モデルを作成するために

は、さらに、表面に現れる面の情報と薄膜のサイズの入力が必要となります。表面に現れ

る面の指定はミラー指数によって行われます。ご希望の面を表すミラー指数を “Miller index” 

フォームにタイプして下さい。隣の “Number of cells” フォームでは、薄膜モデルのサイズ

の指定を行います。それぞれ x, y, z 方向へ指定した数だけ結晶情報から得られる単位胞を

並べてスーパーセルを作成します。ここでは、Si(001)表面ですので、ミラー指数には 0, 0, 1

を入力します。スーパーセルのサイズは、1 から 3 のあたりで入力されると、DFTB の計算

コストに似合うモデルが作成できます。ここでは、例として 3, 3, 1 と入力します（下左図）。 

 最後に [Make Surface] ボタンをクリックしてください。正常に処理されますと、 “Main 

View” にシリコン表面を表す薄膜モデルの原子構造が表示されます。また “Log View” には、

この薄膜モデルにおける並進ベクトルが表示されます（下右図）。ここで表示される並進ベ

クトルは、結晶模型についての並進ベクトルであり、薄膜モデルのものではありません。

詳細は後述の「SPM シミュレータでの利用に関する注意点」を参照してください。 

 原子模型が表示されると、 “Structure Controller” は “Structure” タブをハイライトしま

す。ここには、表示中のモデルに含まれるすべての原子について、原子種や座標などの情

報や組成式が示されます。このタブを操作して、個々の原子を編集することができます。

詳細は後述の「個々の原子座標の編集」を参照してください。作成したモデルを保存する

には後述の「モデルの保存」を参照してください。 

                                                   
60 原子番号を直接入力して Okボタンを押すことでも、原子を選択できます。 
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【シリコン（１１１）表面の作成方法】 

 シリコン(111)の薄膜モデルを作成する方法を説明します。先ほどと同じシリコンですの

で、結晶を表す情報はすべて同じです。同様の作業を繰り返して下さい。ただし “Title” を 

“Si111” とします。結晶の情報の入力が終了したら、次にミラー指数を変更します。 “Miller 

index” フォームに 1, 1, 1 を直接入力します。最後に [Make Surface] ボタンをクリックし

ます。 “Main View” で最終確認をします。また、 “Log View” にこの結晶モデルにおける

並進ベクトルが表示されますので、必要に応じて確認します。 

 

【グラファイト（０００１）表面の作成方法】 

 グラファイトの結晶の情報は、以下の通りです。 

 

格子定数 2.464  2.464  6.711  90.0  90.0  120.0 

空間群 194 (P 63/m m c) 

既約原子座標 C1  0.00000  0.00000  0.25000 
C2  0.33333  0.66667  0.25000 

 

 ここでひとつ注意点ですが、二つ目の炭素の正確な既約原子座標は、ｘ座標が 1/3 でｙ座

標が 2/3 です。1/3 のように少数で正確に表せない場合は、少数点以下第 4 位の範囲内で原

子の同一性を判断しています。そのため入力値として少数点以下第 5 位まで入力する必要

があります。 

 次にミラー指数について述べます。ミラー指数の表示は、六方晶・三方晶の場合、3 つで

はなく 4 つの整数によって表されることが多いのですが、後者の場合独立な数字は 3 つで

すので、ここでは 3 つの整数によって指定して頂くようにしています。(0001)表面の場合は、

(001)を入力してください。基本的には、3 番目の数字が省略されています。あとはシリコ

ンと同様に処理してください。 
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モデルの保存 

【データファイルとして保存】 

表示されているモデルをデータとして保存することができます。メニューバーの “File”

から “Save as” を選択し、続いて “in XYZ format” (DFTB 形式)、 “in Tinker format” (CG/MD

形式)、または “in Modeling Project” を選択してください。ファイル保存ダイアログが現れ

ますので、適切なファイル名を入力して保存してください。 

 
“in Tinker format” として保存する前に必ず原子種 ID を決めて下さい（後述）。原子種 ID

は SPM シミュレータで CG/MD ソルバーを利用する場合に必要となります。 

“in Modeling Project” として保存するためには、 “New Slab” タブに内容を適切に入力し

ている必要がありますのでご注意ください。 

 

【画像ファイルとして保存】 

“Main View” に表示されている画面を画像として保存することができます。メニューバ

ーの “File” から “Export Image” を選択すると “Save Capture” ダイアログが現れます。任

意のファイル名を入力し、ファイルの種類を PNG (*.png), Bitmap (*.bmp), JPEG (*.jpg)か

ら選んで保存します。 

“Main View” を右クリックし、コンテキストメニューから “Export Image” を選択しても

同じ操作が行えます。 

 
 

既存モデルの読み込み 

 既存のデータを読み込んで画面に表示することができます。メニューバーの “File” から 

“Open” を選択し、 “Open File” ダイアログを開きます。 
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読み込むことのできるファイル形式は xyz (*.xyz), tinker (*.txyz), PDB (*.pdb), Modeling 

project (*.mpro), CIF (*.cif), VASP (*.vasp)です。ダイアログから読み込みたいファイルを選

択してください。ファイルのアイコンをモデリングツールへドラッグ&ドロップすることで

も、既存のデータを読み込むことができます。 

 

ファイル形式のうち xyz, txyz, pdb ファイルには原子種や原子のデカルト座標などが与え

られており、これらのファイルを読み込むと “Strucuture” タブにモデルの座標などのデー

タが表示され、 “Main View” にモデルが 3D で可視化されます。txyz, pdb ファイルに含ま

れる原子間結合の情報も反映されます。 

一方、mpro, cif, vasp ファイルには結晶構造の情報（格子定数や既約原子サイトの情報）

が含まれており、これらのファイルを読み込むと “New Slab” タブに結晶構造の情報が自動

的に入力されます。【薄膜モデルの作成事例】では結晶構造の情報を手作業で入力しました

が、その作業を自動的に行うことができます（下図参照）。 
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CIF の場合、一つのファイルに複数の結晶構造情報が含まれる場合があります。そのよう

な場合、CIF を開いたときに次のようなダイアログが表示され、どのデータブロックを利用

するかを選択することができます。 

 
 
 

最近使用したファイルを開くこともできます。メニューバーの “File” から “Recent Files”

を選択し、表示される一覧から開きたいファイルを指定します。最近の 10 件までが履歴

に残ります。 
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既存モデルのインポート 

表示中のモデルに対し、新たに既存のデータを取り込み、それらを同時に表示させるこ

とができます。まずあらかじめ原子構造を作成または読み込んでおきます。次にメニュー

バーの “File” から “Import” を選択します。ファイル選択ダイアログから取り込みたいファ

イルを選択します。これにより新たにデータが取り込まれ、先に表示されていたモデルと

同時に表示されます。 

読み込んだ原子モデルは、すでに表示されていたモデルに対して z 軸正の方向に配置さ

れ、お互いに重ならないような距離が空けられます。インポートできるファイルの形式は

xyz (*.xyz), tinker (*.txyz)に限られます。 

なお、ファイルのアイコンをモデリングツールへ、[Ctrl]キーを押しながらドラッグ&ドロ

ップすることでも、既存のデータをインポートすることができます。 

 

モデリングツールの終了 

 メニューバーの “File” から “Quit” を選択するか、タイトルバーの右にある×ボタンをク

リックすると、モデリングツールが終了します。 

 
その際、編集中のモデルデータが保存されていない場合は、保存を促すメッセージが表示

されます。 

 
[Save] をクリックするとモデルデータを保存するダイアログが開き、保存が完了した後で

ツールが終了します。[Discard] をクリックすると、現在のモデルデータを破棄してツール

が終了します。[Cancel] をクリックするとツールは続行します。 

キーボードの [Shift] キーを押しながらモデリングツールの終了操作を行うと、モデルの
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保存を行わずに強制終了することができます。 

 
 

モデルの編集 

“Structure” タブを利用すると、作成したモデルに

対して原子を追加、編集、あるいは削除することが

できます。編集が終了し画面での確認がとれました

ら、ファイルへ保存してください。 

 

【原子を追加】 

原子を追加したい場合は [Duplex ボタンを使い

ます。まず座標の基準となる原子をリストの列から

選択します61。次に原子を追加したい座標を、基準

原子からの相対座標で入力します。そして [Duplex] 

ボタンをクリックすると新しい原子が描画されま

す。デフォルトでは同じ原子種が追加されますが、 

[Spec] ボタンを押して別の原子種を選んで追加す

ることもできます。 

 なお、原子が全く存在しないときに [Duplex] ボタンを押した場合、入力した x, y, z 値が

絶対座標として扱われ、指定した種類の原子が一つだけ配置されます。 

 

【原子を編集】 

 原子を編集したい場合は [Change] ボタンを使います。まず編集したい原子をリストの

列から選択します。相対座標を入力して [Change] ボタンをクリックすると選択した原子

が移動します。移動先に原子が存在するときは変更できません。あるいは原子選択後に 

[Spec] ボタンを押して原子種を選択し、 [Change] ボタンをクリックすると原子種が変更

されます。 

 

【原子を削除】 

原子を削除したい場合は [Delete] ボタンを使います。削除したい原子をリストの列から

選択します。そこで [Delete] ボタンをクリックすると選択した原子が削除されます。キー

ボードの [Delete] キーでも同じように削除できます。 
 

 

【原子の選択／非選択】 

原子を編集したいときに “Structure” タブのリストから原子を選択する方法をすでに紹

                                                   
61 リストの列をCtrl+クリックすると複数選択できます。リストの列をShift+クリックするとリスト内を範囲
選択できます。Ctrl+Aキーを押すとすべての原子を選択できます。 “Main View” から選択することも
できます（後述）。 
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介しましたが、マウスを使って選択することもできます。“Main View” 画面のモデルを見な

がら選択したい原子をマウスで直接指定できます。 “View Mode” と “Edit Mode” のそれぞ

れについて、以下のような原子選択機能があります。 

 
View Mode 

空白（原子や結合が何もないところ）を 

ダブルクリック 

すべての原子が非選択になる。 

原子をダブルクリック 選択／非選択が反転する。 

 
Edit Mode 

空白（原子や結合が何もないところ）を 

ダブルクリック 

すべての原子が非選択になる。 

原子をクリック 選択／非選択が反転する。 

空白を始点としてドラッグ 範囲内にあるすべての原子が追加

的に選択される。 

空白を始点として Shift+ドラッグ 範囲内にあるすべての原子が非選

択になる。 

空白を始点として Ctrl+ドラッグ 範囲内にあるすべての原子の選

択・非選択が反転する。 

 

このようにして一つあるいは複数の原子を選択状態にすると、“Structure” タブのリスト

中の対応する項目もまた選択された状態になります。すると先に述べた方法で編集や削除

などを行うことができます。 

 
 
 

【原子の移動・回転】 
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“Edit Mode” で一つまたは複数の原子が選択されているとき、マウスのドラッグ操作に

より原子の移動や回転を行うことができます。“Structure” タブのリスト中の原子座標はリ

アルタイムで更新されます。 

 

Edit Mode、原子選択時 

選択した原子群を始点としてドラッグ マウスの動きに応じてその原子群

が平行移動する。 

選択した原子群を始点として Shift + ドラッグ マウスの動きに応じてその原子群

が一まとまりとなって回転する。 
 

 

結合情報の編集 

“Structure” タブでは原子間の結合を生成したり、水素原子を付加したり、結合の種類を

特定したりもできます。 

 

【結合の生成】 

“Bond” ボタンをクリックすると原子間結合情報が更新されます。 “View Option” として 

“Ball&Stick” を選択するとこの結合が可視化できます。原子数が多いときは計算に時間がか

かるのでご注意ください。また、“Link Mode” を利用すると原子間結合を自由に編集できま

す（後述）。 

 

【結合の消去】 

[Bond clear] ボタンをクリックすると原子間結合情報が破棄されます。原子数が多いと

きに結合情報を保ったまま編集作業をすると、処理に時間がかかることがあります。その

ような場合に一時的に結合情報を破棄すると良いでしょう。編集作業が終わったら “Bond” 

ボタンを利用して結合情報を更新してください。 

 

【水素付加】 

[Hydrogenate] ボタンをクリックすると、結合数の不完全な原子に水素原子を付加し結

合数を正常に保ちます。 

 

【原子種 ID の決定】 

[Bond/MM3] ボタンをクリックすると、原子ごとの原子種 ID を自動的に決定します。こ

れは SPM シミュレータで CG/MD ソルバーを利用する場合に必要となります。使用例の手

順としては、(1) xyz 形式のファイルをモデリングツールで読み込む。(2) 原子種 ID を決定

する。(3) Tinker 形式で保存する。(4) それを CG/MD ソルバーの計算に利用する、という

方法があります。 
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Link Mode 

 “Link Mode” を利用すると原子間結合を自由に編集できます。ツールバーの“Link Mode”

アイコン  をクリックして“Link Mode”に切り替えられます。 

原子 A と原子 B の間に結合を作りたい場合、まず原子 A を画面上でクリックし、続いて

原子 B をクリックします。二つの原子のどちらを先にクリックしても構いません。引き続

き原子を順番にクリックすることで、結合を連続して生成することができます。 

 
結合の生成を中止するためには、画面上の原子以外の空白領域をクリックします。それに

より原子の選択状態が解除されます。 

 

逆に原子 A と原子 B の間の結合を消去したい場合、まず原子 A を画面上でクリックし、

続いてキーボードの[Shift]キーを押しながら原子 B をクリックします。二つの原子のどち

らを先にクリックしても構いません。引き続き[Shift]キーを押しながら原子を順番にクリッ

クすることで、結合を連続して消去することができます。 

 
また、View モードと同じように、マウスのドラッグ操作によって視点の操作（回転、移

動、ズーム）ができます。 

 
 

Distance Mode 

“Distance Mode” を利用すると原子間距離を測ることができます。ツールバーの 

Shift key pressed Shift key pressed 
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“Distance Mode” アイコン  をクリックして “Distance Mode” に切り替えられます。 

原子 A と原子 B の距離を測る場合、まず原子 A を画面上でクリックし、続いて原子 B を

クリックします。二つの原子のどちらを先にクリックしても構いません。選択した二つの

原子間に点線が引かれ、計算した距離は出力ログに表示されます。 

 
距離の測定を中止するためには、画面上の原子以外の空白領域をクリックします。それに

より原子の選択状態が解除されます。 

また、View モードと同じように、マウスのドラッグ操作によって視点の操作（回転、移

動、ズーム）ができます。 

 
 

Angle Mode 

“Angle Mode” を利用すると 3 つの原子が成す結合角を測ることができます。ツールバー

の “Angle Mode” アイコン  をクリックして “Angle Mode” に切り替えられます。 

原子 A、B、C が成す角度∠ABC を測る場合、画面上で原子 A、原子 B、原子 C の順番に

クリックします。A-B-C を結ぶ点線および円弧が引かれ、計算した角度は出力ログに表示さ

れます。 

A 

B 

Distance Mode 
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角度の測定を中止するためには、画面上の原子以外の空白領域をクリックします。それに

より原子の選択状態が解除されます。 

また、View モードと同じように、マウスのドラッグ操作によって視点の操作（回転、移

動、ズーム）ができます。 

 
 

編集操作の undo, redo 

様々な編集操作を元に戻したり(undo)、逆にやり直したり(redo)することができます。

Undo は編集操作を行う前のモデルのデータ（原子の数、原子種、原子座標、結合情報、編

集状態）を復元します。これらの機能は、メニューバーから操作することもできますし、

また便利なショートカットキーも割り当てられています。 

機能 メニューによる操作 キーボードショートカット 

元に戻す(undo) メニューバー “Edit”  “undo” Ctrl+Z 

やり直す(redo) メニューバー “Edit”  “redo” Ctrl+Y 

Undo を実行すると redo が使えるようになります。 

 

undo, redo 可能な編集操作の一覧を示します。 

1 現在のモデルに別のモデルをインポートしたとき。 

2 [Duplex] 操作で原子を複製したとき。 

3 [Delete] 操作で原子を削除したとき。 

A 

B C 

Angle Mode 
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4 [Change] 操作で原子を編集したとき。 

5 [Bond] 操作で結合情報を生成したとき。 

6 [Bond clear] 操作で結合情報を破棄したとき。 

7 [Hydrogenate] 操作で水素原子の付加を行ったとき。 

8 [Bond/MM3] 操作で原子種 ID を決定したとき。 

9 Edit モード時にマウス操作で原子を移動／回転したとき。 

10 “New Slab” タブから [Make Surface] ボタンによりモデルを作成したとき。 

11 “Make CNT” タブから [Make CNT] ボタンによりモデルを作成したとき。 

12 [File][Open] により、編集中のモデルを破棄し、既存のモデルを読み込んだとき。 

13 [File][Import] により、編集中のモデルに既存のモデルを追加したとき。 

14 [File][Recent Files] から最近開いたファイルを読み込んだとき。 

元に戻せる編集操作の履歴は最大で 30 件です。 

 

また、次の操作を行ったときに undo, redo の履歴がクリアされます。 

1 GUI を起動したとき。 

2 “File”  “New” を選択したとき。 

3 GUI を終了するとき。 

 

次のタイミングでクリーンインデックスが設定されます。 

1 “File”  “Open” により、編集中のモデルを破棄し、既存のモデルを読み込んだとき。 

2 “File”  “Recent Files” から最近開いたファイルを読み込んだとき。 

3 “File”  “Save as”  “in XYZ Format” により、モデルを XYZ 形式で保存したとき。 

4 “File”  “Save as”  “in Tinker Format” により、モデルをTXYZ形式で保存したとき。 

5 “New Slab” タブから [Make Surface] ボタンによりモデルを作成したとき。 

6 “Make CNT” タブから [Make CNT] ボタンによりモデルを作成したとき。 

いずれの場合も、保存済みのファイルを開いたときやモデルをファイルに保存したとき

にクリーンインデックスが設定されます。 

表示中のモデルを編集するとタイトルバーに表示されるファイル名にアスタリスク [*] 

が付き、これは現在のモデルが非保存状態であることを意味します。このときに GUI を終

了しようとすると、データの保存を促すメッセージが表示されます。 

一方、データを保存するなどしてクリーンインデックスが設定されると、タイトルバー

のファイル名からアスタリスクが消えます。このときは、GUI を終了する際にモデルデー

タの保存を促すメッセージが表示されません。 

 

ツールバー 

 画面上部にツールバーがあります。ツールバーに用意されたアイコンをクリックするこ

とで、GUI に搭載されているいろいろな機能を利用できます。利用できる機能は次の通り
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です。 

 

 
 機能 別の操作方法 

① モデルの新規作成開始。スタートメニューに戻り、すべ

ての設定をリセットする。 

“File”  “New” 

② モデルの読み込み。既存のモデルを新しく開く。 “File”  “Open” 

③ モデルを保存。 “File”  “Save as” 

④ “Main View” を画像ファイルとして保存。 “File”  “Export Image” 

⑤ 元に戻す (undo)。 “Edit”  “undo” 

⑥ やり直す (redo)。 “Edit”  “redo” 

⑦ “View Mode”に切り替える。トグル可能。 [Ctrl+E] 

⑧ “Edit Mode”に切り替える。トグル可能。 [Ctrl+E] 

⑨ “Link Mode”に切り替える。トグル可能。 [Ctrl+E] 

⑩ “Distance Mode”に切り替える。トグル可能。 [Ctrl+E] 

⑪ “Angle Mode”に切り替える。トグル可能。 [Ctrl+E] 

⑫ 現在の視点を保ったまま、モデルサイズを画面にフィッ

トさせる (Zoom All)。 

 

⑬ コンパスの表示／非表示を切り替える。トグル可能。 “Main View” を右クリッ

ク “Show Compass” 

⑭ 分子の描画方法を切り替える。 “Main View” を右クリッ

ク “View Option” 

⑮ モデル範囲の表示／非表示を切り替える。トグル可能。  

 
 

カーボンナノチューブ作成 

カーボンナノチューブ(CNT)モデル作成プログラムを呼び出し、カーボンナノチューブ

やその誘導体を作成して画面に表示できます。 

 

【操作手順】 

1. “Make CNT” タブを開く。 
2. オプションを設定する。 
3. [Make CNT] ボタンを押す。 
4. 出力結果が “Structure” タブや “Main View” に表示される。 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 
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【CNT モデル作成プログラムの引数】 

<mode>: type of CNT: 

CNT の種類を次の 4 つから選択します。 

1. swcnt: シングルウォールカーボンナノチューブ 

2. sheet: グラフェンシート 

3. fuller: フラーレン族 

4. capped: キャップ付き CNT 

 
<Chx>, <Chy>: x, y-component of chiral vector: 

CNT のカイラル指数(n,m) = (<Chx>, <Chy>)を指定します。 

これは CNT の巻き方や大きさを表します。 

n, m は整数で、0≦|m|≦n とします。 

“sheet”, “fuller”, “capped”の場合、n, m は 5 の倍数のみ利用できます。 

 
<Ncell>: number of unit cell: 

CNT の単位胞の数です。 

カイラルベクトルで生成される CNT を１として、これをいくつ並べるか指定しま

す。 

 

[output file]: output file name:（編集不可） 

出力ファイル名。指定がない場合は標準出力。 

 

【実行例】 

<mode>  = swcnt 
<Chx>   = 10 
<Chy>   = 5 
<Ncell> = 2 

<mode>  = sheet 
<Chx>   = 20 
<Chy>   = 20 
<Ncell> = 1 

<mode>  = fuller 
<Chx>   = 5 
<Chy>   = 5 
<Ncell> = 1 

<mode>  = capped 
<Chx>   = 5 
<Chy>   = 5 
<Ncell> = 5 

1 

3 

4 2 
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グラフェンシート作成 

単層のグラフェンシートを作成できます。 

 

【操作手順】 

1. “Make CNT” タブを開く。 
2. グラフェンシート作成用のオプションを設定する。 
3. [Make Graphene] ボタンを押す。 
4. 出力結果が “Structure” タブや “Main View” に表示される。 

 

 
 

【グラフェンシート作成用のオプション】 

C-C nearest distance [ang]:（編集不可） 

C-C 原子間の最隣接距離。1.412 Å に固定されている。 

 
x-length of graphene [ang]: 

グラフェンシートの横幅。デフォルトは 20 Å。 

 
y-length of graphene [ang]: 

グラフェンシートの縦幅。デフォルトは 20 Å。 

 

入力する値に応じて任意のサイズのグラフェンシートを作成できます。 

1 

3 4 2 
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必要に応じて水素原子の付加 [Hydrogenate] や原子種 ID の決定 [Bond/MM3] を実行し、

モデルを保存して下さい。 

 
 

SPMシミュレータでの利用に関する注意点 

 モデリングツールで出力する原子構造ファイルは、SPM シミュレータの DFTB ソルバー

および、CG/MD ソルバーで使用することができます（マクロ系ソルバーでは、原子構造の

データの中から高さ情報のみを抽出して利用します）。 保存したファイルは、直接 SPM

シミュレータでロードすることができます。ただし以下の点についてご注意ください。 

 各原子は、時として非常に接近した位置に生成される場合があります。このような原

子構造ファイルを SPM シミュレータで使用するとエラーを返すか、あるいは正常なシ

ミュレーション結果が得られません。適当な原子をクリックしてハイライトしたとき、

通常ですとその原子は、原子球の全体が黄色に変化します。しかし、ハイライトされ

た原子の一部しか変化しない場合、接近した位置に原子が生成された恐れがあります。

その場合は、結晶データの相対原子位置などに誤りがないか確認をしてください。 

 “Log View” に出力される並進ベクトルは、結晶データから生成されるもので、薄膜モ

デルのものではありません。薄膜モデルに利用する場合は、並進ベクトルの z 成分を

無視してください。SPM シミュレータで利用するときは、ｚ成分を 100.0 などの大き

い数字を入力することを推奨します。将来的には、並進ベクトルの情報は、原子構造

ファイルを通して SPM シミュレータへ自動的に渡されるよう変更する計画です。 

 CG/MD 用の出力ファイルには、電子状態を摸した原子種情報が含まれています。たと

えば、同じ炭素原子でも sp3 状態なのか、sp2 状態なのかを区別する必要があります。

モデリングツールでは、シリコン・炭素・水素に限り、これを自動的に処理します。

ただし、原子の削除や追加に伴う変更は、現バージョンでは考慮しておりません。こ

の場合、お手数ですが、テキストエディタを用いて “mm3.prm” 中から適切な値（正数

値ひとつで表されています）を出力ファイル中の適切な位置へ記載して下さい。 

 探針用のモデルを作成するときは、結晶単位胞の角を利用すると簡単に作成できます。

その場合、表面を全て水素原子で終端することで、安定な探針構造になります。ただ

20 x 20 Å 12 x 30 Å 50 x 18 Å 
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し探針先端部の水素原子については適宜削除してください。 

 CIF ファイルを読み込む際の注意事項。 

CIF に記載される原子サイトの占有率 occupancy について、以下のことにご注意く

ださい。モデリングツールで結晶構造情報から作成したモデルにおいては、すべての

原子の占有率は 1.0（指定のサイトに原子が必ず存在する）として扱われます。CIF フ

ァイルによっては、特定の原子サイトに欠陥があるなどの場合に 1.0 未満の占有率が与

えられることがありますが、その場合は CIF の読み込み時に出力ログへ注意を促すメ

ッセージが表示されます。 

<<< Load a file "C:\sample\sample.cif" >>> 
Now loading ...  
Warning: incomplete occupancy 0.3333 for Ow at 0.736 0.368 0.491 
Completed to load. 

このとき、 “New Slab” タブの原子サイト情報は次のように表示されます。 

 
出力ログには原子サイトの fractional 座標も示しており、この場合はリストの下から

2 番目の O 原子のサイトが占有率 0.3333 であることがわかります。[Make Surface]ボ

タンを押し、読み込んだ情報に基づいて原子モデルを作成すると、下図のように不自

然なモデルが描画されます。 

 
黄色の円で囲んだ部分を見ると、3 つの酸素原子が非常に近接した位置に存在しま

す。占有率 0.3333 を踏まえると、その 3 つの酸素原子のうちいずれか一つの位置に酸

素原子が存在することが示唆されます。例えば多数のユニットセルを用意したときに、

3 つの位置のいずれかがランダムに現れるということが考えられます。 

モデリングツールでは、1.0 未満の占有率を正しく考慮したモデルを作成すること

はできません。占有率について警告が与えられた場合、作成されたモデルには何らか

の問題があることに注意してください。 
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本ツールは開発途上のものです。仕様の変更は極力避けるよう努めますが、やむを得ず変

更される可能性があります。予めご理解ご了承ください。 

 
  

２ 分子モデリング 
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2 分子モデリング 

 

はじめに 

 
ここでは、SPM シミュレータの初期構造を作成するためのツールとして、フリーソフト

ChemSketch と OpenBabel の使用方法を紹介いたします。このツールで作成した初期構造

データは、原子・分子・ナノ材料 AFM シミュレータで利用可能です。 

原子・分子・ナノ材料 AFM シミュレータでは、AFM 像のシミュレーションを行うために、

Allinger によって開発された MM3 という古典力場パラメータを用いています。MM3 が対応

している元素を下図に示します。 

 
 
 

パラメータは元素だけではなく、その元素がどのような化学的な環境にあるかによっても

区別して設定され、その区別のことを原子種(atom type)といいます(例えば、炭素元素に対

して、アルキル基の炭素とベンゼン環の炭素とは区別されるため、異なる原子種です)。つ

まり、原子種、およびそれらの組み合わせによって、vdW 相互作用や二原子間の共有結合

の相互作用等のパラメータが設定されることになります。考えうる原子種の組み合わせは

非常に多いため、分子構造によってはパラメータが用意されておらず、その場合は分子内

の構造変化の計算を行うことができません。 

ChemSketch のダウンロード 

 

ACD/ChemSketch は Advanced Chemistry Development 社の提供するフリーソフトです。

こちらのソフトウェアのダウンロードにはユーザー登録が必要であり、また、ライセンス

条 項 に 同 意 の 上 で イ ン ス ト ー ル を 行 っ て い た だ く 必 要 が あ り ま す 。 以 下 に 、

MM3 力場対応元素 
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ACD/ChemSketch のダウンロードを行う流れの一例をご紹介いたします。 

 

①URL: http://www.acdlabs.com/resources/freeware/chemsketch/ 

の ACD/ChemSketch のダウンロードページを表示します。 

②ページの下部にあるダウンロードのアイコンをクリックします。 

③ログインページが表示されるので、Create an Account をクリックします。 

④下図が表示されるので*の印がついている項目を入力し、Register をクリックします。 

 
 

 
 

 
 

性別 

下の名前 苗字 

確認のため同じ E-Mail 

アドレスを再度入力 

確認のため同じ 

パスワードを再度入力 

郵便番号 

会社名 

国籍 

http://www.acdlabs.com/resources/freeware/chemsketch/
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⑤記入した E-Mail アドレス宛に、メールが届いたら 

Before you can login you need to activate your account: 
To automatically activate your account, click here 

とメール本文に記載されているので、青く反転した here をクリックします。 

これでアカウントの作成は終了です。 

⑥再度 URL: http://www.acdlabs.com/resources/freeware/chemsketch/ 

の web ページを表示します。 

⑦ページの下のほうにあるダウンロードのアイコンをクリックします。 

⑧ログインページが表示されるので、手順④で入力した E-Mail アドレスとパスワードを入

力し Login アイコンをクリックします。 

⑨下図が表示されたら実行をクリックします。 

 

 
 

⑩Next > をクリック 

 
 

⑪ライセンス条項を確認したうえで、 I accept the terms in the License Agreement を選択

http://www.acdlabs.com/account/activateaccount.php?email=s_takagi@aas-ri.co.jp&code=0e74c0e25a005ea1573786d38fd05896
http://www.acdlabs.com/account/activateaccount.php?email=s_takagi@aas-ri.co.jp&code=0e74c0e25a005ea1573786d38fd05896
http://www.acdlabs.com/resources/freeware/chemsketch/
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し、Next >をクリック。 

 

 
 

⑫Next >をクリック。 
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⑬Next >をクリック。 

 
⑭Next >をクリック。 

 
⑮Install をクリック。 
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⑯Finish をクリック。 

 
 

⑰ChemSketch をクリック。 
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⑱OK をクリック。 

 
 

⑲Select All をクリックし、Yes をクリック。 
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⑳OK をクリック。 

 
以上でダウンロードと初期設定は終了です。 

 
 

OpenBabel のダウンロード 

 

OpenBabel は GPL ライセンスのもとで配布されているフリーソフトであり、化学情報のフ

ァイル形式の変換に用いられます。使用には、こちらのソフトウェアのライセンス条項に

同意の上でインストールを行っていただく必要があります。以下に、OpenBabel のダウン

ロードを行う流れの一例をご紹介いたします。 

 
① URL:http://openbabel.org/wiki/Main_Page  

の web ページを表示します。 
② Download をクリック。 

http://openbabel.org/wiki/Main_Page
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③ Windows版の Download v2.3.2 Installer をクリック。 

 
 

④ 実行をクリック。 

 
 

⑤ 実行するをクリック。 
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⑥ Next >をクリック。 

 
 

⑦ ライセンス条項を確認したうえで、I Agree をクリック。 
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⑧ Next > をクリック。 

 
 

⑨ Install をクリック。 
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⑩ Finish をクリック。 

 
 

以上でダウンロードは終了です。 

 
 

ChemSketchを用いたオクタン分子の作成 

 

炭素数８のアルカンである、オクタン(分子式 C8H18)を作成します。 

 

1. “ChemSketch” を起動します。 

2. 炭素鎖を作成します。 

① “Structure” を選択します。 
② 左のツールから C(炭素原子)を選択します。 
③ 上のツールから “Draw Normal” を選択します。 

 
④ 空白の画面をクリックすると、炭素原子 1 つから成る CH4 が生成します。以下の

作業で操作を戻したい場合は、Ctrl+Z (undo)および Ctrl+Y (redo)を使うと便利です。 

 
⑤ CH4 にカーソルを合わせてクリックすると、H 原子の一つが CH3 に置換され、エ

タン分子になります。 

1 

3 

2 
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⑥ 以下、片方の端の CH3 にカーソルを合わせてクリック、を炭素数が 8 になるまで

繰り返します。 

 
⑦ これでオクタン分子の骨格が完成しました。 

 

3. 3 次元最適化。”3D Optimization”ボタンをクリックすると、水素原子が付加されて三次

元構造になります。 

 
4. モデルの保存。 

① メニューバーから[File][Save As]を選択し、データを保存するためのダイアログを開き
ます。 

② ファイルの種類を “MDL Molfiles [V2000] (*.mol)” に設定し、ファイル名を入力して保
存します。 

③ 保存したファイルはフリーソフト OpenBabel を利用して*.txyz 形式に変換できます。（後
述） 

 

もっと簡単な方法もあります。上部のツールから “Draw Chains” アイコンをクリックし

ます。画面上で Shift キーを押しながら、任意の点から右へドラッグします。炭素の数が “C 

8” のように表示されたらマウスボタンをリリースします。以上でオクタン分子が出来上が

ります。 

・・・ 
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ChemSketchを用いたキニーネ分子の作成 

分子式 C20H24N2O2 のアルカロイドである、(-)-キニーネを作成します。次のような構造を

持つ分子であり、これを一から作り上げます。 

 
1. “ChemSketch” を起動します。 

2. 分子の骨格を作成します。 

① “Structure” を選択します。 
② 右のツールからベンゼン環を選択します。 

 
③ 空白の画面をクリックしてベンゼン環を生成します。以下の作業で操作を戻したい場合

は、Ctrl+Z (undo)および Ctrl+Y (redo)を使うと便利です。 
④ 続いて、配置されたベンゼン環の右の結合部分にカーソルを合わせ、クリックすることで

ナフタレン構造を作ります。ヘテロ原子への置換は後で行います。 

  

1 

2 
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⑤ 左のツールから C（炭素原子）を選択します。上のツールから “Draw Normal” を選択し

ます。 

 
⑥ 炭素原子鎖の骨格を作ります。鎖を伸ばしたい炭素原子を始点とし、付加する炭素原

子の位置を終点とするようにドラッグします。ヘテロ原子への置換は後で行います。 

 

 

  3   4 

 

 

 5 
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⑦ メトキシ基(-O-CH3)側の骨格も同様にして作ります。 

 
3. 原子の置換、官能基の付加、修飾をします。 

① 原子を置換します。左のツールから N（窒素原子）を選択します。置換したい原子上にカ
ーソルを合わせ、クリックすると N原子に置換できます。 

 
② 同様に O（酸素原子）への置換も行います。左のツールから O（酸素原子）を選択し、置

換したい原子上にカーソルを合わせ、クリックすると O原子に置換できます。 

 
③ ヒドロキシ基を付加します。左のツールから O（酸素原子）を選択し、炭素骨格を作った

ときと同様にして操作します。ヒドロキシ基を付加させる炭素原子を始点とし、酸素原子
を配置したい位置を終点とするようにドラッグします。 

 
④ 二重結合を作ります。左のツールから C（炭素原子）を選択。上のツールから “Draw 

Normal” を選択します。結合部分にカーソルを合わせ、クリックすると二重結合に変わ
ります。 

（クリックするたびに二重結合、三重結合、単結合と繰り返されます。） 
⑤ 立体構造を指定します。上のツールから “Up Stereo Bonds” を選択します。 

結合部分にカーソルを合わせてクリックすると、紙面上方へ向かうような立体を表現す
る結合に変わります。 

（クリックするたびにくさび形の向きが変わります。上のツールから隣の “Down Stereo 
Bonds” を使うと紙面下方に向かう結合を表現できます。） 

⑥ 下のような構造ができあがりました。 
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4. 3次元最適化。 

① “3D Optimization” ボタンをクリックすると、水素原子が付加されて三次元構造になりま
す。 

 
② 警告のダイアログが出ます。立体結合は残すので、 “No” を選択します。 
③ 次のような構造が得られます。 

 
④ 左上のツールから “3D Rotation” をクリックし、画面上をドラッグすると、3 次元回転さ

せることができます。 

 
5. モデルの保存。 

① メニューバーから[File][Save As]を選択し、データを保存するためのダイアログを開き
ます。 

② ファイルの種類を “MDL Molfiles [V2000] (*.mol)” に設定し、ファイル名を入力して保
存します。 

③ 保存したファイルはフリーソフト OpenBabel を利用して*.txyz 形式に変換できます。（後
述） 

 
 

Open Babelを用いたファイル形式の変換 

 

“Open Babel”を用いて、“ChemSketch”で作成したファイル(mol 形式)を、シミュレータで使

用可能な形式(txyz 形式)のファイルに変換します 
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１． “Open Babel GUI”を起動 

２． mol 形式から txyz 形式ファイルへの変換 

１）”INPUT FORMAT”から、”mol – MDL MOL format”を選択します 

 
 

２）”OUTPUT FORMAT”から、”txyz – Tinker MM2 format”を選択します。 

 
 

３）①”Input below”チェックボックスのチェックをはずし、②ChemSketch で作成した

mol ファイルを指定します。(注)指定する mol ファイルのパスには、日本語文字を含め

ないようにしてください。 
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４）①”Input below”チェックボックスにチェックを入れます。②”Output below only”チ

ェックボックスのチェックをはずし、③出力する場所を指定し、ファイル名を入力しま

す。(注)指定する mol ファイルのパス、及びファイル名には、日本語文字を含めないよ

うにしてください。 

 
 

５）”CONVERT”ボタンをクリックします。 

① 

② 

① 

② 

③ 
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６）４)－③で指定した場所に、mol ファイルを変換した txyz ファイルが生成されます。 
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第 6章 

トラブルシューティング 

 
 

 SPM シミュレータの利用時に起こり得るトラブル事例とその解決方法を紹介します。 

 
 

シミュレータの実行に伴うトラブル 

 
 

シミュレータが正常に起動しない 

シミュレータが正常に起動しない場合、ig4dev32.dll（通常は C:¥WINDOWS¥system32

にあります）のバージョンが合っていない可能性があります。このファイル名を別名（例

えば、ig4dev32.dll_bak）に変更後、再度 GUI を起動してみてください。 

なお、他のアプリケーションで不都合が出た場合は、お手数ですが元にお戻しください。 

 

設定したパラメータが計算に反映されない 

 

読み込み中のプロジェクトファイルのあるフォルダに対して、ログインしているユーザ

アカウントが書き込み権限を持っていないことが原因と考えられます。 

SPM シミュレータはデフォルトでは "C:¥Program Files" 以下のフォルダにインストー

ルされますが、管理者権限を持たないユーザアカウントはこのフォルダ以下の内容を書き

変えることができません。Windows Vista 以降の OS の場合、"C:¥Program Files" 以下のプ

ロジェクトファイルや出力ファイルを書き変えようとすると、VirtualStore という仕組みが

作動します。すると、Windows 側が保存先を自動的に切り替えてしまい、"C:¥Program Files" 

以下のファイルを直接書き換えず、別の場所にファイルのコピーを作り、そのファイルを

編集するようになってしまいます。SPM シミュレータは始めに選択したフォルダにある出

力ファイルを読み込むため、結果として別の場所にある出力ファイルの変化を見出すこと

はできません。 

 

この問題を解決するための 2 通りの方法を紹介します。 

 まず一つ目は、一時的に管理者権限を付けてシミュレータを起動する方法です。SPM シ

ミュレータを起動する際に、シミュレータのアイコンを右クリックし「管理者として実行」

を選択して下さい。 

二つ目は、サンプルプロジェクトのコピーを作る方法です。SPM シミュレータのアイコ

ンをダブルクリックし、通常の方法で起動します。サンプルプロジェクトを "C:¥Program 

Files¥SpmSimulator¥SampleProject" 以下から読み込みます。ここで、今開いているプロジ

シミュレータの実行に伴うトラブル 
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ェクトのコピーを作るために、メニューバーの  [File] -> [save as] を選択して "Save 

project" ダイアログを開きます。プロジェクト名は初期値のままで構いませんが、保存先の

ディレクトリは、必ず書き込み権限のあるフォルダ（例えば "C:¥Users¥ユーザー名" 以下）

を選択してください。プロジェクトの保存ができましたら問題は解決となります。計算の

設定を更新して保存したり、計算を実行したりしたときに、選択されたフォルダ以下に結

果が反映されるようになります。 

 
 
 
 

インストールに伴うトラブル 

 

インストーラ実行時に発生し得るエラーコード、ならびに対処方法を示します。 

 

インストールエラー (エラーコード:0003) 

 
ネットワークへの接続情報の取得に失敗している可能性があります。SPM シミュレータ

をインストールするにはインターネットへの接続が必要です。具体的には Windows に付属

するアプリケーション ipconfig.exe を使用してネットワーク情報を取得する際に、正常な接

続の情報が得られないことが原因となります。 

まずインターネットへの接続を確認して下さい。正常に接続でき、なおかつ当該エラー

コードが発生する場合は以下の手順を確認して下さい。 

 

Windows の環境変数の PATH に ipconfig.exe へのパスが設定されていない場合に当該エ

ラーコードが発生することがあります。以下の手順に従って環境変数を編集して下さい。 

 

まず“システムのプロパティ”を表示するウィンドウを開きます。 

【Windows XP をお使いの場合】 

デスクトップまたは画面左下のスタートメニューから、マイコンピュータを右クリックし、

プロパティをクリックします。 

【Windows 7 をお使いの場合】 

Windows7 の画面左下のスタートボタンを押します。 

表示されるメニューの “コンピュータ” を右クリックし、プロパティをクリックします。 

システムを表示するウィンドウが開きましたら、左側の “システムの詳細設定”をクリック

します。 

インストールに伴うトラブル 
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“詳細設定”のタブをクリックします。 

“環境変数”ボタンを押し、環境変数を設定するためのウィンドウを開きます。 

ここからは間違えないようにご注意下さい。 

システム環境変数のリストから “Path” を探して選択し、“編集” ボタンを押します。（ユー

ザー環境変数のリストではありません。） 

“変数値”に次のようにして値を追加します。 

変数値の文字列の一番最後にカーソルを合わせます。それに引き続き、以下の内容を

セミコロン『;』を含めてすべてコピー＆ペーストします。 

 
;%SystemRoot%;%SystemRoot%¥System32;%SystemRoot%¥System32¥Wbem 
 

“OK”ボタンを押してシステム変数の編集を終えます。 

“OK”ボタンを押して “環境変数” の編集を反映させます。 

“OK”ボタンを押して “システムのプロパティ” の編集を終えます。 

 

以上で環境変数の設定は完了です。改めてインストーラを起動して下さい。 
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